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• Fusion and Real-time fusion

• Bridges or Smart Hole Filling

• Export model

• Measure model

• Construct CAD-primitives

• About your scanner

• Ask for help

Artec Studio is an industry-acclaimed software package for advanced 3D scanning and data processing. It
enables you to scan countless objects using Artec scanners.

This manual will show you how to use the application as well as your 3D scanner to quickly and easily create
great-looking 3D models. Use the left panel to get an overview of the entire manual, or refer to the Quick Start
Guide. To get the most out of the documentation, review the various terms we use throughout. Consult the
Index to find references for specific parameters that appear in processing algorithms. Also, take a look at the
Conventions and Acronyms section for a key that describes how we highlight semantic elements.

The incomplete list of chapters below is intended to clarify the document structure.

• 3D Scanning at a Glance (Quick Start Guide) is a brief overview of scanning and processing basics. It also
covers Autopilot mode.

• Using the Hardware covers hardware-related matters: scanners, third-party 3D sensors and 3D mice

• Scanning explains the basic principles of object scanning and offers advice on how to conduct the scanning
process to obtain the best results.

• Viewing Scans and Models describes ways in which to control an object’s appearance in the 3D View window
and obtain the best view of the 3D model.

• Projects, Scans and Models contains information on data management, working with projects, exporting
and importing data, undoing recent operations, and saving the history of project changes.

• Data Processing focuses on data-processing techniques: working with separate scans, alignment, fusion,
filters, defect-elimination methods and texturing.

• Additional Modes demonstrates how to publish models on the Web; how to use additional features, such
as employing several scanners to capture an object; and how to use measuring tools.

In addition to this manual, you can find practical tips and other information at the Support Center. If you
encounter an issue when using our 3D scanners or applications, please submit a request.

Documentation for earlier versions of the software is available here.

CONTENTS 9
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CHAPTER

ONE

3D SCANNING AT A GLANCE

Before you start using the guide, we want to show you how easy 3D scanning can be. This brief summary will
help you understand the 3D scanning process with the Artec 3D tools and get started quickly. If you prefer to
begin with comprehensive and detailed information, you can skip this chapter.

The figure below schematically shows a typical common sequence of the 3D scanning and processing in the
Artec 3D environment.

Scanning Working with a scanner, transferring data from the scanner to a PC (mobile device) for further pro-
cessing.

Cleaning Rough cleaning of scans with the Eraser tool. Removal of the base surface and side objects.

Alignment Aligning multiple scans of the same object.

Registration Optimizing the position of frames within one or more scans.

Fusion Creating a mesh model on the base of scans.

Postprocessing Mesh simplification, smoothing and other optional steps.

Note: The need for a particular step depends on the individual case.

1.1 Preparation

1.1.1 PC Requirements

Besides a scanner itself, you need a PC to create and process models in Artec Studio. Your PC must run on the
64-bit version of Microsoft Windows 8, 10 or 11. The more powerful the PC, the better. The main memory (RAM)
and graphics card are the most critical components (visit our FAQ page for more information).

10
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1.1.2 Activation

Warning: Don’t connect the scanner just yet! Continue reading for more information.

1. Register for an account at my.artec3d.

2. Sign in and download Artec Installation Center from the welcome page.

3. Install Artec Installation Center. When prompted, enter your email and password.

4. Plug the scanner into a power outlet, then connect it to your PC using the USB cable.

5. Wait for Windows to detect the scanner. Click Activate.

6. Click Install in the Software section to get Artec Studio running on your machine.

(For more details, see User Account, Scanner Activation and Offline Activation.)

1.1.3 Prepare Object and Scene (Common Recommendations)

Most objects are easily scanned, but observe the following recommendations for best results:

• Before scanning transparent, reflective or black objects, we suggest applying a powder coating or a special
anti-glare spray.

• To scan monochrome objects with simple geometric shapes, do the following:

– Add auxiliary objects (e.g., crumpled paper) to the scene

– Paint markers (e.g., “X” shapes) on the surrounding surfaces

• Be sure to provide good ambient light.

A detailed information on preparing for different scanner types is available at the following links:

• for Artec Spider II

• for Artec Point

• for Artec Micro II

• for Artec Ray II

• for Artec Leo

• for Artec Micro

• for Artec Ray

See also:

Selecting and Preparing Objects for Scanning.

1.1. Preparation 11
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1.2 Scanning

1.2.1 Scanning with Point

After the Artec Point Addon plugin has been installed, the scanner has been set up and connected to the PC
correctly, you can start using the device.

1. Launch Artec Studio, connect the scanner to your PC and turn it on. Calibrate the scanner. To achieve the
best results, it is recommended to calibrate Artec Point before each scanning session.

2. Attach reflective targets to or near the work piece.

3. Adjust target size by expanding the Advanced section in the Scan panel.

4. Click the Play button to the right of the Scan targets in the Scan panel, and then press the Play button on
the scanner to turn on its laser.

5. Scan targets.

6. Adjust the Artec Point scan settings by expanding the Advanced section in the Scan panel.

7. Select the scanned target cloud that scanning will be based on by clicking the Scan geometry button.

8. Scan the object itself.

9. If necessary, use the Refine scan feature to select the desired area and rescan it at a higher resolution.

Figure 1: Scanning object with Artec Point.

See also:

Scanning with Artec Point in details.

1.2. Scanning 12
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1.2.2 Scanning with Spider/Spider II, Eva

1. Launch Artec Studio, then aim the scanner at the object.

2. Press on the scanner to start Preview mode. For Artec Spider II, click the Preview button in the Scan
panel.

• Geometry + Texture is the default scanning mode and is suitable for most cases

• For older PCs, Geometry mode is a good alternative

• The Real-time fusion mode creates a model in real time, allowing you to skip postprocessing; click
Stop, then select the Real-time fusion checkbox and click Preview.

3. Make sure the object is visible, then press once again to initiate recording. If possible, scan all sides of
the object in one go, slowly moving the scanner around it as pictured below.

Note: While scanning, pay closer attention to the object on the screen than to the actual
object.

4. If you hear an alert sound and the screen displays an error against a red background, smoothly aim the
scanner at the area you just captured. Possible reasons for the “Tracking lost” error include the following:

• You are scanning simple geometric shapes

• The part of the object you are scanning is too small

• Scanner movement is too fast

5. Press to finish scanning. For Spider II, use the Stop button in the Scan panel.

Figure 2: Scanning with Eva.

Turn and Scan (Optional)

Turn the object and capture any remaining unscanned regions (press ). Also, to facilitate alignment, record at
least one previously scanned region.

See also:

• LED Indicators for Eva, Spider and Spider II

1.2. Scanning 13
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1.2.3 Scanning with Micro II

1. Launch Artec Studio, connect the scanner to your PC and turn it on. Calibrate it if necessary.

2. Fit an object in the camera view. The object must be entirely visible. For large objects, consider removing
extra spacers from the scanner.

3. Adjust Brightness and other quality settings as necessary. Tune it to minimize areas highlighted in red
(potentially noisy areas).

4. Adjust bounding and cutoff settings as necessary.

5. Select Scanning path. For simple cases, use the Preview mode.

6. Click Scan with Artec Micro II. Micro II will start capturing frame while swinging the fixture platform and
rotating the turntable.

If necessary, flip the object and affix it. Then repeat the steps above to scan the remaining areas. You’ll need
to later align the scans obtained this way.

Figure 3: Aligned scans from Micro II.

See also:

Scanning with Micro II in details.
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1.2.4 Scanning with Micro

1. Launch Artec Studio, connect the scanner to your PC and turn it on. Calibrate it if necessary.

2. Fit an object in the camera view. The object must be entirely visible. For large objects, consider removing
extra spacers from the scanner.

3. Adjust Brightness and other settings as necessary. Tune it to minimize areas highlighted in red (potentially
noisy areas).

4. Select Scanning path. For simple cases, use the Preview mode.

5. Click Scan. Micro will start capturing frame while swinging the L-shaped arm and rotating the turntable.

If necessary, flip the object and affix it. Then repeat the steps above to scan the remaining areas. You’ll need
to later align the scans obtained this way.

Figure 4: Aligned scans from Micro.

See also:

Scanning with Micro in details.
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1.2.5 Scanning with Leo

Since Artec Leo is a self-inclusive device featuring computing and graphics processing units, you don’t need to
connect it to a PC running Artec Studio while scanning.

1. Tap New project or press the red button on the handle of the scanner. Leo will start preview, i.e. building
surfaces without recording them.

2. Configure the Leo settings as you need.

3. Direct the scanner at the object. Practice your movements and assess the quality of the surface being
reconstructed on the screen.

4. Once you’re ready, tap or press the red button on the handle of the scanner.

5. Scan the object from all possible sides.

6. Tap or press the red button on the handle of the scanner.

7. Rotate or turn the object upside down to scan the missing regions.

8. Tap Close if you are done with the scan.

Once you have recorded a scan, it is added to the project.

Figure 5: Scanned object.

It is possible to import projects from Artec Leo either over a network from Artec Studio or using a microSD card.
See here for details.

See also:

Scanning with Leo in details.
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1.2.6 Scanning with Ray II

Note: Scanning with Ray II can be controlled only from the mobile application Artec Remote. However, you
can import Ray II scans to Artec Studio 18. This short introductory document will cover the work with Artec
Studio.

1. First, you should scan your object using the Artec Remote app. For further scanning details, please refer
to the Artec Remote scanning information.

2. Use the USB stick to transfer data to the external computer.

3. Launch Artec Studio.

4. Select File → Import → Ray II scans menu option

5. Select scans for import

6. Adjust import settings.

Figure 6: Scanned object.

For details, please refer to the Importing Ray II scans.
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1.2.7 Scanning with Ray

Note: Ray can work both through Artec Studio and themobile application Artec Remote. This short introductory
document will cover the work with Artec Studio.

1. First, you should make a preview scan for the following reasons: to get a low-resolution image of the area
you are scanning so you can see the desired object; to estimate the required point density for scanning.

1. Ensure Ray is connected to your computer.

2. Launch Artec Studio.

3. Open the Scan panel. Click Scan with Ray. The application will open the Ray scan panel.

4. Click Preview. Ray will capture a preview.

Figure 7: Ray preview scanning.

2. Once you have a preview, you can

• Select the entire preview image to scan the whole space.

• Locate and mark sections to scan particular objects in the scene using interface buttons

like and

3. Adjust point density and other necessary settings.

4. Scan selected sections using the Scan button in Artec Studio.

See also:

• Tweaking Scanning Options,

• Scanning Procedure,

1.2. Scanning 18
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Figure 8: Marking section.

• Tracking Modes, and

• Scanning With Real-Time Fusion.

1.3 Use Autopilot

For beginners, the easiest way to obtain a 3Dmodel is by using Autopilot. It’s also a great time saver for advanced
users. If you prefer performing all the steps manually, refer to the Process Manually section.

Autopilot is a special mode that helps users obtain a complete 3D model without learning all the ins and outs
of postprocessing. It consists of two major parts: semiautomatic (editing and alignment) and automatic.

Tweaking Autopilot Settings

• Hole-filling method (available options are Don’t fill, Watertight and By radius) instructs the algorithm to
fill or not fill holes in the model.

• Model resolution—the lower the resolution value, the sharper the shape and the more details you will
see. If you’re unsure, leave the value as Auto. Effectively, it’s the same as Creating Models (Fusion)
resolution. Note that the resolution should be no less than 0.5 for scans captured using Eva and no
less than 0.1 for Spider.

• Polygon count determines how many polygons the resulting model will have. The greater the value,
the better the quality and the larger the file size. If you’re unsure, leave the value as Auto. For more
information, consult the Mesh Simplification (Tools, Mesh Optimization) section.

• Texture—clear this checkbox if you don’t want to apply texture to the model.

• Texture resolution takes specific values in the range of 512x512 to 8192x8192 or 16384x16384 pixels
depending on the available GPU memory.

• Export final model saved the resulting model in the defined Format with the given Name to the location
specified in the Save to option.

1.3. Use Autopilot 19
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To produce a model,

1. Click Autopilot in the left panel or hit F9.

2. Become familiar with the steps that you will perform in this guided mode (listed in the welcome screen).

3. In the Workspace panel, use the flag to mark all scans that you intend to use, then click Next.

4. Then specify the input parameters for themodel-creation step and clickNext. Primary settingsmay include
the following:

Note: We suggest consulting the tool tips, which you can reveal by clicking the button next
to the option name.

a. Scan quality (geometry). Click to determine whether your scan of the object has the
correct geometry by examining the tool-tip images.

b. Scan quality (texture). Click , look at the images and decide whether your scan has suffi-
cient texture.

c. Hard-to-scan surfaces. Select this option if your object has surfaces that are difficult to

capture. Consult the image samples by clicking the button.

d. There are parts to erase. Select this option to erase some parts of the scans prior to pro-
cessing.

e. Scans are well aligned. Select this option if the alignment step should be skipped.

f. Decide on the Object size by referring to the image samples.

g. Leave the default values for the remaining options in this window (sufficient for most
cases). For advanced scenarios, you can tweak these settings (more details appear in the
sidebar).

5. If necessary, erase any extraneous objects that can hinder processing and postprocessing. Learn how to
use Eraser by consulting the Erasing Portions of Scans (Eraser) section.

6. Once you’re done, click Next. If the object was captured over several scans, Autopilot will align them and
show you the result. You can approve it or align the scans manually (consult Best Fit Alignment without
Points).

7. Click Next.

8. Autopilot will begin processing and then postprocessing. Once it’s finished, a message will appear inform-
ing you that the model is ready. Click OK.

The automatic steps can be grouped as follows:

• Processing

1. Global registration

2. Outlier removal

3. Fusion

• Postprocessing

1. Small-object filter

2. Mesh simplification

3. Texturing
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Note that, the Autopilot mode does not implement advanced techniques such as HD Reconstruction and Photo
Registration.

1.4 Process Manually

1.4.1 Crop Surroundings

Once you finish, click File and select Save project. Close the Scan panel. You can now crop the surroundings.

Purpose: To erase auxiliary surfaces (e.g., a table or floor).

Steps: Open Editor → Eraser → Cutoff-plane selection. Follow the panel instructions.

Tip: Use freely other types of the Eraser (not only Cutoff-plane selection) to remove other unwanted elements
from the scan.

See also:

Editing Scans.
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1.4.2 Align

Tip: If you have only one scan (see the Workspace panel), or if you used Auto-alignment during scanning, you
can skip this step.

Purpose: To align several scans.

Steps:

1. Mark two or more scans using , click Align and select those scans in the Best fit tab while holding the
Ctrl key.

2. Click Auto-alignment.

3. If alignment fails owing to a lack of texture or lack of overlapping areas, manually match the features
among the scans and click the Align button.

Figure 9: Two scans before and after alignment.

See also:

Alignment in details.

1.4.3 Global Registration

Purpose: To simultaneously optimize the frame position across all scans, thus preparing them for further pro-
cessing.

Steps: Mark scans using , then click Tools → Registration → (Global) Run.

Tip: If you see some obvious problems with preliminary (Rough) registration after scanning, try to resolve them
by Global registration of each scan separately. See Global-Registration Parameters.
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See also:

Global Registration in details.

1.4.4 Eliminate Noise

Purpose: To erase large outliers and some noise.

Steps: Open Tools → Outlier removal → Run.

Figure 10: Outlier removal.

See also:

Editing Scans and Eliminating 3D Noise (Outlier Removal) for more details.
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1.4.5 Fusion

Purpose: To create a model (a single surface, as opposed to the multiple surfaces that constitute the source
scan).

Steps: Select Tools → Fusion → Fill holes → All (watertight) → Run.

Tip: To obtain sharper surfaces, set the Sharpness value of the Fusion algorithm to 1.

In any case, 3D resolution can be adjusted: the smaller the value, the more precise the resulting surface.

See also:

Creating Models (Fusion) in details.

1.4.5.1 Erase Flaws (Optional)

Purpose: To erase any outliers and poorly scanned regions.

Steps: Click Editor → Defeature brush. Follow the instructions.

See also:

Editing Scans
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Figure 11: Using Defeature brush.

1.4.6 Simplify Mesh

Purpose: To reduce the file size by decreasing the number of polygons without significantly distorting the actual
3D geometry.

Steps: Click Tools → Mesh Optimization → Mesh simplification → Run.

See also:

Mesh Simplification (Tools, Mesh Optimization) in details.

1.4.7 Texturing

Purpose: To create a textured model.

Steps:

1. Click Texture.

2. Select amodel (fusion output) and its source scan(s) in the corresponding fields. Also see Photo Registration

3. Select texturing for Export → Apply.

See also:

Texturing and Photo Registration in detail.
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Figure 12: Mesh simplification.
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1.5 Export, Measure, Share

To export a model(mesh):

1. Select the object, right click and select the Export→Meshes option from the contextmenu, or alternatively,
open File → Export → Meshes.

2. Select a required format, specify the folder and file name, then click OK.

To measure the model:

1. Open Measures.

2. Select one of the following:

• Distance for distance calculation: points are connected by lines (linear) or curves that pass over the
model surface (geodesic)

• Sections for area and volume calculation

See also:

Exporting Models, Scans and Point Clouds, and Measurement Tools.

1.6 Tips and Tricks

• You can reset all settings to their defaults using F10→ Scan tab → Reset to defaults.

• To return any altered parameters in the Tools panel to their default values, click the adjacent button.
A parameter lacking this button is set to the default value.

• Save screenshots by hitting Ctrl+Shift+S.

• Apply annotations using Measures: click Ctrl+LMB to tag a label and type text, then click or any-
where outside the label’s pop-up window.
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CHAPTER

TWO

GLOSSARY

The following terms related to Artec Studio and 3D scanning appear regularly in this manual.

accuracy How closely a measurement matches the actual value of the quantity being measured.

Autopilot An advanced smart mode that guides the user through postprocessing in a few steps, automatically
selecting the most effective settings and producing a 3D model.

bundle Capture of an object through simultaneous use of multiple scanners, whose numbers and relative po-
sitions are specified in the application.

CAD object A feature-based, parametric solid model used in design engineering and manufacturing. It can be
created in a CAD system, reverse-engineering software package or Artec Studio since version 15.

CAD primitive A simple CAD model created in Artec Studio and either fitted to a polygon model or positioned
independently.

collection A set of scans (or models) for alignment. An alignment session may only have one collection of
registered scans and several collections of unregistered ones.

fine registration A thorough frame alignment using an algorithm for relative positioning of sequential frame
pairs.

frames 3D surfaces captured during a scanning session, collectively constituting a scan. The scan rate varies
with scanner type and can reach a maximum of 15 frames per second using Eva.

fusion Process that creates a polygonal 3D model. It effectively melts and solidifies the captured and processed
frames or point cloud surfaces. Fusion can be run as a separate algorithm or throughout the scanning
(Real-time fusion).

global registration Algorithm that optimizes the relative positions of all frames using a single coordinate sys-
tem.

group A method of organizing objects in the Workspace panel hierarchy.

HD scan A scan that contains some frames of the high-definition (HD) resolution.

key frames Frames used by the global registration algorithm. The algorithm selects them automatically to fully
cover the surface of the captured object using as few as possible.

mesh The surface geometry of a 3D model; it comprises a series of linked polygons.

model The 3D object that results from the fusion operation (in Artec Studio) or another modeling process in a
different software package.

near and far cutting planes Planes that limit the space in which the scanner is capturing 3D frames. The device
will ignore everything that is closer than the near cutting plane or more distant than the far cutting plane.

object A distinct entity in the scanned scene, or a generic term for all 3D data in Artec Studio: scans, point
clouds, polygon and CAD models, and primitives.
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origin The center of the coordinate system.

project A method of managing the scanned material, processed data and user operation history, either in mem-
ory or on disk. Artec Studio project files use the A3D extension.

resolution The ability of a scanning system to capture detail in an object. See also 3D resolution.

rough registration Preliminary frame alignment performed during capture.

scan A sequence of frames captured in a single continuous movement of the scanner around an object or scene.

SD scan A scan that contains only frames of the standard-definition (SD) resolution.

section; in a point cloud scan Corresponds to the region selected in the Ray preview area. The application may
save these sections in the export files differently (Merging Sections).

section; in measurements Short for cross-section. Section is the plane that splits model or scan into two parts
(Sections and Volume).

sparse reconstruction object A point cloud generated by the Sparse Reconstruction algorithm from photos po-
sitioned in 3D space.

supporting surface A surface on which the object is resting (e.g., a table or the floor).

target cloud An OBC file with a set of reference targets created in a photogrammetry solution, which can be
imported to Artec Studio. It is possible to import multiple targets clouds and switch between them in
a particular scanning session. During scanning, each target from the original set of reference targets is
captured multiple times on different frames, resulting into a number of instances. The instances rep-
resenting one particular target are grouped into clusters. Information about captured targets and their
deviation from the reference ones is available in the Features panel. See also Inspecting Quality Of Targets
Clouds Registration. Alternatively, a target cloud can be created by scanning targets on the object with
Artec Point.

targets Stickers placed on the object being scanned to ease identification of the various regions. There are two
types of targets: non-coded and coded. Unless the type is explicitly specified, the target is considered
non-coded. Typically, a non-coded target is a round sticker that has a black ring with a white circle in the
center; a coded target has a unique code ring that photogrammetry software can automatically recognize.

tracking Calculation of the scanner’s position in a coordinate system relative to the scene.

transformation Any change in the position of a scan and/or its frames, for example, translation and rotation.

You can also find these terms along with some algorithm parameters in Index.
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CHAPTER

THREE

USING THE HARDWARE

3.1 3D Scanners

Artec Studio can work with one or more Artec 3D scanners. It offers tools to quickly create 3D models of
physical objects. Besidesmanaging the process of capturing objects, it lets you perform full data postprocessing,
optimize mesh tessellations and apply other operations to obtain a quality 3D model. You can then send the
complete model to a CNC machine or import it to another 3D-modeling application.

Most Artec 3D scanners are specifically designed for handheld use, offering light weight and compact size.
Using them is easy—no special knowledge or skills are necessary. To obtain a complete 3D model, simply scan
the object from different angles and fuse the resulting scans into a single model using Artec Studio.

In the images below, you can see the front and side views of Artec Spider II and its components.

3.1.1 Spider II

Figure 13: Spider II. Front view

For detailed information on the technical specifications of Artec Spider II, scanning settings, and the full scan-
ning workflow, refer to the Artec Spider II User Manual . For a quick start guide and safety instructions, see the
Artec Spider II Quick Start Guide .
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3.1.2 Point

Figure 14: Point components.

For detailed information on the technical specifications of Artec Point, scanning settings, and the full scanning
workflow, refer to the Artec Point User Manual . For a quick start guide and safety instructions, see the Artec
Point Quick Start Guide .

3.1. 3D Scanners 31

https://docs.artec-group.com/point/User%20Manual/1.0%20Artec%20Point%20User%20Manual.pdf
http://docs.artec-group.com/point/Quick%20Start%20Guide/1.3%20Artec%20Point%20Quick%20Start%20Guide.pdf
http://docs.artec-group.com/point/Quick%20Start%20Guide/1.3%20Artec%20Point%20Quick%20Start%20Guide.pdf


Artec Studio, ver. 19

3.1.3 Micro II

Figure 15: Micro II components.

For detailed information on the technical specifications of Artec Micro II, scanning settings, and the full scanning
workflow, refer to the Artec Micro II User Manual . For a quick start guide and safety instructions, see the Artec
Micro II Quick Start Guide .

3.1.4 Leo

Figure 16: Leo components.

For detailed information on the technical specifications of Artec Leo, scanning settings, and the full scanning
workflow, refer to the Artec Leo web manual . For a quick start guide and safety instructions, see the Artec Leo
Quick Start Guide .
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3.1.5 Ray II

Figure 17: Ray II components.

For detailed information on the technical specifications of Artec Ray II, scanning settings, and the full scan-
ning workflow, refer to the Artec Ray II User Manual . This user manual is available in multiple languages on
Documentation Portal. For a quick start guide and safety instructions, see the Artec Ray II Quick Start Guide .

3.1.6 Micro

Figure 18: Micro components.

For detailed information on the technical specifications of Artec Micro, scanning settings, and the full scanning
workflow, refer to the Artec Micro web manual . For a quick start guide and safety instructions, see the Artec
Micro Quick Start Guide .
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3.1.7 Ray

Figure 19: Ray components.

For detailed information on the technical specifications of Artec Ray, scanning settings, and the full scanning
workflow, refer to the Artec Ray web manual .
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3.1.8 Eva

Figure 20: Eva components.

For detailed information on scanning with multiple Eva scanners, refer to Hardware Synchronization for Eva ,
for HD scanning with Eva, see Notes on HD Scanning With Eva, and for further processing of scanned data, visit
the Data Processing page.

3.1.9 Spider

Figure 21: Spider components.

For detailed information on scanning workflow, refer to Notes on Scanning With Spider and for further process-
ing of scanned data, visit the Data Processing page.
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3.1.10 Field of View Comparison: Artec Eva vs. Artec Spider

Depending on the size of the object you’re scanning, use either the Artec Point, Artec Ray/Ray II, Leo, Eva,
Spider/Spider II, or Micro/Micro II. The primary difference between these models is the depth and field of view.
They also differ in 3D resolution as well as point accuracy; consult the Artec website and relevant manuals for
details.

Figure 22: Fields of view for Eva and Spider 3D scanners.

You can combine several different scanner types while capturing a scene. In some cases when capturing complex
shapes, this capability increases the scanning rate and enables you to achieve your desired precision.

3.1.11 LED Indicators for Eva, Spider and Spider II

Artec scanners include built-in multicolor indicators. By explaining the meaning of these indicators, the list
below enables you to keep track of the scanning process:

Steady blue—scanner is booting up.

Flashing green—Artec Studio cannot detect a 3D scanner.

Steady green—scanner is connected to the application and ready to use.

Flashing red—scanner is in Preview mode, or tracking in Recording mode is lost.

Steady red—scanner is in Recording mode and object tracking is proceeding correctly.

3.1.12 Hardware Buttons for Eva, Spider and Spider II

Artec Eva and Artec Spider scanners have three-position buttons on their bodies.

—press this button once to open the Scan panel and start Preview mode; press it once more to switch to
Recording mode. Subsequently, pressing this button will switch between Preview and Recording.

—press once during a scan to stop the scanning process; press twice to stop scanning and close the Scan
panel.

Artec Spider II scanner has a Play/Pause red button on its body.

—Being in the open Scan panel, click the Preview button, direct the scanner at the object, then press the
Play/Pause button on the scanner to switch from Preview to Recordingmode. To pause scanning, press this
button once more. To complete scanning, click the Stop button in the Scan panel.
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Figure 23: Scanner buttons: Artec Spider on the left and Artec Eva on the right.

3.1.13 Hardware Synchronization for Eva

Artec Eva is equipped with two jacks designed for 6P6C connectors (RJ12). By creating a bundle, you can link
multiple Artec Eva scanners to each other. The master device is a leading scanner that sends signals to the
next slave device. Each subsequent device is connected to the previous one sequentially as Figure 24 shows. To
connect the devices, you can use a standard phone cable (RJ12 6P6C) or any other cable that uses the conductor
scheme shown in Figure 24. Each scanner should also connect to the PC via USB.

Warning: Only Artec Eva scanners can connect to each other. Do not connect Artec Eva to a telephone wall
port!

Figure 24: Synchronization scheme.
Jacks on the Artec Eva scanner shown at left and conductors in a 6P6C connector shown at right.
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3.2 Artec Turntable

Artec Turntable is designed to ease scanning of small and midsize objects by eliminating the need to rotate
them manually. Both the rotary plate and the mat that comes with the turntable feature a special pattern to
ensure robust tracking with Artec scanners. The mat is made of silicone, which prevents objects from sliding
off the rotary plate.

To scan using Turntable, follow the steps:

1. Ensure your computer has a Bluetooth adapter that supports the 4.0 standard.

2. Add a new Bluetooth device.

3. Open Artec Studio.

4. Access the Scan panel.

5. Select the Use turntable checkbox.

6. Place the object on the turntable.

7. Click Preview.

8. Click Record to start capturing. The turntable will start rotating.

9. Click Pause or Stop. The turntable will stop rotating.

3.2.1 Recovering Lost Tracking

If you experience a tracking loss, Artec Studio will pause the turntable. It also turns the rotary plate back by
about 15 degrees. Once the application has recovered tracking, it resumes rotation.

3.3 3D Mouse

Artec Studio can work with 3Dconnexion manipulators.

Basic support includes navigation in 3D View and the following commands:

• Home

• Fit to view

• Undo

• Redo

For 3D mouse to function, you need to install drivers from the manufacturer’s website. Additionally, you can
assign four currently supported commands to the mouse radial menu or at least two of them to the hardware
buttons for Artec Studio.

To assign a command to the 3D mouse button, follow the steps:

1. Open Artec Studio

2. Then open 3Dconnexion Properties utility from the Windows tray

3. Click Buttons

4. Click on the > arrow on the right side of either button field. A flyout window will open for that 3D mouse
button.

5. Open the Artec Studio category
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6. Select either of the currently supported command.

Figure 25: Assigning command to 3D mouse button.

If you want to assign several commands, create a new Radial menu (use the eponymous category in the flyout
menu). For more information, consult the manual for your 3Dconnexion mouse.

To get used to navigating 3D content, use 3Dconnexion Trainer or 3Dconnexion Demo from the 3Dxonnextion
Home application.

Note: In Artec Studio, you move the camera around the object rather than the object itself.

3.4 Artec Battery Pack

Available as an accessory, battery pack allows you to scan anywhere without the need to be near a power outlet.
Battery from this pack supports Artec Eva, Artec Spider and Artec MHT scanners and lasts for up to 6 hours of
scanning.

Battery pack includes the following items:

• Battery

• Battery pouch

• Power adapter (110–230 V → 19 V)
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Figure 26: Battery pack with Eva.
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1. Fully charge Artec battery using its Input socket.

2. Plug the cable into the battery Output socket.

3. Then connect the cable to your Artec scanner.

Figure 27: Battery ports from left to right: Input, Output.

Important: Never confuse battery ports when connecting scanner.
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CHAPTER

FOUR

INSTALLATION

4.1 System Requirements

Your computer must meet the system requirements to use Artec 3D scanners.

In addition, take note of the following:

• Real-time fusionmode (Scanning With Real-Time Fusion): ensure that your graphics card has at least 1 GB of
memory or your Intel HD Graphics chipset is 4600 or higher (consult the FAQ article for more information).

• Using multiple scanners (Multicapturing) requires your workstation to integrate as many independent USB
host controllers as connected scanning devices. Upgrading your hardware with PCI/PCI Express USB cards
may provide the required number of hosts.

• Using HD mode

– If you are going to use the scanner in the HD mode, ensure that your Nvidia GPU has a minimum
CUDA compute capability of 6.1, 2 GB of memory (4 GB for Leo scans) or more and your computer’s
RAM is at least 32 GB.

– If your computer does not meet these requirements, you can still perform the HD reconstruction, but
it may take up to several hours. In this case, it is recommended to use lower values of Point density
(see Enabling HD Mode for details).

4.2 User Account

To install Artec Studio and keep it up to date, register for a free account at my.artec3d. Registration is also
required to activate an Artec 3D scanner. In addition, the site allows you to track all your Artec devices and
products.

Your account at my.artec3d will be valid for all Artec sites and services.

To register, follow these steps:

1. Go to my.artec3d and click please sign up.

2. Fill in all the fields in the registration form (by clicking Next) and click Create account.

3. Receive a registration email that contains a confirmation link.

4. Click the link or copy it to your browser to confirm your registration and go straight to your my.artec3d
account.
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Figure 28: my.artec3d welcome screen.

4.3 Scanner Activation

Before using your new Artec 3D scanner, you must activate it and link it to an account at my.artec3d. You can
do so with the help of Artec Installation Center—a standalone utility available for download from my.artec3d.
If you’re a new user and don’t yet have Artec Installation Center, please read Running Artec Installation Center
below. Otherwise, proceed to 3D Scanner Activation Using Artec Installation Center.

Warning: Do not connect your scanner to the USB port before installing Artec Installation Center.

4.3.1 Running Artec Installation Center

To use Artec Installation Center, first ensure that your computer is connected to Internet. Any computer with
USB2.0 or USB3.0 ports will work. If necessary, you will be able to install and activate Artec Studio on a separate
computer later. Also make sure that you already have a my.artec3d account; if not, see User Account.

1. Log into yourmy.artec3d account and download Artec Installation Center. The link for the Artec Installation
Center executable is available in the My software section.

2. After downloading, open the folder that contains the executable and run it. Follow the instructions on
the installation screens. Once Artec Installation Center is installed, you will see a dialog requesting your
email address and password. Use your my.artec3d account to log in as Figure 29 shows.
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Figure 29: Authentication for Artec Installation Center

4.3.1.1 Logging Out and Switching Accounts

You may need to change my.artec3d account. Artec Installation Center displays the current user email in the
top-right corner (Figure 46).

To log out of Artec Installation Center:

1. Click Log out.

2. Enter another user’s email and password in the window that opens.

3. Click Sign in.

4.3.2 3D Scanner Activation Using Artec Installation Center

To activate a 3D scanner using Artec Installation Center, make sure your computer is connected to the Internet
and that you have installed the application.

1. Run Artec Installation Center (go to the Start menu: click Start → All Programs → Artec Group → Artec
Installation Center) to bring up the window shown in Figure 46.

2. Connect your new Artec 3D scanner to the computer and wait until Windows detects the device and installs
the necessary drivers. You may see a notification similar to one shown in Figure 30.

3. Go to Artec Installation Center, click Refresh and wait for the new 3D scanner to appear in the hardware
box. Click Activate (to the right of the serial number) to enable your 3D scanner. The status of the device
should change to Activated, as Figure 31 shows.

Figure 30: Windows notification indicating device installation.
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Figure 31: 3D scanner activated

4.4 Artec Studio Installation

There are two ways to download and install Artec Studio:

• Through Artec Installation Center (either during the installation process or by clicking Install in the appli-
cation, as Figure 32 shows)

• From my.artec3d—log into the site, go to the My software page and download the executable (see Figure
33)

Figure 32: Artec Installation Center is ready to install Artec Studio.

If you download the executable, run it to begin installation; otherwise, click Install in Artec Installation Center. To
continue with the installation, click Next and proceed to the license agreement (see Figure 34). After reviewing
the agreement, accept it by clicking Yes.

Note: The following figures are only for reference. Please follow these steps by selecting the particular version
you want to install.

Specify the path to the installation folder (we recommend using the default location) as Figure 35 shows, then
select the components you would like to install (see Figure 36):

Program-menu shortcuts create icon in the Start menu

Desktop shortcut create icon on the desktop

Start-menu shortcut add shortcuts to the Start menu and Quick Launch panel

English manual install user manual in English

Artec scanner drivers install drivers for Artec 3D scanners

Artec Ray drivers install drivers for Artec Ray 3D scanner

Artec Micro drivers install drivers for Artec Micro 3D scanner

Artec Micro II drivers install drivers for Artec Micro II 3D scanner

Artec Point add-on install Artec Point Add-on plugin
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Figure 33: Portion of My software page at my.artec3d.

Figure 34: License agreement
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Figure 35: Installation location

Figure 36: Select components to install
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Figure 37: Click Install to begin the installation

Figure 38: Artec Installation Center showing Artec Studio activation window
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Figure 39: Finish installation

By default, the application will create all of the above icons and install the user manual and Artec 3D-scanner
drivers. To continue with the installation, click Next.

If you have yet to install Artec Installation Center, a login dialog will appear, as Figure 29 shows. If you are not
connected to the Internet, consult Offline Activation regarding offline activation of Artec Studio.

If you have yet to link to your account the computer on which you are installing Artec Studio, you will see the
activation confirmation shown in Figure 37.

When the installation is complete (see Figure 38), the installer will offer to launch Artec Studio.

4.5 Offline Activation

If the computer on which you are installing Artec Studio lacks an Internet connection for security or other
reasons, you may use the offline activation procedure to activate the software.

Note: Copies of Artec Studio activated offline cannot be deactivated, so use this option only if absolutely
necessary.

Note: Before conducting offline activation, make sure the scanner (see Scanner Activation) and Artec Studio are
tied to your my.artec3d account.

For offline activation, you need the following:

• Another computer connected to the Internet
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• Artec Studio installation package (preferably, download it from my.artec3d)

• Flash drive or another storage medium to transfer files from the Internet-connected computer to the
computer that will run Artec Studio

Figure 40: Artec Installation Center authentication dialog

Figure 41: Artec Installation Center — Activate offline

Installation and activation procedure:

1. Start Artec Studio installation.

2. During installation the login/password dialogwill be displayed as Figure 40 shows. Click Continue offline….

3. Click the Activate offline button in the pop-up window.

4. In the offline-activation dialog (Figure 42), click Save… and save generated Activation ID file to a flash
drive or other storage medium.

5. Log into your my.artec3d account and open My software page using the Internet-connected computer.

6. Find Artec Studio and click on it. A new page will appear, as Figure 43 shows.

7. Click the Activate application offline link then the Select file button and specify the Activation ID file path.
Next, click Activate.

8. A new dialog will allow you to download an Offline Activation Data file; save it to the flash drive.

9. Return to the computer on which you are installing Artec Studio. Click Activate and Continue and specify
the Offline Activation Data file.

Note: Once you create the Offline Activation Data File, my.artec3d will decrease the number of available
activations by one.
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Figure 42: Offline-activation window

Once you complete all the steps described above, your copy of Artec Studio will be activated and all of your
Artec 3D scanners will be installed on the non-Internet-connected computer.

Figure 43: Offline activation at my.artec3d.

Note: If later you purchase another Artec 3D scanner, you must reinstall the application and repeat the acti-
vation procedure described above to copy the new scanner’s data files to your computer.
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4.6 Deactivation

Note that deactivation is only possible for computers on which you activated Artec Studio online as Artec Studio
Installation describes. Artec Studio installations activated offline cannot be deactivated.

Note: The number of deactivations may be limited, so deactivate Artec Studio only if you absolutely must
move it from one computer to another.

Figure 44: Deactivation of Artec Studio.

To deactivate a license on your computer, follow these steps:

1. Make sure the computer is connected to the Internet.

2. Go to Control Panel → Uninstall Applications and click on Artec Studio. The uninstallation process will
start.

3. The dialog shown in Figure 44 will appear. Select the I understand. Deactivate Artec Studio checkbox.

4. Click Next to complete the uninstallation.

4.7 Managing Artec 3D Scanners and Products

Artec Installation Center manages applications and 3D scanners linked to your account.

It’s a multifunctional supplement to Artec Studio that connects with my.artec3d and helps you install new ap-
plications, download updates and manage your 3D scanners. To launch Artec Studio for the first time, you must
log into my.artec3d. After this one-time authentication, you need not provide your email address or password
each time you launch the application.

When Artec Studio launches, Artec Installation Center checks for new updates; if an update is available for any
installed product, the software will display a notification like the one shown in Figure 45.
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Figure 45: An Artec Studio update is available for download.

Once you log in, Artec Installation Center displays information about your products.

Figure 46: Artec Installation Center.

The Software section of Artec Installation Center provides all information about your software products:

• A list of all applications available to you

• Activation status of each application (application may or may not be activated)

• Total number of activations and number of activations you’ve used so far

• Activate, Install or Update buttons for any of these actions that are currently available to you

– Install—appears if the software is not installed on the computer (installation usually means activa-
tion)

– Activate—appears if the software is not currently activated on the computer. Activation decreases
number of licenses by one for each computer.

– Update—appears if a new version of installed software is available for download

The Hardware section contains a list of the scanners that you own or have otherwise connected to your computer.
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For the first case, the Activated status or Activate button will be displayed, while in the second case, the On loan
status or Rent button will be displayed.

A row of buttons appears at the bottom of the Artec Installation Center window:

Refresh —refresh the data displayed by Artec Installation Center

Close —exit Artec Installation Center
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CHAPTER

FIVE

SCANNING

5.1 Scanner Buttons and Capture Modes

Your 3D scanner may be in one of the following capture modes (each of which has a corresponding color and
flicker rate of the LED indicator on the device):

Figure 47: Understanding capture modes (colors correspond to scanner LED indicator colors).

Idle—the LED is steady green . This mode indicates either that the application has detected the scanner or
that the user has clicked the Stop button in the Scan panel or pressed the button on the scanner body
(see Figure 23). In this case, the 3D scanner is not flashing.

Preview—the LED is flashing red . In this mode, the 3D scanner is capturing images, but the software is
neither performing alignment nor recording captured frames. To start this process, either click the Preview
button in the Scan panel (see Figure 67), press the button on the scanner body or hit the F7 key on the
keyboard. This mode is useful when doing the following:

1. Checking the 3D scanner’s field of view

2. Determining the best position for the object

3. Preparing to recording and developing a scan procedure

4. Adjusting texture brightness

Recording—the LED is steady red Scanning takes place in this mode, with the software storing 3D data to
disk or RAM. Activate this mode either by clicking the Record button in the Scan panel, hitting the Space
key on the keyboard or pressing the button (do so once for Preview and a second time for Recording). To
pause recording, either click Pause in the Scan panel, press on the scanner body or hit the Space key.
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5.2 Selecting and Preparing Objects for Scanning

Artec 3D scanners employ the structured-light method of 3D reconstruction. Since they capture 3D frames using
optical technology, some types of objects are difficult to scan. Certain techniques, however, enable successful
scanning of such objects. For example, you can cover a transparent or dark object with a light paint or dust it
with talcum powder. You can also use other easily removable substances or a special anti-glare spray.

Table 1: Hard-to-scan Surfaces
Surface Features Possible Solutions
Black or very dark Dust with anti-glare spray
Shiny or reflective objects Dust with anti-glare spray, tilt scanner when capturing
Transparent (glass, certain kinds of plastic, etc.) Dust with anti-glare spray
Thin edges Add background geometry (e.g., crumpled paper)

Note: If your scanner supports the HD mode, then you can capture dark or shiny surfaces in high resolution, in
their original shape and with no extra steps. See HD Scanning and HD Reconstruction for details.

5.3 Technique

Artec 3D scanners capture objects at a rate of 15 frames per second to ensure that adjacent frame areas overlap
as you gradually move the scanner. Artec Studio uses features in overlapping areas to automatically align cap-
tured frames. It performs this task in real time, providing immediate access to the frames in a single coordinate
system. You can evaluate the captured area after the scanning session to determine which parts of the object
require additional scanning.

To accurately capture an object or scene, follow these steps:

1. Pay closer attention to the object on the screen rather than looking at the actual object.

2. Ensure that Artec Studio can accurately register frames from the scanner. To this end, do the following:

• Don’t move the scanner too fast

• Keep the object as close to the center of the field of view as possible

• Maintain the scanner orientation in such a way that the field of view is sufficiently filled with surfaces
(see Figure 48)

• Try to position the scanner in the way the most surfaces in the field of view are colored in green
which corresponds to the center of the range meter1 (Figure 49)

3. If you’re capturing an object over several scans, remember to capture a common area in each one to ensure
successful alignment

4. If you’re capturing an object in one scan, do so all the way around the object—regardless of direction—plus
a little more (360+ degrees)

1 Technically, the center of the range meter is the center of the depth of view. The 3D scanner has near and far cutting planes (see
Figure 22) that determine the optimum distance between the scanner and the target object. Artec Studio offers the Range meter feature so
you can easily visualize the distance between the scanner and the object during the recording process. The Range meter comprises a set
of semitransparent diagrams located on the left side of the 3D View window (see Figure 49). Each histogram displays the distribution of
captured surface points by distance from the scanner. The color corresponds to the set of surfaces from which it was obtained: by default,
gray indicates registered key frames, dark green indicates the last successfully registered frame and red indicates a registration error.
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Figure 48: Scanner orientation and reconstructed surfaces.

5. Avoid capturing any objects that may change shape during the scanning process. When the geometry of
the scene is changing, the system may fail to find the correct position of new frames relative to previously
aligned ones. If you have captured unwanted objects, you must remove them later during the editing
stage (see Editing Scans).

6. Don’t record too many frames: ensure that you have sufficiently scanned all regions, but avoid scanning
them twice, except when providing overlapping areas for subsequent alignment.

5.4 Scanning Procedure

Ins and Outs

• Artec Studio creates a new scan in the Workspace panel at the beginning of each session.

• When you start Preview mode, Artec Studio will hide all uploaded scans. This mode helps you to
determine how well the 3D scanner sees the object, and it helps you to identify areas that may cause
trouble during the scanning session. To begin the scanning process, click the Record button in the Scan
panel or press the button on the device body.

• If your 3D scanner is equipped with a texture camera, Artec Studio will activate the scanner’s texture
flash and capture color images that it will later use to texture the 3D model.

1. Prepare the object and make sure it has enough geometry and texture details (see Selecting and Preparing
Objects for Scanning).

2. Provide even lighting without using direct sunlight.
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Figure 49: Distance meter and distance color showing surfaces that fall within the optimal range for Artec Eva.
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3. If you have connected just one 3D scanner to the computer, Artec Studio will select it automatically;
otherwise, you must select the appropriate device from the dropdown list under the Advanced section of
the Scan panel.

4. If your selected 3D scanner supports the HD mode (such as Artec Eva) and you want to get the scanned
images in high-definition resolution, you need to turn the HD mode on (see Enabling HD Mode for details).

5. Create a new project before getting started: select File → New project from the menu, or use the shortcut
Ctrl+N.

6. Decide how many sessions you need in order to capture the entire object. By using the Artec turntable,
you may be able to avoid interrupting the session and eliminate the need to turn the object by hand.
Depending on your choice, you may

• Turn the object

• Position yourself to gain access to the other area

• Use a rotating table

7. Click Preview or press on the scanner. Direct the scanner at the object and practice your movements
around the object, taking into account the proper Technique.

Note: If you have checked the Enable automatic base removal option (it is disabled by default),
then first direct the scanner at the surface that supports the object.

8. Click Record to start capturing.

9. Gradually move the scanner while monitoring the process in the 3D View window

10. Capture what you can and pause or cease recording by clicking the Pause or Stop button, respectively.
Choose Stop if you must make adjustments to the object’s positioning (see the next step).

11. Turn the object or otherwise adjust it as necessary, then capture any remaining unscanned regions.

12. Once you have successfully captured the object from all sides, click the Stop button or press on the
scanner body.

5.5 HD Scanning and HD Reconstruction

While all Artec scanners can scan 3D objects in the standard-definition (SD) resolution, Artec Eva and Artec Leo
also support an HD mode — AI-powered scanning technology for ultra-sharp, clean, and detail-rich scans.

Key advantages of the HD mode:

• Scanning with a high resolution of up to 0.2 mm

• Broad range of objects that can be scanned flawlessly and in high detail: from smaller, intricate parts like
valve handles, to larger areas with fine details like car engines

• Little to no noise in raw data for cleaner post-processed data and saved time for your final 3D model

• Capability to capture dark or shiny surfaces in high resolution, in their original shape and with no extra
steps

To obtain HD scans from the data captured in the HD mode, Artec Studio provides you a special algorithm of HD
data processing — HD reconstruction. This algorithm generates large, high definition frames with more details
to give you complete surface geometry.

In general, the HD reconstruction is a time-consuming and resource-intensive operation. It requires:
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• Powerful Nvidia video card

• Sufficiently large RAM

However, you can optimize the HD reconstruction by properly choosing its main parameters:

• Point density, which determines the number of points per frame used for data processing

• HD frames frequency, which determines the fraction of captured HD frames to be used for the HD recon-
struction

See Enabling HD Mode for details.

Important: To obtain HD scans with your 3D scanners, the HD mode should be enabled in advance, before
scanning or importing the HD data.

To find out more on the HD scanning and HD reconstruction with Artec Eva, see Notes on HD Scanning With Eva.

Setting the HD mode for Artec Leo is described in the Artec Leo manual. For information on importing the HD
data from Artec Leo, see Opening a Project from Leo.

5.6 Tracking Modes

Ins and Outs

• Artec Studio still records texture in Geometry trackingmode if the scanner incorporates a texture camera

• Continuous scanning in the hybrid tracking mode is easier with the Scan using auto-alignment option.

The software provides three tracking modes and one option:

Geometry + Texture, or hybrid The optimal (and default) algorithm for 3D scanners equipped with a texture
camera. It uses features from images obtained using the texture camera as well as geometrical features
of the object and thus is more likely to successfully capture flat or textureless objects. The only possible
drawback is greater CPU utilization compared with other algorithms, potentially decreasing the frame
rate for less powerful computers. You can use this mode with Artec MHT, Artec Eva, Artec Spider, and
Artec Spider II.

Geometry The default algorithm for all 3D scanners that lack a texture camera (Artec Eva Lite). It uses only
object geometry to align the scanned frames, making it suitable for objects that have a rich geometry but
not objects with large flat, spherical or cylindrical parts. The Geometry tracking algorithm is the least
CPU hungry.

Targets A special algorithm for scanning objects with special targets placed on their surfaces. See Target-
Assisted Scanning.

Real-time fusion (option) Available for Artec 3D scanners, this option fuses the results immediately after scan-
ning.

See also:

Tweaking Scanning Options
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Figure 50: Texture tracking renders color object (scanner’s current field of view outlined in green).

Figure 51: Main window when using Geometry tracking to scan objects.
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5.6.1 Base Removal: Erasing a Supporting Surface

Ins and Outs

• Base removal is available for all tracking modes.

• If you click Stop or press , you should again identify the supporting surface.

• If the scene remains unchanged, you can also use the Auto-align new scans with those marked in
Workspace option. In this case, the application won’t prompt you to identify the base.

• If base detection is successful, the base will always render in Recording mode.

When you capture an object, you can often omit from the scan any surface that supports the object. The Base
removal option serves this purpose. To employ this option, first indicate the surface on which the object is
resting and then capture the object. If this approach is unsuitable for your situation, clear the Enable automatic
base removal checkbox.

1. Open the Scan panel.

2. Check the Enable automatic base removal option (it is disabled by default).

3. Click Preview and direct your scanner at the surface that supports object (e.g., a table or the floor). A gray
wireframe plane will appear, indicating the scene’s base.

4. Once the application detects the base, it will display a message: “Now scan the object.”

Important: If Artec Studio fails to detect a supporting surface, you can still start recording.

5. Click Record ( ) and then direct the scanner at the object.

6. Scan the object freely. You can pause and resume the session as necessary.

7. Click Stop; all scans will move to the coordinate system with the Z axis normal to the base.

8. Close the Scan panel. The Base removal algorithm will remove the previously detected supporting surface.
If not, erase it manually.

5.6.2 Resuming Scan After Lost Tracking

Artec Studio records adjacent frames on the basis of common surface features. If the scanner stops recognizing
common features, it will stop capturing the scene. This situation is called lost tracking; if it happens, just direct
the scanner at a recently captured region. There are, however, nuances, which we address below.

Table 2 lists several causes of lost tracking. The most common is moving the scanner too fast.

Table 2: Causes of lost tracking.
Reason Possible Solutions
Moving the scanner too fast Move the scanner more slowly or increase the Scanning speed
Scanner sees too few surfaces Apply an anti-glare spray or direct the scanner at a larger part of the

object; increase Sensitivity of Artec Spider
Object doesn’t have enough features
for successful tracking

Apply masking tape or draw markers on the surrounding surfaces,
and/or move the scanner more slowly
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Figure 52: Scanning with the Enable automatic base removal option.
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Figure 53: Alert message: tracking lost.
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The Scan using auto-alignment option may ease the process of resuming tracking (this option is enabled by
default in the application settings). Note the following:

• Artec Studio switches almost instantly from displaying Tracking lost mode (see Figure 53) to Searching for
position, which appears on a green background.

• To continue scanning, direct the scanner at a region you’ve already captured.

– Try to maintain the original scanner orientation toward this region

– You need not necessarily use the most recent one, but it should have sufficient texture features.

• If the application successfully resumes tracking, it will start recording in a newly created scan. This new
scan will already be aligned with the previous one. All the scans will also be grouped.

Figure 54: Workspace panel after resuming tracking.

The Scan Using Auto-Alignment section describes system behavior when this option is disabled.

5.6.3 Auto-align new scans with those marked in Workspace

Auto-alignment is a great timesaver and may help simplify further processing. But for projects that involve
scans using Geometry + Texture tracking and for which the actual scene is unchanged, you can continue scanning
immediately:

1. Ensure that the Scan using auto-alignment option is turned on in Settings (see Capture).

2. Mark previously captured scans using the icon in the Workspace panel.

3. Select Geometry + Texture tracking as well as the Auto-align new scans with those marked in Workspace
checkbox in the Scan panel.

4. Click Preview, direct the scanner at a textured region you’ve already captured textured region—maintaining
the original scanner orientation—and then click Record.

5. If tracking resumes successfully, Artec Studio will align the newly recorded scan with the selected ones.
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5.6.4 Scanning With Real-Time Fusion

Real-time fusion is a special mode in which Artec Studio builds a 3D model in real time while you’re scanning.
It’s the easiest and fastest way to obtain a model, but it cannot completely replace the normal workflow for
processing raw scans after capturing them. Thus, we recommend avoiding Real-time fusion in the following
cases:

• The scene is large and the amount of GPU memory is limited

• Objects have complicated shapes that cannot be captured in one scan session

• The object has small geometric details

• Extra-high accuracy is required

Figure 55: Real-time fusion model.

The Real-time fusion feature is available for each tracking method.

1. Open the Scan panel.

2. Select the required tracking mode.

3. Select the Real-time fusion checkbox2.

4. Click Preview and then Record. Observe the recommendations in Scanning Procedure.

5. Pause and resume the session as necessary.

6. When you stop scanning, the Workspace panel will add one or more raw scans named Spider Scan1,
Spider Scan2, Spider Scan3 and so on, as well as one model named Spider Scan1-Fusion.
The number of these raw scans corresponds to how many times you pause and resume scanning (see
Figure 56).

You can access the Settings window and use the Performance tab to configure the following Real-time fusion
settings (see Real-Time Fusion Settings):

Voxel size 3D resolution of the model (i.e., the size of the triangulation-grid step in millimeters). The smaller
the value, the more geometric details you can detect and capture in 3D.

2 If you selected the Targets mode and cleared the Disable hybrid tracking for .obc checkbox (see the Photogrammetry Settings section),
Artec Studio will clear the Real-time fusion checkbox because it doesn’t support this combination of options.
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Figure 56: Workspace panel after using Real-time fusion.

5.7 AI Photogrammetry

Starting from Artec Studio 19, two new algorithms have been added to allow users to reconstruct 3D models
from sets of photos and videos without a 3D scanner and a photogrammetry kit. Please be aware that projects
created by this version might not be compatible with older versions of Artec Studio.

The Photo Reconstruction pipeline in Artec Studio is divided into two consecutive stages:

• Sparse Reconstruction positions photosets in 3D space, generating a sparse reconstruction object as the
output.

• Dense Reconstruction creates a final 3D mesh that can be further processed and textured.

Dense Reconstruction offers two different algorithms:

– Separate Object Reconstruction is intended for a single object that is fully captured within the frame
and clearly separated from the background.

– Whole Scene Reconstruction is suitable for feature-rich scenes, such as aerial or drone captures, or
objects like stones, statues, and architectural structures, where there is no requirement to separate
the object from the background.

See also:

For more details on the full workflow of AI Photogrammetry, preparing objects for the algorithms, their basic and
advanced settings and hardware limitations, please refer to the Photogrammetry Quick Start Guide.

5.8 Target-Assisted Scanning

Generally, you don’t need any special equipment to record using an Artec scanner. If the object has hard-to-scan
regions, however, targets may be useful. In some cases, they can improve tracking and further registration.

Targets address the problem of increased deviation when scanning large objects and provide more scanning
accuracy by very precise ongoing alignment. Starting from version 17, Artec Studio gives you the ability to eval-
uate the quality of reference targets capturing when scanning. You can view the distribution of error deviation
across the whole set of the reference targets (see Inspecting Quality Of Targets Clouds Registration).
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5.8.1 Placing Targets

Whatever the method chosen, you should place at least non-coded targets on the object.

Attach non-coded targets (Figure 57) to the object using the following rules:

• Try to place them on flat elements

• Avoid uneven surfaces

• Avoid obstructing significant geometric elements

Figure 57: Non-coded targets placed on an object.

Note: You can specify the target size in the Settings dialog of Artec Studio, as Photogrammetry Settings describes.
If you use non-coded targets from the Scan Reference kit, specify 5mm for the inner diameter and 10mm for the
outer diameter. You should measure targets from other suppliers and specify both diameters in the appropriate
fields of the Settings dialog.

Place coded targets if your choice is photogrammetry (Photogrammetry Solution).

1. Prepare the objects and surrounding scene. All objects must remain stationary during measurement and
capture.

2. Place the cross (Figure 59) on the scene, ensuring that it rests firmly, and it is seen from most points of
view. Also double check that all targets on the cross are clearly visible.

3. Place the coded targets on the object and the surroundings. Note that you should distribute them such
that at least six to eight coded targets are visible in each image. Random placement is preferable; avoid
symmetry and target alignment.

Figure 58: Coded targets.
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5.8.2 Using Artec Scanners Only

You don’t necessarily need a photogrammetry kit to benefit from targets placed on the object you’re scanning;
Artec 3D scanners can do all the work. This mode employs extra-hybrid (Geometry + Texture + Targets) tracking
and doesn’t require you to upload an OBC file.

1. Open the Scan panel in Artec Studio. Select Targets under Features to track.

2. Scan the object from all sides

3. Run Global registration

Note: As you scan (without having uploaded an OBC file), the application registers the target coordinates.
You can then save an OBC file and use it in later scanning sessions. We strongly recommend running Global
registration first, however.

5.8.3 Photogrammetry Solution

By using a combination of special reference targets and photogrammetric measurements, you can scan large
areas in one session, improve the accuracy of captured surfaces and boost productivity by reducing postpro-
cessing time. The only downside of this method is the preparation. After scanning, however, you need not align
the scanned surfaces, so you can immediately proceed to Fusion (see the order of postprocessing steps in 3D
Scanning at a Glance).

This synergy of technologies is possible thanks to Artec 3D-scanner and photogrammetry solutions. Several
third-party photogrammetry offerings are available on the market. Scan Reference photogrammetry is one ex-
ample. The Scan Reference kit includes hardware and software (see Figure 59), a digital camera, a reference-scale
cross, non-coded sticky targets (which Artec Studio uses to match the captured 3D data to the photogrammetric
measurements), and reusable magnetic coded targets (required to automatically carry out measurements in the
Scan Reference software).

Figure 59: Scan Reference kit
The kit includes (from left to right) coded targets (foreground), a digital camera, a scale cross, a roll of tape with

non-coded targets and a carry case.
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5.8.4 Preparing To Scan With Targets

1. Take several photos of the object from different angles. To determine the appropriate number of photos,
angles and targets for each image, as well as required settings for a calibrated digital camera, consult the
Scan Reference user manual and FAQ article. General recommendations are as follows:

a) Take photographs at a distance of 0.5–1.5 meters with enabled flash

b) Each photograph should contain as much targets as possible and each target should be captured at
least in 10 photos

c) Entire cross should be captured in first 10–12 photographs

d) Capture the object from all sides

2. Move the cross and the coded targets away from the scene.

3. Connect the camera to a PC, then transfer and process the photos using the Scan Reference software. Once
the calculations are complete, the software will display measurement results on the screen. These results
can appear as a point table or a 3D model.

4. Save the table of points in an *OBC file. This format is the software’s default.

5.8.5 Scanning Procedure With Targets Clouds

To perform scanning using targets, follow these steps:

1. Import one or more target clouds (OBC files), using the File→ Import → Scans, meshes or point cloudsmenu
option or press Ctrl+I. You can also drag and drop the files to the area of the 3D View window. The
imported objects will appear in the Workspace panel and will be rendered in the 3D View window.

2. Open the Scan panel in Artec Studio. Select Targets under Features to track.

3. Select a targets cloud to use as a reference from the dropdown list below.

Important: If you don’t want the texture and geometry features to assist target scanning, select
the Disable hybrid tracking for .obc checkbox (Photogrammetry Settings).

4. Scan the object. When you finish, the software will automatically align and register all scans.

5. Check the quality of targets’ registration (see Inspecting Quality Of Targets Clouds Registration).

6. If you have introduced changes to the captured targets cloud on step 5, run Global registration.

7. If necessary, repeat steps 5 and 6.

5.8.6 Inspecting Quality Of Targets Clouds Registration

To increase the accuracy of scanning with targets and give users more control and flexibility, an ability to
manually inspect the quality of target clouds registration is implemented in Artec Studio.

During scanning, each reference target is captured in a number of frames. The result of target capturing in a
particular frame is called an instance. All instances representing the same target are grouped into a cluster.
During global registration, Artec Studio calculates the deviations of each captured instance and cluster from
the corresponding targets of the reference target cloud.

The deviation values are listed in the Features Panel. They are also shown in the 3D View window. For every
instance, its position, its center and deviation can be viewed. The size and the color of the target represents
how much it deviates from the reference position.
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Figure 60: Example of targets clouds uploaded.

You can evaluate the deviation of each instance or cluster and exclude badly registered targets from the consider-
ation of the global registration algorithm.

5.8.6.1 Features Panel

By default, the Features panel is available above the Properties panel at the bottom of the Workspace panel. It
contains the list of clusters and instances of all targets captured during scanning, including deviations from
their reference positions.

For the Features panel to display the list of captured targets, you need to select proper objects in the Workspace
panel. These can be one or more scans with the global registration applied and/or the reference target cloud.

Tip: To work easier with the Features panel, drag it to the area of the 3D View window.

5.8.6.2 Evaluating Deviations

For each cluster and each instance inside the cluster, Artec Studio calculates its deviation. The value of the
deviation depends on the type of objects selected in the Workspace panel:

• With one or more scans and the reference targets cloud selected, the deviation is calculated against the
position of the corresponding reference target.

• With only scans selected, the deviation is calculated against the average position of the captured instances
of the reference target.

• With only the reference targets cloud selected, no deviation is provided.
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Figure 61: The list of instances belonging to a cluster and their deviations are displayed in the Features panel
and in the 3D View window.
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You can inspect the deviation of the entire cluster or analyze any of its instances separately. To view the list
of instances inside a cluster, click the icon to the right of the number of instances. To return to the list of
clusters, click All clusters.

Figure 62: The list of clusters and their deviation displayed in the Features panel and in the 3D View window.

5.8.6.3 Removing Badly Registered Instances/Clusters

To remove a badly registered target instances or clusters from further registration process, follow these steps:

1. In the Features panel, select one or more instances or clusters of the desired scans.

2. Open the context menu by clicking RMB on the selected object(s) and click Delete. You can also press
Delete on the keyboard.

3. After you have excluded the selected targets, re-run Global registration.

Note: You can also measure distances between individual instances in the targets cloud. See Measurement
Tools.
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5.9 Artec Metrology Kit

Artec 3D introduces the new Artec Metrology Kit available for Artec Studio versions 17 and above. The kit is
basically a camera-based photogrammetry system that enables you to both generate a reference target clouds
(.obc) and evaluate results directly in Artec Studio, with an integrated software. Using the kit, you can measure
objects of any size, and the resulting target cloud can be used for applications like deformation analysis, flatness
inspection, general dimensions measurement, or your own specific engineering use case.

The kit has been developed to complement the photogrammetry-based Artec product line. It can be used in
conjunction with our scanners to attain maximum accuracy and error-reduction.

Figure 63: The Artec Metrology Kit software integrated into Artec Studio.

There are two types of kits available:

1. The Artec Metrology Kit Entry and

2. The Artec Metrology Kit Professional

The difference between the two is only the hardware that comes with the kit - the camera and reference objects.

Each kit contains the following hardware:

1. Camera and camera Flash

2. Reference crosses and scale bars

3. Coded and non-coded targets

4. Batteries and SD card reader

Important: The Artec Metrology Kit software is integrated into Artec Studio, immediately after the kit is acti-
vated.
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The Artec Metrology Kit can be used independently or along with other Artec scanners.

5.9.1 Activating the kit

The first step requires you to activate your Artec Metrology Kit using the Artec Installation Center. Activating
the kit automatically enables the Artec Metrology Kit software in your system.

5.9.2 Capturing photos

1. Prepare the object to be captured by placing the reference crosses, scale bars and targets on surfaces,
ensuring that they don’t move relative to the object.

2. The scale bars must be places perpendicular to each other.

3. Make sure there are non-coded and coded targets in each photo. Capture each target at least 6 times, and
the reference cross from four perpendicular angles.

4. Follow the best practices of photogrammetry (See section on placing targets above).

5.9.3 Creating reference cloud

After capturing all the photos, to generate a reference target cloud, follow these steps:

Make sure you have activated your Artec Metrology Kit in the Artec Installation Center. Doing so, automatically
activates the Artec Metrology Kit software in Artec Studio.

1. In Artec Studio, go to Files→ Generate reference cloud… option. This will launch the Artec Metrology Kit
software.

2. Enter an appropriate project name and select the respective project template from the drop-down list.
Every kit has a unique template.

3. Click on the Next button, and on the next window, the DPA pilot measurement dialog box opens up.

4. Select and upload all the captured photos (from the file system or an SD card), and click on the OK button
(tick mark).

5. Set a target thickness value in open dialog. This value will be automatically subtracted from the surface
for precise result. You can find the set value in the Properties panel of the Workspace (See Figure 65).

6. Wait for the software to perform the calculation and generate a target cloud.

Note: You can use the 3D View, Images and Points options in the menu bar to assess the
targets, photos etc. You can also redo the calculation by adding more photos, or changing the
settings.

7. Click on the OK button (tick mark) to generate the reference cloud, which then appears as an object in
your Artec Studio workspace.
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Figure 64: Reference target cloud generated using the Artec Metrology Kit.

Figure 65: Target thickness compensation dialog.
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5.9.4 Metrology Kit applications

After creating a reference target cloud, you can:

1. Use the Artec Metrology Kit software to perform inspections or measurements like deformation analysis,
flatness inspection etc.

2. You can also carry on with target-assisted-scanning, or process your scan data in Artec Studio using the
generated target cloud. For the detailed workflow, see Target-Assisted Scanning.

5.10 Using Certain Scanner Types

5.10.1 Notes on Scanning With Artec Point

Starting from Artec Studio 18.5, Artec introduces Artec Point, a new automated desktop 3D scanner for digitizing
small parts with metrology-grade accuracy. Artec Point uses a blue laser for scanning. The two cameras of the
scanner are positioned at specific angles, and their fields of view intersect to form a common field of view.
During the scanning process, more than four marker points must be present in this common field of view.

• Avoid placing targets on prominent features to prevent the loss of key feature data and ensure there are
neither too many nor too few targets.

• Double check that objects don’t change their shape and position.

• If you feel that the entire object has not been fully scanned, you can scan it again. Each new scanning
session will create a new point cloud.

Basic settings

• Resolution: Sets the resolution of the output scanned data.

• Remove base: Isolates and removes the base that is scanned as part of the object. This feature allows for
the base to be identified and deleted while keeping the object intact.

Note: Base removal is only possible when scanning is based on a previously created target cloud and requires
at least four targets attached to the base on which the object is placed. If the object is placed on an additional
stand that rests on the base as shown in the image below, targets attached to the stand cannot be used for
detecting or removing the base.

Advanced settings

• Target size: Determines the size of attached reflective targets:

– 3 mm

– 6 mm

– 12 mm

• Target excision: Defines the value for removing points around targets in the point cloud to create smoother
edges; the higher the value (0 to 3 mm), the larger the hole but the cleaner the edges.

• Base cut-off threshold: Defines the threshold for automatically detecting the base using targets and allows
adjustment of the cut-off position upwards from this point, typically within 1–2mm; the value range varies
from 0 to 25 mm.
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Figure 66: Insufficient amount of targets on the base.

• Laser exposure: Controls the laser illumination time. Decrease it for highly reflective objects. The default
value is 1 ms for regular objects, 0.5 ms for larger ones. For capturing finer details, set it lower. The value
range is from 0.1 to 10 ms.

Note: When working with data from Artec Point, please follow the standard post-processing workflow as
outlined in the user manual. If there are any deviations from the standard workflow specific to Artec Point,
these will be clearly indicated in the respective sections of the user manual. Always refer to these sections for
any specialized instructions.

5.10.2 Notes on Scanning With Spider/Spider II

Because Artec Spider and Artec Spider II have smaller field of view and provides higher accuracy in comparison
with Artec Eva, scanning using it can pose difficulties. Consider the recommendations given in Technique and
also the following:

• Opt for rotating table if possible

• Use a piece of paper with text on it as artificial texture

• Double check that objects don’t change their shape and position

• Try tuning sensitivity in particular cases (see Sensitivity). Avoid extreme values.

• For the Artec Spider II scanner, we recommend increasing the Geometry gain slider for better scanning
of dark surfaces, as it improves pattern visibility. However, avoid setting it too high to prevent excessive
noise on light surfaces. Adjust as needed based on surface color for optimal reconstruction. This setting
controls the brightness of the geometry cameras. However, it does not affect the texture camera).
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Artec Spider and Artec Spider II scanners work best once they reach their normal operating temperature. As
soon as you plug Artec Spider/Artec Spider II in or connect it to a PC, they begin warming up. In the Scan panel,
you can see two lines indicating the device’s current and optimal temperatures. Artec Spider/Artec Spider II will
warm up faster in Preview mode. The Scan panel also displays additional information about the time remaining
until the scanner reaches its optimal temperature.

Note: Artec Spider and Artec Spider II can operate at temperatures beyond its optimal range, but the accuracy
of captured surfaces may be lower.

5.10.3 Notes on Scanning With MHT

The flash feature in an Artec MHT scanner has a very large but limited number of operation cycles, so ensure
that you disable the scanner when it’s not in use. Avoid leaving the Artec MHT on for a long time when using the
maximum capture rate (15 frames per second). Artec Studio will automatically turn off the Artec MHT after five
minutes of continuous operation. Normally the active mode/rest mode is 3 minutes of scanning and 7 minutes
of rest; this mode is optimal and significantly increases the lifetime of the flash.

5.10.4 Notes on HD Scanning With Eva

To obtain a scan of high-definition resolution with the Artec Eva scanner, the HDmode must be turned on before
scanning. Find out how to do this in Enabling HD Mode.

After the HD mode is enabled, perform your scanning as usual.

Once you finish scanning, the following will happen:

1. Two new objects will appear in the Workspace panel: a conventional scan of SD resolution and a raw data

scan. The latter can be identified by its icon ( ). Using the obtained raw data scan, you can launch the
reconstruction of the HD scan at any time (see Reconstructing HD scans from saved raw HD data for details).

2. If the Launch HD reconstruction after scanning option has been selected before scanning, the HD recon-
struction will start automatically. The corresponding progress bar will be displayed on the Status bar.

3. When the HD reconstruction is complete, an HD scan will appear in the Workspace panel in addition to
the SD one. Its name will be marked with the letters “HD”, for example: Eva HD Scan 1.

5.11 Tweaking Scanning Options

5.11.1 Enabling HD Mode

To perform HD reconstruction, you need to compile the neural network model before using this algorithm. You
can do this during your first launch of Artec Studio, or by navigating to the Performance tab in Settings and
clicking the Set up neural network button.

If the scanner connected to your computer supports the HD mode (such as Artec Eva), it will be enabled by
default. You will see the Launch reconstruction after scanning option selected. The specifics of each of these
options are described below.
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Figure 67: Scan panel: Advanced section hidden (on the left) and revealed (on the right).
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5.11.1.1 Launching reconstruction after scanning

If the Launch reconstruction after scanning option is selected, HD reconstruction will automatically start as soon
as your scanning is complete. Therefore, before you start scanning, you have two options:

• To use the common Scan reconstruction slider which adjusts the final quality of reconstructed scans and is
the default one.

• To use the advanced mode and configure the HD reconstruction parameters: Point density and HD frames
frequency manually. To do this, use the eponymous sliders.

The Scan reconstruction slider has four different options:

• SD (equivalent to the No HD option for the HD frames frequency and zero Point density respectively)

• Normal (equivalent to the 1/8 for the HD frames frequency and Point density of 1.78x)

• High (equivalent to the 1/4 for the HD frames frequency and Point density of 4x)

• Ultra (equivalent to the 1/2 for the HD frames frequency and Point density of 7.11x)

To adjust the HD frames frequency and Point density parameters, check the Advanced option above the Scan
reconstruction slider.

The Point density determines the number of points in the resulting HD scan. The higher the point density, the
greater the number of polygons in the resulting HD scan.

The Point density varies in the range from 1× to 16× and is represented by the following values:

• Normal

• High

• Ultra

• Extreme

With the value of 1×, the number of points per scan is of the same order as in the case of the SD resolution.
However, the surfaces reconstructed from the 1× HD data are cleaner than the ones based on the SD data. The
density of 16× corresponds to ~3 million polygons per frame. The default Point density is 4×. This means that
the resulting HD scan will contain four times as many points as the SD scan.

Increasing the Point density results in higher degree of resolution, coverage, and detail, but requires more
memory and time for the HD reconstruction.

The HD frames frequency determines how many of the captured HD frames you are going to use for the HD
reconstruction. For example, if you select 1/4, then only every fourth HD frame from the captured ones will
be used to build the HD scan. The fewer HD frames you use, the fewer polygons the resulting scan will have
(i.e., it will require less memory) and the less CPU time the processing will take. On the other hand, it is more
likely that you will lose some of the scanned surface and the resulting HD scan will have holes. The HD frames
frequency parameter is represented by the following values:

• No HD frames

• Every 8th frame

• Every 4th frame

• Every 2nd frame

• Only HD frames

When scanning complex objects, shiny surfaces with insufficient data, or scanning at a high scanning speed, it
is preferrable to use high HD frames frequency values: from 1/4 to 1. For simple objects with few details, we
recommend choosing HD frames frequency with the 1/8 value.
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Important: The HD reconstruction is a time-consuming and resource-intensive operation. On slow computers,
it can take up to several hours. If Artec Studio evaluates your computer’s resources as insufficient for the
selected values of the Point density and HD frames frequency parameters, then the corresponding warning will
be displayed. For information on resources requirements, see the Using HDmode section in System Requirements.

To learn about additional options for adjusting the HD reconstruction, see HD Reconstruction in the Settings
section.

See also:

HD Scanning and HD Reconstruction

5.11.2 Disabling Distance Color

The Show distance color option (Figure 49) highlights the reconstructed surfaces in the field of view based on
the working range of a particular scanner.

Red Surfaces are too close to the object.
Orange, green Corresponds to the middle of range. Green represents the optimal distance.
Blue Surfaces are too far away from the scanner and about to disappear.
No color Surface is not being recorded.

In some cases you may need to observe how well texture is being recorded. Disabling this feature would then
help. Clear the Show distance color checkbox in the Scan panel to this end.

5.11.3 Real-time processing

The Enable real-time processing option is ON by default. This option enables Artec Studio to perform real-time
operations like saving, mapping textures and surface optimization, during the scan process. These simulta-
neously occuring operations may sometimes, depending on your system’s CPU model, significantly reduce the
scanning speed (FPS). In order to optimize CPU usage and restore FPS during scanning, you can uncheck the
Enable real-time processing option in the Scan panel.

Disabling real-time processing can prevent decline in scanning speed. The real-time operations are then auto-
matically performed immediately after scanning.

5.11.4 Tuning Texture Brightness

Note: This option is available only for Artec 3D scanners equipped with texture cameras.

You can adjust the Texture brightness setting in Preview mode. Use the slider to increase or decrease the bright-
ness of frames captured by the color camera (see Figure 68). Note that the texture brightness affects texture
quality as well as tracking steadiness. Observe the recommendations in the Table 3.

Table 3: Adjusting texture brightness.
Surface Color Recommendation
Dark or black Increase brightness
Light-colored or white Decrease brightness
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Figure 68: Increasing Texture brightness during Preview.
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5.11.4.1 Preventing Overexposure

Artec Studio has error-proofing against overexposure. If the Auto-adjust brightness checkbox is selected and the
specified value of Texture brightness causes texture to overexpose, the application will automatically decrease
brightness to avoid damaging texture.

5.11.5 Sensitivity

You can tune the Sensitivity of Artec Spider scanner if the application fails to reconstruct particular surfaces.
Increasing this setting enables the scanner to more easily capture black, reflective, translucent and fine objects
(such as human hair). The higher the sensitivity, the noisier the recorded surfaces will be. Higher values may
also reduce the scanning speed. For Eva and other Artec scanners, this setting is automatically adjusted.

5.11.6 Frequency for Capturing Texture Frames

By default, the Frequency of texture frames option is set to Automatic. In this mode, Artec Studio does not capture
texture for every frame. To specify the frequency for capturing texture frames manually, do the following:

1. Check the One per … frame radio button (see Figure 67, right).

2. Using the spinner near it, specify the desired frequency: n.

After that, the texture will be captured for every n-th frame.

5.11.7 Deactivating Scanner Flash

If circumstances prohibit you from using the scanner flash, follow the directions below.

Figure 69: Influence of ambient light on captured results.
On left: flash is turned off; ambient light is poor; results—dark texture. On right: flash is turned off; lighting conditions are

improved; results—good texture.

Note that if you disable the flash, you should compensate by using bright ambient light. According to our tests,
acceptable texture quality is obtainable with the flash disabled if the surface illuminance is at least 1 000 lux.
Compare the models shown in Figure 69, which were recorded under different lighting conditions.

The following procedure captures the textured model without using the scanner flash:

1. Open the Scan panel and click the Advanced link

2. Turn off the texture flash by selecting the Disable flash bulb checkbox

3. Use good illumination. Avoid fluorescent lamps.

4. Click Preview and direct the scanner at the object
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5. Adjust Texture brightness and Texture exposure time. In most circumstances, values should be as low as
possible, because increasing the brightness also increases a texture noise, whereas increasing exposure
time can blur the texture. Instead of adjusting sliders, try to further improve the lighting conditions.

6. Capture the scene

7. Perform required postprocessing as described in Data Processing to get a textured model

8. Adjust texture parameters for this model as described in Texture Adjustment. Pay particular attention to
the Hue and Saturation sliders. The Hue slider allows you to correct unwanted texture color.

5.11.8 Tuning Exposure Time

You can alter texture exposure time in the Preview mode. Adjust this parameter in tandem with the Texture
brightness. Increasing exposure time can blur the texture. Don’t alter the default value unless it’s necessary.

5.11.9 Disabling Texture Recording

Select Don’t record texture checkbox if you don’t want to store texture information in your scans. It is located in
the Advanced section of the panel and disengages both texture camera and texture flash in the scanner. Note
that this option is unavailable for Artec Eva Lite. Don’t forget to select this checkbox once you have completed
textureless scanning; otherwise, next time you want to start regular scanning the hybrid tracking mode could
be unavailable.

Important: Just using the Geometry tracking mode it is still not sufficient for the application to don’t record
texture. Make sure you clear the eponymous checkbox.

5.11.10 Decreasing Scanning Speed

Artec Eva captures objects at up to 16 frames per second, whereas Artec Spider at 7.5. Default values ensure
comfortable scanning with smooth movements. However, if you find scanning speed inappropriate, you can
decrease it. In this case, Artec Studio will record fewer identical frames and register them faster. To this end,
use the Scanning speed slider in the Scan panel.

Important: Decreasing scanning speed may hinder scanning. Don’t use this slider unless it is absolutely
necessary.

5.11.11 Limiting Number of Frames in Scans

Processing extra large scans might be problematic. To prevent Artec Studio from creating scans with an exces-
sive number of frames, use the Limit number of frames in scan to counter. This counter defaults to 2000 frames
in each scan.
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5.11.12 Supplementary Settings

5.11.12.1 Scan Names and Starting Number

Customize scan names and starting number by entering your own values in the Scan name and Start with fields
and changing the state of the Add scanner type in prefix checkbox. The software uses these values to create a
scan title in the Workspace panel (see Figure 70, left). You can change the default values Eva Scan and 1 to,
for example, Capture and 14.

5.11.12.2 Saving Scans to Disk

Trigger a capture mode that simultaneously records scanning results to a disk by selecting the Save scans directly
to disk checkbox. This option is enabled when you’re working with an existing saved project (see Saving a Project)
and can be useful when capturing large amounts of data on a computer with insufficient memory.

5.11.12.3 Delay Before Recording

Specify a delay (in seconds) before recording using the Delay before recording spinner under the Advanced section
of the Scan panel. The countdown begins as soon as you click the Record button. To eliminate the delay, set the
value to zero.

5.11.12.4 Depth of Field

Decrease specified operating-zone (Depth of field) by using theNear (mm) and Far (mm) sliders under the Advanced
section of the Scan panel. Here you can only decrease range within the specified boundaries.

5.11.12.5 Motion Tolerance

As the name suggests, this option allows slight movement of the object without losing the scanner’s tracking.
In other words, when this option is enabled, Artec Studio enables the scanners (Spider & Eva) to tolerate slight
movements in the object being scanned. Motion tolerance is disabled by default, and can be enabled in the
Advanced section of the Scan panel. This is particularly suitable for scanning moving objects like heads of
children, objects with moving background or animals etc.

5.11.12.6 Specify Scanning Range

By default, Artec Studio provides the correct values for the minimum and maximum limits within which the
cutoff planes are to be positioned. These values are different for each 3D scanner model, and they ensure that
you capture good-quality 3D data. If high accuracy is a secondary concern, you can manually adjust the depth
boundaries, allowing you to capture objects using an Artec L scanner or third-party 3D sensors positioned closer
to or further from the object than is recommended. To do so, select the Override default depth range checkbox
in the Settings dialog in the Scan tab, then specify new boundaries for the scanning range in millimeters (For
more details about scan settings, see Capture).

Warning: Custom depth-range settings may reduce accuracy.
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5.11.12.7 Hiding Scan Panel During Scanning

To widen the viewport during scanning, software automatically closes the Scan panel once you start recording
using Artec Eva or Artec Spider scanners. The Hide this panel during scanning checkbox is located in the Advanced
section and is cleared by default.

5.11.12.8 Temperature Compensation Wizard

To enable metrology precision for Eva, run a temperature compensation. It will adjust the scanner settings to
the ambient temperature. In Advanced section, click Start temperature compensation wizard and wait for a process
to finish.

5.12 Troubleshooting

Issue Possible Resolution
Geometry + Texture radio button
missing from Scan panel.

You were probably scanning without texture. Clear the Don’t record
texture checkbox in the Advanced section.

Final model contains noticeable
noise.

You likely scanned the affected areas improperly, or the scanner was
too far from the object. Rescan those areas.

Tracking lost error persists. Make sure Scan using auto-alignment is enabled in the Settings dialog
and use Geometry + Texture tracking.
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CHAPTER

SIX

WORKSPACE AND MORE

6.1 Artec Studio User Interface

6.1.1 Windows, Panels and Bars

When you launch Artec Studio, you will see the main application window, which allows you to perform all
operations on scans and models.

The main window is divided into several sections:
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Section Intent and other information

1. 3D View
Display all 3D data.

2. Navigation cube
Quickly orient objects.

3. Scene settings
Alter 3D-data appearance and toggle display of coordinate grid.

4. Quick toolbar
Quickly access to the set of tools for working with objects geometry and
transformations.

5. Workspace panel
List and manage 3D objects as well as toggle their display and availability
for tools.

6. Properties panel / Fea-
tures panel

Displays detailed information for 3D objects. / Displays information about
captured targets for scans with global registration applied.

7. Log window
Store records of any executed commands, specifying the time and details
of each operation (error and troubleshooting messages).

8. Status bar
Contains information on memory availability and current usage by Artec
Studio. It also has a progress indicator for any currently running task, such
as algorithm execution, model and scan exporting, and so on.

9. Left panel
Accommodate panels for various application modes, including Scan, Au-
topilot, Editor, Tools, Align, Fix holes, Texture, Construct, Measures, Settings,
History and Feedback.

10. Left toolbar
Toolbar to start the above mentioned modes.

11. Menu bar
Dropdown menus with various commands.

If any of the panels are hidden, go to the Window menu on the Menu bar, and select the panel to display it.
If Quick toolbar is hidden or some of the tools are disabled, it means that your projects doesn’t contain any
supported objects.

You can also quickly show or hide some of the panels/toolbars (namely, Left toolbar, Workspace panel and Log
window) by clicking on the special bars marked with double arrows: , , , . These bars are located
along one of the borders of the corresponding panel or toolbar.

You can minimize or maximize the right-side panels by clicking on the (-) or (+) icons on the upper right corners,
respectively.

Note: The Workspace, Features, Quick toolbar, and Properties panels are detachable, and can be moved around
and placed anywhere on the window. Simply drag-and drop, or click on the on the upper right corner of the
panel, and drag.
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6.1.2 Primary Settings

To access the settings dialog, select Settings… in the Filemenu. The settings window has several tabs for various
groups of application settings. To switch between the tabs, click the icon at the top of the dialog. For a detailed
description of the tabs, see Settings.

To change the language, select the Miscellaneous tab (Figure 211) and then the required language from the list
and click OK. You will be asked to confirm the operation and restart the application. Once you agree, Artec
Studio will automatically restart using the new interface language. If you choose not to restart, the changes
will be applied the next time you start the application.

Important: By default, the 3D view window functions in the normal camera mode. However, you can switch to
Orbit camera mode by selecting the Orbit Camera option in the View menu.

6.2 Workspace Panel

6.2.1 Object Types

After each scanning iteration, Artec Studio saves a separate scan. The list of all scans for a given project appears
in the Workspace panel (see Figure 70). Afterwards, the algorithms, primarily fusion, yield models.

Artec Studio can accommodate the following types of objects in Workspace:
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Table 4: Object types in Artec Studio.
Type Icon Content Origin

Scan Set of frames From scanners Eva, Spider, Spider II, Leo,
Micro, and Micro II

HD raw data Set of HD frames From Eva scanner
Point cloud scan Point cloud From Ray and Ray II scanners

Raw point cloud scan Point cloud From Artec Point scanner or imported
point cloud

Sparse reconstruction Sparse reconstruction
object

Created in Artec Studio

Model Polygonal mesh Algorithm output (fusion) or imported
mesh

CAD model CAD model Imported

Cylinder CAD primitive Created in Artec Studio (see Constructing
CAD Primitives)

Cone CAD primitive Created in Artec Studio

Plane CAD primitive Created in Artec Studio

Sphere CAD primitive Created in Artec Studio

Torus CAD primitive Created in Artec Studio

Freeform CAD primitive Created in Artec Studio

Targets Target cloud Imported

Group Group of objects Grouping of objects listed above

See also:

Figure 72.
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6.2.2 Object Columns

Object data in the Workspace panel is arranged in several columns:

Scans marked with in this column will appear in the 3D View window and will undergo
processing by all Artec Studio algorithms and tools.

Icon Each type of objects has a specific icon (see Table 4). This icon is always displayed to the left
of the object or group name for improved visual perception of information in the Workspace
panel.

Name When a scan is created, Artec Studio automatically assigns it a name, such as Eva Scan
1, Eva Scan 2 and so on, according to the values in the Scan name and Start with fields
as well as the state of the Add scanner type in prefix checkbox in the Scan panel. To rename
some object, follow these instructions.

Color In this column, each object has a colored square (for example, ) next to it for clarity and
quick visual search. You can change the color by clicking on the corresponding square and
selecting the desired color from the palette.

Type The type of an object. See here for details.
Error The largest registration-error value among all frames in the scan. More information.
Frames The total number of frames constituting the scan.
Scanner type The type of the scanner that created the object.
Texture
frames

The number of captured texture frames. See Texturing for details.

Polygons The number of polygons constituting the object.
Locks Algorithms will not reposition the frames of the scans marked with , nor will they move

the scans and other objects marked with .

Figure 70: Workspace panel and respective context menus: object list on left and surface list on right.

Use the button at the top left to select the columns to be displayed or to hide the panel. Change the column
order by drag-and-dropping their headers.

Note: The columns marked with and appear automatically if you set the Lock object or Lock frames
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status respectively, for one or more objects using the context menu (see Operations with Objects for details on
the context menu operations).

Figure 71: Selecting columns to be displayed, and filtering objects.
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6.3 Operations with Objects

In the Workspace panel, you can perform various types of operations with objects. All types of operations are
available through the context menu called by clicking RMB on some object.

Menu Item Description
Objects filter Instruct Workspace to display only particular types of the objects.
Select all Select (highlight) all objects for further operations on them. If only one or several

objects of one group are selected in Workspace, the first run of this command will
select all group objects, the second – all Workspace objects.

Deselect all Reset any selection
Invert selection Reset the current selection and select all other objects.
Group / Ungroup You can group a few objects in the workspace according to some feature. Select re-

quired objects, call the context menu by clicking RMB and select Group. You will see
that the objects are wrapped with a common header (for example, Group 1), which can
be changed as well as the object names (see below). It is possible to create subgroups
within groups. Resumed scans are also grouped automatically during scanning. Each
scan imported from Leo will be included in a separate group inside the project group.
See also Actions with Groups.

Rename Select an object by clicking LMB on its name, hit F2 and specify a new object name in
the opened dialog window. You can also rename many objects at once: select multiple
objects (as described above) and then use F2 or RMB to rename them.

Duplicate To make a complete duplicate of an object in the Workspace, right-click on the object
and then select Duplicate. A copy of the object will be created with the name like Copy
of Fusion 1.

Show Display the selected objects in the 3D View section. See Selecting Scans and Models for
details.

Hide Do not display an object in the 3D View section (cancel the Show operation).
Lock frames Set the Locked frames status ( ) to a scan, which blocks the reposition of the scan

frames during Global Registration. See Locking Object’s Position for details.
Lock object Set the Locked object status ( ) to a and object, which blocks its position while using

various other tools. See Locking Object’s Position for details.
Unlock Remove the Locked frames and Locked object statuses from an object.
Change color Call the color palette to change the color of an object or a group. See also Actions with

Groups.
Copy transforma-
tions

Save the transformations of a scan and its frames for their further transfer to another
scan. See Transferring Transformations for details.

Unregister Reset the positions of individual frames in a scan computed during its registration. See
Separating Scans for a use case.

Delete Delete objects from your project.
Upload to Cloud Upload fusions and models to cloud directly from Artec Studio. See Exporting to Artec

Cloud for more information.
Any column header Sort the objects by either of their properties. Clicks: ascending order → descending

→ initial.
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Figure 72: Filtering objects in Workspace.

6.4 Actions with Groups

In the Workspace panel you can perform the following actions with the groups of objects using the elements of
the group header row:

Table 5: Actions with groups in the Workspace panel.
Action How to perform
Select/Deselect To select or deselect all objects in a group, click the group row in the column

marked with .

Set/Change group color By default, the group color is not set ( ). To set or change the color of a
group, click the group row in the Color column area and select the desired
color from the palette. When the group color is set and the group is col-
lapsed in the Workspace panel, then all objects in the group are painted in
the group color. Otherwise, each object is painted in its own color.

Unset group color To cancel the color setting for a group, right-click the group row in the Color
column area.

Lock To lock or unlock all objects or frames in a group, click the group row in the

Lock column area ( or ). See Locking Object’s Position for details.

6.5 Selecting Scans and Models

To view a scan or model in the 3D View window or to process it, you need to mark it with the icon in the

Workspace panel. To navigate scans and models, use keys ↑ and ↓ or click an arbitrary area except those in ,

or color column ( ).
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Purpose Method Alternate Method
Highlight an object inWorkspace to view
its properties or run a command from the
context menu

Left-click on the scan name —

Toggle visibility and availability for pro-
cessing (flag )

Left-click in the column
• Use the Show or Hide
context-menu com-
mands

• Select the object name
using Ctrl+Alt+LMB.

Batch selection (deselection) of objects
for display and processing

Click in the rows of the re-
quired objects one by one • Hit Ctrl+A (Ctrl+D)

to select (deselect) all
objects

• Click LMB while holding
Ctrl (Shift) to high-
light a few objects and
then hit Space

• Click LMB on one of the
flags and while hold-

ing down LMB, move the
cursor through the other
flags.

Select a single object for processing and
deselect others

Select the object name using
Ctrl+Alt+LMB

Use Ctrl+LMB in the empty

area of the column

In addition to the methods in the table above, you can use commands from the context menu by clicking RMB
on the objects.

See also:

The full list of hot keys in workspace.

6.5.1 Selecting Frames

Double-clicking on the scan name (or using the View frames command in the context menu) opens a list of all
the frames in that scan (see Figure 70, right).

Manually selecting specific frames will make them (and only them) appear in the 3D View window. Alternatively,
to select a particular frame directly on the 3D View window, without the need for manually browsing through
the frames list, simply click LMB while holding the Alt key.

You can select frames in a number of ways:

• Click LMB on the frame name to select it while clearing other selections.

• Click LMB while holding the Ctrl key to select several frames at once.

• Click LMB while holding the Shift key to select a sequence of frames in the specified range.

• Click Ctrl+A/Ctrl+D to select/deselect all frames.

• Click LMB while holding the Alt key to select a frame directly from the 3D View window. This will display
only the selected frame in the 3D View window.
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To start a sequential frame demonstration, use the button at the upper right of the Surface list. To stop the

demonstration, click .

6.5.2 Object Properties

At the bottom of the Workspace panel, you can see a Properties panel. Click on it to expand it. Then select any
object to display its properties. Depending on the selected object, its properties are displayed under the Basic
and Advanced tabs.

In the Advanced tab, you can view details of a scan like number of Polygons or Size of the scan and Scanner ID.

Figure 73: Basic and advanced object properties of a selected scan.

If no object is selected, the global settings of the project will be displayed in the Properties panel.

Figure 74: Project properties when no object is selected.
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6.5.3 Features

By default the Features panel is located at the bottom of the Workspace panel near the Properties panel. Click
on it to expand it. Then select one or more scans with the global registration applied and/or a reference target
cloud to display the features of the captured targets.

See Features Panel for details. If no object is selected, the Features panel will be empty.

Figure 75: Features without a selected object.

6.5.4 Selecting a Point Cloud Scan

Point cloud scans contain only one surface. Click LMB on a point cloud scan and look at the Properties section:

Figure 76: Properties of the point cloud scan.

Parameter Description
Global
registra-
tion

Shows whether the global registration procedure has been performed.

Mesh
polygons

Since Artec Studio doesn’t display all the points constituting the scan, you can only see a mesh
obtained from a simplified copy of the actual point cloud.

Points Total number of points in the point cloud.
Sections When you scan with Ray, youmay select particular regions (sections) to narrow down the actual

scene. This parameter stands for the number of these regions.
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6.6 Quick Toolbar

You can get access to the most frequently used tools for CAD and other objects using quick access Quick toolbar.
The presence of tools on the Quick tolbar and their accesibility directly depends on the objects existing/being
selected in your project.

Tool Icon Summary Supported ob-
jects

Transformation

Allows to move, rotate, scale and mirror
objects relative to the global coordinate-
system axes. Same as Editor → Transforma-
tion tool.

All visible

Cross section Creates a dynamically adjustable cutting
plane.

Scans, Models,
CAD objects,
Point clouds.

Chamfer

Creates a transitional face between two
adjoining object faces at a certain angle
depending on set distances. Symmetri-
cal/asymmetrical.

CAD objects.

Fillet

Creates a smooth, rounded transition be-
tween two faces of an object, based on spec-
ified distances. It generates a new face that
smoothly connects the original faces and can
be either symmetrical or asymmetrical.

CAD objects.

Draft Modifies the angle of object face. CAD objects.

Thickness Adds thickness to object by offsetting faces
inward or outward, or in both directions.

Models, CAD ob-
jects.

Move surface Move the selected surface by a specified off-
set. CAD objects.

Delete face Delete one or more faces on CAD models. CAD objects.

Deviation analysis

Calculates the deviation of two objects and
asseses the result of the fitting and aligning
geometry tools. Same as Measures → Dis-
tance map.

Models, CAD ob-
jects.

6.6.1 Cross section

To create a cross section,

1. Mark the checkboxes of desired object in the Workspace to which you would like to apply the Cross
section tool on the Quick toolbar.

2. Click the Cross section ( ) icon on the Quick toolbar to open the Cross section tool. The Cross section
tool will open in a pop-up, which is draggable and can be located at any place in the 3D view window.

3. Select one of the available coordinate planes (YOZ , XOZ , XOY ). Once the coordinate
plane is selected, you will see the preview of a cross section.

Z-axis is always perpendicular to section.
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Figure 77: Cross section on YOZ coordinate plane.
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To customize cross section,

• Move section along its normal (Z-axis) by clicking LMB on the arrow and dragging it.

• Flip the direction of cross section by clicking the Flip direction button

Figure 78: The flipped cross section on YOZ coordinate plane

Note: Even after the cross section is generated, you can switch to another coordinate plane.

• To enhance visibility by filling section with color, toggle the Show cap switch on.

Keep in mind that showing caps is only available for CAD objects and models.

Apply changes by clicking on the Save as section button. Your saved section will appear onMeasures panel along
with other measures.
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Figure 79: Cross section with colored cap.
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6.6.2 Chamfer

To create a chamfer,

1. Mark the checkboxes of desired CAD object in the Workspace to enable Chamfer tool on the Quick
toolbar.

2. Click the Chamfer ( ) icon on the Quick toolbar to open the Chamfer tool. The Chamfer tool will open
in a pop-up, which is draggable and can be located at any place in the 3D view window.

3. Click LMB on the desired edge of the CAD object. The hovered edge will be highlighted in yellow. Once
it’s selected, you will see a preview of the default chamfer.

Figure 80: The default symmetrical chamfer at 45°angle.

To customize the created chamfer,

1. Set the value of distance from initial edge to the new edge on the first face to the Distance 1 field. If the
Symmetrical switch is toggled, the value entered in the Distance 1 field will also be applied to the Distance
2 field.

2. To make the created chamfer assymetrical, toogle the Symmetrical switch off and enter custom distances
in the Distance 1 and Distance 2 field.

3. To adjust the shape of chamfer corner, try different values of Corner Form parameter

4. To spread the chamfer to the neighbouring edges that are smoothly connected, use Tangent propagation
parameter

5. Apply changes by closing the Chamfer tool.

To reset your changes, click Reset icon ( ). All changes will be undone.
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Figure 81: Chamfer with Tangent propagation parameter off.

Figure 82: Chamfer with Tangent propagation parameter on
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6.6.3 Fillet

To create a fillet,

1. Mark the checkboxes of the desired CAD object in the Workspace to enable the Fillet tool on the
Quick toolbar.

2. Click the Fillet ( ) icon on the Quick toolbar to open the Fillet tool. The Fillet tool will open in a pop-up,
which is draggable and can be located at any place in the 3D view window.

3. Click LMB on the desired edge of the CAD object. The hovered edge will be highlighted in yellow. Once
it’s selected, you will see a preview of the default fillet.

Figure 83: The default symmetrical fillet.

To customize the created fillet,

1. Set the value of distance from initial edge to the new edge on the first surface to the Distance 1 field. If
the Symmetrical switch is toggled, the value entered in the Distance 1 field will also be applied to the
Distance 2 field.

2. To make the created fillet assymetrical, toogle the Symmetrical switch off and enter custom distances in
the Distance 1 and Distance 2 field.

3. To adjust the shape of fillet corner, try different values of Corner Form parameter.

4. To spread the fillet to the neighbouring edges that are smoothly connected, use Tangent propagation
parameter.

5. Apply changes by closing the Fillet tool.

To reset your changes, click Reset icon ( ). All changes will be undone.
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6.6.4 Thickness

To thicken an object,

1. Mark the checkboxes of the desired mesh or CAD object in the Workspace to enable the Thickness
tool on the Quick toolbar.

2. Click the Thickness ( ) icon on the Quick toolbar to open the Thickness tool. The Thickness tool will open
in a pop-up, which is draggable and can be located at any place in the 3D view window.

3. To adjust the thickness, set the desired value in either the Forward or the Backward field, or assign different
values to both fields by turning off the Symmetrical switch.

Figure 84: The Thickness tool with a 5mm forward and backward offset
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6.6.5 Draft

To create a draft,

1. Mark the checkboxes of the desired CAD object in the Workspace to enable the Draft tool on the
Quick toolbar.

2. Click the Draft ( ) icon on the Quick toolbar to open the Draft tool. The Draft tool will open in a pop-up,
which is draggable and can be located at any place in the 3D view window.

3. Select one or multiple adjacent faces connected to the base for which the draft will be specified.

4. Set the draft angle in the Angle field.

5. Click the Apply button to save the created draft (see Figure 85).

Figure 85: The created draft at 20°angle

To reverse the direction of the base surface, click the Reverse ( ) icon in the Draft pop-up. The surface draft
will be flipped.

6.6.6 Move surface

To move a surface of the selected CAD object,

1. Mark the checkboxes of the desired CAD object in the Workspace to enable the Move surface tool
on the Quick toolbar.

2. Click the Move surface ( ) icon on the Quick toolbar to open the Move surface tool. The Move surface tool
will open in a pop-up, which is draggable and can be located at any place in the 3D view window.
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3. Select any face of the CAD object. Shift-click to select multiple faces.

4. Set an offset value to the Distance field.

5. Specify an offset axis (optional).

6. Click the Apply button to save changes. The face surface is moved.

Figure 86: The Move surface tool with a 50mm offset - Not applied yet.

6.6.7 Delete face

To delete a face of the selected CAD object,

1. Mark the checkboxes of the desired CAD object in the Workspace to enable the Delete face tool
on the Quick toolbar.

2. Click the Delete face ( ) icon on the Quick toolbar to open the Delete face tool. The Delete face tool
will open in a pop-up, which is draggable and can be located at any place in the 3D view window.

3. Select any face of the CAD object. Shift-click to select multiple faces.

4. Choose between the Leave hole and Try fixing hole options. Depending on the selected option, the hole
left in place of the deleted face will either remain as is, or Artec Studio will attempt to fix it.

5. Click the Apply button to save changes. The selected face is deleted.
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Figure 87: Deleted face with the fixed hole.

Figure 88: Deleted face with the left hole.

6.6. Quick Toolbar 109



Artec Studio, ver. 19

6.6.8 Deviation analysis

In Artec Studio there is a number of tools that fit the geometry of one object into another or align them:

• Fit all kinds of primitives

• Fit Freeform surfaces

• Best-fit

• Autosurface creation

Deviation analysis tool calculates the distance map showing the deviation of the initial and fitted surfaces.
Deviation analysis can be performed between CAD and model or two models.

To enable the tool,

1. Mark the checkboxes of the desired CAD object and model, or two models in the Workspace to enable

the Deviation analysis tool on the Quick toolbar.

2. Click the Deviation analysis ( ) icon on the Quick toolbar to open the Deviation analysis tool. The De-
viation analysis tool will open in a pop-up, which is draggable and can be located at any place in the 3D
view window.

Note: If you selected only one object, the Deviation analysis tool will be enabled, but you will see the text
prompt to select at least two objects. If invalid objects are selected, Deviation analysis tool will remain disabled.

Once you’ve selected the valid objects for calculating the deviation, the algorithm will run automatically, the
Deviation analysis pop-up will open.

By default, Search distance is 1 mm but you can also recalculate by entering a desired Search distance (in mm)
value and click the Recalculate button. For more information aboutDistance map parameters, refer to theDistance
Maps section.

See also:

The Deviation analysis tool is the same as Measures → Distance map and can also be performed in the Datum
Alignment mode. See Datum Alignment for more details.

6.7 Memory Management: Smart RAM Usage

Working with a large data set requires a huge amount of RAM and you might often find it necessary to free
up RAM without deleting any of the project data. While the previous versions of Artec Studio tackled this by
making it possible for you to load or unload scans manually, the new Artec Studio 16 automatically optimizes
RAM usage through smart memory management.

When you open a project, all the scans are preloaded into the RAM and displayed in the Workspace, which
enables you to start working with them immediately. When you select one or more scans in the Workspace,
Artec Studio will automatically load only the selected scans. If a particular algorithm or action requires any
scans, the application will automatically load them into RAM too. Likewise, Artec Studio will automatically
unload unnecessary scans, frames, textures or a combination thereof. This selective loading and unloading of
data frees up extra RAM automatically.
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Figure 89: The Deviation analysis tool with calculated distance map

Note: In addition to 3D data, the change history can also consume a large portion of memory. For information
on how to control the history size as well as how to clear it, consult History of Project Changes.
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CHAPTER

SEVEN

VIEWING SCANS AND MODELS

7.1 3D Navigation

When you have finished scanning, Artec Studio displays the results in the 3D View window.

7.1.1 Moving, Rotating and Scaling

You can control the observer’s perspective in the 3D View window by moving or rotating the observation point,
or by zooming in or out. Use the mouse to control these effects.

Tip: You can also use 3D mouse to navigate 3D content (see 3D Mouse).

7.1.1.1 Moving

Move the mouse pointer over the 3D View window. Hold down the left (LMB) and right (RMB) mouse buttons
simultaneously, then move the mouse to relocate the model. You can also use the middle mouse button to
perform the same operation.

7.1.1.2 Rotating

To rotate around any possible axis, move the mouse pointer over the 3D View window. While holding down
LMB, move the mouse in the desired direction to rotate the model.

7.1.1.3 Flipping

To quickly rotate (flip) 3D data around a specific axis (or rather the axis perpendicular to the screen plane) in a
specific direction, use the dedicated arc arrows ( ) near the navigation cube (see Figure 93) or the O key:

Using arrows

1. Click (LMB) one of the arrows ( ).

2. Still holding down LMB, move the mouse cursor in the direction of either of the arrows.

Using the O key

Press and hold the O key and drag the mouse cursor outside an imaginary ellipse that inscribes the 3D View
window.
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Figure 90: Imaginary ellipse inscribing the 3D View window.
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7.1.1.4 Zooming

Hold RMB and move the mouse. Moving left or up will zoom out, whereas moving right or down will zoom in.
You can also use the mouse wheel to produce the same effect.

7.1.2 Global Coordinate System and Rotation Center

To enable or disable the global coordinate-system axes, select the Show grid option in the View menu or Grid in
the 3D View toolbar, or press G.

Figure 91: Custom rotation center.

When you rotate the model, the scene always turns around a certain point—the rotation center. By default, the
rotation center coincides with the origin of the main axis grid. To change its location, double-click LMB at any
point on the 3D model: the rotation center will move to this point. Setting the rotation center can be useful
when you wish to view a particular object from all sides. Once it is set, rotate the view using LMB.

Artec Studio displays the rotation center as a small purple sphere with the three small coordinate axes (see
Figure 91). If the rotation center coincides with the origin of the main axis grid, the purple sphere lacks small
axes. If the rotation center hasn’t been altered, it even lacks the sphere.

Application can set the rotation center to the center of mass of the object. Access the following menu command:
Edit → Cursor → Set to mass center. To go back to the default state, select Set to origin of axis grid.
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7.2 Choosing Projections

The View menu allows you to choose between perspective and orthogonal projections when displaying the
model in the 3D View window.

Perspective view is the central projection on a plane produced by direct rays that focus on one point: the pro-
jection center. This method produces a visual effect similar to human eyesight.

Orthogonal view is when the projection center resides infinitely far from the plane of projection; in this case, the
projection rays are perpendicular to the observation plane. This method preserves parallel lines and is more
commonly used for measurement (see Measurement Tools for details).

You can also change projection type in other ways:

• Hit Ctrl+5 on the main keyboard

• Hit 5 on the extended numeric keypad (numpad)

7.3 Viewpoints

To quickly toggle a camera view between several predefined positions, use navigation cube, View menu or the
keyboard combinations listed in Table 6.

In comparison with the other ways, navigation cube provides more flexibility in orienting objects in the window.
Apart from using labeled faces (TOP, FRONT, LEFT, etc.), cube allows one to orient scene to intermediate positions
with the help of controls located on the edges and vertices (see Figure 92).

Figure 92: Navigation-cube controls (face, edge, vertex).

Table 6: Key combinations for switching viewpoints.
Viewpoint Keyboard Extended Numpad
Front Ctrl + Shift + 1 1
Back Ctrl + 1 Ctrl + 1
Right Ctrl + Shift + 3 3
Left Ctrl + 3 Ctrl + 3
Top Ctrl + Shift + 7 7
Bottom Ctrl + 7 Ctrl + 7

The Home command of the View menu or H keystroke restores the view to its original position.

The Fit to view menu option, button or F keystroke automatically fits the object to the 3D View window.

For point-clouds, you can have a look at scan from the Ray perspective. Open the right-click menu for this scan
and select the Go to scanner viewpoint command to this end.
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Figure 93: Navigation cube and arc arrows.

7.4 Displaying 3D Data

The toolbar on the right of the 3D View window features controls for data-display modes. If minimized, it can

be opened by clicking button in the 3D View window (see Figure 93). All the commands for viewing and
switching between modes are also available in the View menu.

7.4.1 Rendering and Shading Modes

Figure 94: Examples of model using different rendering modes.
Point model on left and wire over solid on right.

Both the View menu and the 3D View toolbar allow you to choose one of the following 3D rendering options
for scanned frames:

Render solid the most common way to render with a solid fill on all faces using your selected shading method

Render wireframe display polygonal-mesh edges without applying a solid fill to the faces

Render points display polygonal-mesh vertices

Render wireframe over solid apply a solid fill to the faces and use a different color to display edges. This method
enables you to visually assess the quality of the polygonal model (see Mesh Simplification (Tools, Mesh
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Optimization) for details).

Render points and solid automatically display scans in point view, but display models in solid-fill view. This
mode eliminates the need to switch to another mode in order to find the best rendering approach for
each surface type. It is enabled by default for the Artec Spider scanner.

For some examples of the various model-rendering modes, see Figure 94.

Figure 95: Smooth versus flat shading (respectively).

To choose a shading method for the solid fill, use the View menu:

Smooth shading the color value for each point in a triangular face is calculated using color interpolation at the
vertices

Flat shading all the points on a triangular face are assigned the same color

7.4.2 Color and Texture

The Color subgroup in the View menu or Color mode section in the toolbar list the methods for assigning colors
to the surfaces in the 3D View window:
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Texture
displays textured data; other-
wise, the software uses the scan’s
default color

Ctrl+Alt+1

Scan color displays the default color of the
scan; the figure depicts two scans Ctrl+Alt+2

Surface
color

displays each frame in a scan us-
ing a different color Ctrl+Alt+3

Max error

colors the frames from Eva and
Spider in accordance with their
registration quality from green to
red via yellow and orange; red in-
dicates unacceptable values and
registration errors

Ctrl+Alt+4

X-ray

beneficial for noisy data since it
highlights only areas with high
point density; it features a slider
for adjusting its intensity

Ctrl+Alt+5

7.4.3 Lighting

The Show option under the Lighting subgroup in the Scene settings section or Lighting option in the View menu
toggles the lighting in the 3D View window. This option may be useful when you must turn the lighting off to
see only the outline of the model or to assess texture quality.

Additionally, the Directional option under the Lighting subgroup in the Scene settings enables you to adjust the
Height and Azimuth of the light source in the 3D scene. To do so, make sure the lighting is ON on the 3D View
window, click on the Directional option, and adjust the sliders as desired.

Figure 96. is an example of a model rendered with different Azimuth values.
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Figure 96: Adjust the light source in the 3D View window.

7.4.4 Backface Rendering

Artec Studio offers four methods for rendering a frame’s backface:

Show assigns the backface the same color as the model. This display mode is useful when you want to correct
geometric problems in a model by working with it from the inside.

Cull the backface is not displayed. This mode produces a very clear view when combined with the X-ray mode
(see Color and Texture for details).

Black renders the backface in black. In this mode, it is easiest to distinguish between the front and back sides
of the scanned surfaces.

Transparent renders the semi-transparent backface using a color that is slightly different from the front side
of the corresponding surface. This mode allows you to view both sides of the scanned surfaces at the
same time: those at which the scanner was aimed, and their backs. This is convenient for viewing scans
of closed environments such as a room scan taken from the inside.

You can choose the mode from the View menu or from the toolbar in 3D View window. See Figure 97 for
examples that illustrate the different modes of backface rendering.

The Transparent mode is the default one.

7.4.5 Rendering Object Outlines

To highlight the outlines of the object displayed in the 3D View window, hover the mouse cursor over its name in
the Workspace panel. This can be useful, for example, to distinguish between several scans of the same object
when they are rendered in the 3D View window simultaneously. The outlines are highlighted even through
surfaces.

You can enable and disable the outlines highlighting on the UI tab of the Settings dialog.
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Figure 97: Examples of different modes of backface rendering:
1—Show, 2—Cull, 3—Black, 4—Transparent.
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7.4.6 Representation of Normals and Boundaries

The Show normals option in the View menu enables or disables rendering of normals for each vertex. By default,
the normals point away from the model surface and toward the 3D scanner. You can change this direction using
the Invert normals command. You can also switch between modes for displaying normals by hitting the N key
with the 3D View window active.

When working with edges, the Show boundary feature in the View menu allows you to enable and disable
highlighting of the model’s edges. To toggle this feature, hit the B key with the 3D View window active.

7.4.7 Rendering and Texturing Untextured Polygons

Textured models may have some untextured areas (for instance, the green area in the middle of Table 7). The
Render polygons without texture option in the View menu allows you to toggle rendering of such areas.

If the texture of the imported model is smaller than the model itself, Artec Studio can wrap it to fill the untex-
tured areas (see Table 7). The wrapping effect is similar to floor tiling or a repeating wallpaper pattern—that is,
the texture repeats periodically. To activate this option, enable the Wrap texture coordinates option in the View
menu.
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Table 7: Rendering and texturing untextured polygons.
Options Enabled Result

None

Render polygons without texture

Wrap texture coordinates
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7.4.8 Displaying Boundaries of Texture Atlas

Textures applied to 3D models are obviously two-dimensional. You may, however, want to see the boundaries
of each texture patch on the actual 3D surface. Artec Studio can display a texture-atlas file, such as the the
middle image in Figure 161, with its boundaries highlighted (see Figure 98). Identifying the way in which the
boundaries lie on the surface may, for example, help you determine whether you must simplify the model to
get better texture application.

To enable boundary display, access the View menu and select Show texture boundaries or hit the Shift+B keys
with the 3D View window active. To disable this feature, make sure this menu command is unchecked.

Figure 98: 3D model with texture-atlas boundaries.

Technically, this command also works for textures produced by triangle methods, but it provides no usable
information.

7.4.9 Specifics of displaying the textures of Leo scans

Leo allows you to obtain scans with a scanning depth of 2 m or even more. However, texture frames with a scan
depth greater than 1.5 m (distance between the scanner and the scanned surface) may distort the actual colors
of the scanned objects. For this reason, Artec Studio excludes the use of such texture frames for rendering the
texture of final models. To warn you about such texture frames, Artec Studio displays them blackish on the
scans in the 3D View window.

7.5 Saving Screenshots

You can capture surfaces displayed in the 3D View window and save them in a graphics file. Unlike the conven-
tional system Print Screen command, this option saves only the contents of the 3D View window and uses
the specified background color (see Background for screenshots transparent, black or white). Screenshots taken
while you are using the measurement tools will also contain your measurements and notes (see Measurement
Tools and Notes (Annotations) for details).

Tip: When saving screenshots in X-ray mode, avoid using transparent background.

To capture a screenshot, follow this procedure:
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1. Select the Save screenshot… option in the View menu, or hit Shift+Ctrl+S.

2. In the dialog, specify the destination folder and file name, then click the Save button. Artec Studio will
save the file in PNG format.

Note: If you save a screenshot using an existing file name, Artec Studio will overwrite that file. Be sure to
specify a unique name.
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CHAPTER

EIGHT

PROJECTS, SCANS AND MODELS

A project encompasses all 3D data obtained by scanning and postprocessing that can be saved to disk and
accessed for later use. In addition, it contains command history and measurement results. For each project, a
corresponding folder contains all project data and an A3D project file.

Note: Please note that, the project data is stored as .sst files for versions 16 and above, and may not be
accessible.

Artec Studio can display project statistics. It includes information on number of scans, surfaces (frames), poly-
gons, vertices and UV coordinates. To access this data, call a right-click menu for any Workspace object and
select Project info. If you want to collate data on the selected scans with the total numbers for the project, first

mark the required scans using with the flag.

8.1 Creating a Project

To start a new project, select the File → New project menu option. It is a best practice to save this project to
a specific folder before you start scanning. If you start scanning with the Save scans directly to disk option
enabled or import scans from Ray/Ray II, a temporary project is created in the Windows temporary folder or
another directory if you specified one in Settings.
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8.2 Saving a Project

Starting from version 16, Artec Studio automatically saves projects, and changes made to projects instanta-
neously. A newly created and yet manually unsaved project is automatically saved and stored in the default
Temporary folder (see Temporary Folder). You can manually save the project in a preferred location using the
File → Save project as… menu option or access it from the temporary folder as necessary.

8.2.1 Restoring a Project

While working, if Artec Studio crashes due to unexpected reasons, then the next time you open the application,
it will prompt you to restore the project. It is specifically applicable for projects that were not been manually
saved (or in other words, that were still in the default temporary folder).

8.3 Opening Project and Scans

To open an existing project, use the File → Open project menu option or hit Ctrl+O.

Note: Artec Studio versions 16 and above do not support SPROJ files. Projects created with earlier versions in
the SPROJ file format, must be converted to the A3D format to be compatible.

By default, when you open a project, the application will restore it to the state in which it was last saved.

Note: When Artec Studio opens a project, it will determine the amount of available memory. If the scan you
are trying to load requires more memory than is available in your system, the application will process it as an
“unloaded” scan.

8.3.1 Opening an SPROJ file

In order to open an SPROJ file in Artec Studio (versions 16 and above), you will need to convert them to the A3D
file format. On selecting an SPROJ file to open, Artec Studio will automatically prompt project conversion. Artec
Studio will convert the selected project to A3D format and save it separately at the file location you specify. You
will not lose your SPROJ project. The converted A3D project will, however, not contain the project’s command
history.

8.3.2 Opening a Project from Leo

You can obtain projects from Leo via direct connection to the scanner or using an SD card installed in the device.
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8.3.2.1 Connecting to Leo

1. Ensure that your Leo scanner and your computer are connected to the same network, and you authenti-
cated using the same credentials

2. Click File → Import → Leo project (connect to scanner)

3. Wait for the application to show your Leo scanner. If no device is displayed or you are using a direct
connection, follow the steps indented below:

a. Click Connect by IP

b. Specify IP address that you may find in Leo network settings

c. Click Add

4. Select the required scanner and click Connect

5. Then using either LMB or ↑ and ↓ select the project that you want to load (Figure 100)

Note: You can import more than one project from Artec Leo at the same time, into a single Artec Studio project.
To select multiple projects, use the shift key.

1. If the selected project contains HD raw data, you can import it by checking Import raw data.

2. To start HD reconstruction immediately after the import, perform the following actions:

a. Check Launch HD reconstruction.

b. Select the desired Point density, ranging from Normal to Extreme by adjusting the epony-
mous slider.

The Point density determines the number of polygons per frame that is used for reconstructing
the scanned surfaces from the raw data. With 1× the number of polygons is of the same order
as for the SD resolution and 64× corresponds to ~5 million polygons per frame. Increasing
the Point density results in higher degree of resolution, coverage, and detail, but requires more
memory and time for the HD reconstruction.

Important: If Artec Studio evaluates your computer’s resources as insufficient for the selected
Point density, then the warning is displayed that the HD reconstruction can take up to several
hours on your computer. For information on resources requirements, see the Using HD mode
section in System Requirements.

3. Click Import.

If you have enabled the HD reconstruction, it will start immediately after the data uploading finishes.

Wait for scans to appear in the Workspace panel.

The imported projects and scans will be automatically grouped—the group with the project namewill be divided
into subgroups of scans (see here about grouping). The imported HD scans will have an “HD”mark in their names,
for example: Leo HD Scan 1.

If the scans contain information on supporting surface and the corresponding option is enabled in Settings, Artec
Studio will also launch base removal.

Note: You can import HD projects from Artec Leo multiple times with different values of Point density.
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Figure 99: Scanner list and the Connect by IP button.

8.3. Opening Project and Scans 128



Artec Studio, ver. 19

Figure 100: Dialog for selecting Leo projects to import.

8.3. Opening Project and Scans 129



Artec Studio, ver. 19

8.3.2.2 Using SD Card

If you want to open Leo scans without having to connect to the device, use the following method:

1. On Leo, first copy a project to SD card.

2. Then insert the card into the computer with installed Artec Studio.

3. Click File → Import → Leo project

4. Browse for the required project folder

5. Select the folder containing Leo project and click Select folder. Import will start.

Note: HD data from Artec Leo can be exported to an SD card with the .leo format.

8.4 Importing Models and Scans

Importing is another way to load data into Artec Studio in place of capturing or opening a project. You can
import scan files created in earlier versions of the software, individual frames, point cloud data, as well as CAD
models in the following formats:

SCAN Artec 3D scan format
PLY Stanford polygon file format
STL Stereolithography file format
VRML VRML file; actual extension is *.wrl
OBJ Wavefront OBJ file format
PTX Disney per-face texture mapping format
C3D Artec Ray original point cloud
BTX Artec Ray/Ray II point cloud
STEP, STP (CAD format) Standard for the Exchange of Product model data
IGES, IGS (CAD format) Initial Graphics Exchange Specification
X_T (CAD format) Parasolid XT data format
SAT (CAD format) Standard ACIS text format
E57 Point cloud format
USD Universal Scene Description (*.usda in text and *.usdc in binary format;

*.usda/usdc via usdz zipped in an archive, also in binary or text
format)

8.4.1 Importing Scans or Meshes

To import a file, use the File→ Import → Scans, meshes or point cloudsmenu option or hit Ctrl+I . Next, select
a file for importing. You can also drag and drop a file into the main Artec Studio window, or just double click
on it.

Note: The import process runs in the background, so you can continue working with the scans you’ve already
loaded. The progress indicator for the import operation will appear at the bottom of the main application
window. To abort the operation, click Cancel in the bottom-right corner.
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Artec Studio will import frame files as individual single-frame scans. After importing each scan, the application
calculates the key frames for any scan that contains more than one surface. Also, the application will check the
surfaces for defects when the appropriate setting is enabled (see Surface-Consistency Detection During Import).
If it finds defects, it will show a dialog with a list of defective surfaces once the import operation is complete.
You can then choose which ones should be corrected.

Note: When importing point clouds from an external source in e57 format, you will need to choose how Artec
Studio interprets the data, especially if the file contains multiple segments.

Figure 101: Dialog for importing point clouds in e57 format.

1. Import separately. Choose this option if you want Artec Studio to treat each part of the imported file as
an individual point cloud. This is useful if the file contains multiple distinct segments (such as separate
hemispheres). After import, each segment will appear as a separate object in the Workspace, allowing for
independent processing.

2. Merge into one cloud. Select this option if the data represents a single point cloud but has been divided into
multiple parts. Artec Studio will merge these segments into a single point cloud object in the Workspace,
processing it as one unified cloud.

8.4.2 Importing Ray II scans

To import Ray II scans, use the File → Import → Ray II scans menu option. Next, select a Ray II project (*.artec)
file . You can also drag and drop a file into the main Artec Studio window.

Now, mark the checkboxes of the desired scans to import, and then click Import button.

Note: Wait until all selected scans are imported. Imported scans will appear in the Workspace panel.

Spheres and checkerboard targets can be searched during import and later with the Target Detection tool in the
Tools panel. Disabling the Sphere targets option of the import dialog will make the import faster.

To detect spheres for further Global registration and Alignment:

• Mark the checkboxes of desired scan in the Workspace.

• Navigate to the Tools panel → Target Detection.

• Click the icon.

• If searching for spheres, select the Sphere targets option and specify the spheres’ diameters by entering
the value in the Diameter field.
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Figure 102: Dialog for importing Ray II scans from the selected project (*.artec).

Figure 103: Imported Ray II scans in the Workspace panel.
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Figure 104: Import options

• If also searching for checkerboard targets, select the Checkerboard targets option.

• Click the Run button to apply Target detection algorithm.

Figure 105: Target detection pop-up

8.4.3 Importing CAD models

You can import CAD models created in different CAD programs and saved to the following formats: STEP, STP,
IGES, IGS, X_T, SAT.

To import a file, use the File → Import → CAD models menu option. Next, select a file for importing. You can
also drag and drop a file into the main Artec Studio window, or just double click on it.
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Figure 106: Imported CAD model.

8.4. Importing Models and Scans 134



Artec Studio, ver. 19

8.5 Exporting Models, Scans and Point Clouds

When you want to store data for future processing, the best approach is to save the project as an A3D file or to
export the data to the SCAN format. Any Artec Studio version can open the latter format. If you plan to use the
data in other applications, however, you should save scans and individual frames in another format.

You may also need to perform one of the following tasks:

Export one or more
scans

File → Export →
Scans or use the Ex-
port option in the
context menu

Doing so will save all frames to folders with names that match
the corresponding scan names. An exception is the SCAN for-
mat; in this case, Artec Studio not only stores the frame-by-
frame scan structure, but it does so in a single file.

Export a single sur-
face

File → Export →
Meshes- or use the
Export option in
the context menu

It works for models. If you, however, marked several scans, mod-

els or frames using the button, Artec Studio will suggest
merging them.

Export Ray/Ray II
scans

File → Export →
Point clouds

It works for point cloud scans from Ray/Ray II.

8.5.1 Exporting Scans

To export scans:

1. Mark any scans you want to export using the button.

2. Right click and select the Export → Scans option, or select the File → Export → Scans command.

3. Click the … button to open and specify the destination folder.

4. Select Scan export format using the eponymous dropdown list.

5. If the selected format supports textures, also specify the texture format.

6. Select the Apply transformation checkbox, or leave it cleared (for more information, consult Understanding
How Artec Studio Applies Transformations).

7. Click OK.

ply Stanford polygon file format
stl Stereolithography file format
obj Wavefront OBJ file format
wrl VRML file; actual extension is *.wrl
x Direct X file format
scan Artec 3D scan format
obc OBC point-cloud file

Note: The export process for models and scans runs in the background, so the application will allow you to
continue working with the scans. The progress indicator for the export operation will appear at the bottom of
the main application window. To abort the operation, click Cancel in the bottom-right corner.
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8.5.2 Exporting Meshes (Models)

You can export a single model (mesh) or several models at a time. Models can be merged before export or
exported separately.

To export a mesh or multiple meshes:

1. Mark one or more models using or select frames in the scan by clicking on them while holding the
Ctrl key.

2. Right click and select the Export → Meshes option, or select the File → Export → Meshes command. A
dialog window will appear (Figure 107).

Tip: Ctrl+Shift+E hot key does the same.

3. Click … and specify the destination folder.

4. Use one of the following options for the file names:

• Leave the field blank and the exported meshes will get the same names as their corresponding
models in the Workspace panel.

• Enter a custom export name. If you are going to export multiple meshes, this name will be used
as a mask. For example, if you specify ‘Model’ as the custom export name, then the meshes will be
named as Model1, Model2, and so on.

5. Select an appropriate mesh format from the Model export format dropdown list1 (see the description of
available formats below).

6. If the model has texture and the selected mesh format supports it, choose an appropriate texture export
format from the eponymous dropdown list (see Storing and Exporting Color Information for details).

7. To merge the models into a single mesh before exporting, select the Merge models checkbox. Otherwise,
each model selected in the Workspace panel will be exported to a separate file.

8. To move the models to origin before exporting, select the Move to origin checkbox.

9. Click OK.

PLY Stanford polygon file format (standard andwith the support for vertex color)
STL Stereolithography file format
VRML VRML file (1.0 and 2.0); actual extension is *.wrl
OBJ Wavefront OBJ file format
ASC Point cloud 3D format
AOP American Academy of Orthotists and Prosthetists file format
PTX Walt Disney Ptex: mesh with per-face texture mapping
X Direct X file format (binary or text)
XYZRGB XYZRGB file format
E57 ASTM E57 3D file format (with the support for vertex color)
USD $ Universal Scene De-
scription (*.usda in text and
*.usdc in binary format; *.
usda/usdc via usdz
zipped in an archive

also in binary or text format)

1 If you type an extension in the file name field, application will use it rather than the selected mesh file format.
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Figure 107: Dialog for exporting meshes.

See also:

Model Placement

8.5.3 Exporting CAD objects

You can export CAD primitives created in Artec Studio to the following formats: STEP, IGES, X_T.

To export CAD primitives:

1. Mark one or more CAD object using flag or Workspace menu commands.

2. Select the File → Export → CAD objects command.

3. Specify the destination folder, enter the file name, and select the appropriate format from the dropdown
list.

4. Click Save.

8.5.4 Exporting Point Clouds

You can export point cloud scans obtained from Ray and imported from Ray II to either of the following formats
(respective units are given in the third column):

PTX Leica Geosystems Cyclone Point Cloud. Important! Don’t con-
fuse it with Disney Ptex.

Meter

XYZ XYZRGB file format, raw point clouds from Artec Point Specified in settings
BTX Artec Ray/Ray II point cloud; various versions (v2, v3, v5, v6). Micron
E57 Artec Ray/Ray II and external point clouds Meter

1. Mark one or more point cloud scans using flag in Workspace. Ensure that you have selected a point
cloud scan by double-clicking its name: the panel must show point cloud properties.

2. Select File → Export → Point clouds.

3. Specify the destination folder and required format and click Save.
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8.5.4.1 Merging Sections

When exporting to PTX, ensure the Export point clouds to PTX with merged sections checkbox is marked in the
Artec Studio settings. This option merges all sections (selections made during scan with Ray scanner) so that
third-party software products can open the exported file.

8.5.5 Understanding How Artec Studio Applies Transformations

Artec Studio offers two options for exporting surfaces:

1. Store surfaces using the scanner coordinates and create XF text files that contain the coordinates calcu-
lated during registration. To use this approach, clear the Apply transformations checkbox.

2. Store surfaces that are relocated to the positions calculated during registration. In this case, XF files
contain no relevant data. To use this approach, select the Apply transformations checkbox.

8.5.5.1 Special Aspects of Scan Placement

In most cases when you’re exporting a scan to a common 3D-graphics format, you should select the Apply
transformations checkbox. By doing so, you instruct third-party applications to display surfaces in the same way
that Artec Studio does: that is, with the origin at the center of mass. If for some reason you need to store a scan
in the scanner’s coordinate system—in other words, with surfaces located at a distance from the origin that is
equal to scanner’s operating range—clear the Apply transformations checkbox.

Technically, Artec Studio saves scans in the scanner’s coordinate system, but it displays them in a user-friendly
manner by placing the origin at the center of mass. The actual positions of surfaces calculated during reg-
istration are stored in text (XF) files. Therefore, when you’re importing files using Artec Studio, it makes no
difference whether the checkbox was cleared when Artec Studio exported them. It does make a difference,
however, for third-party applications that cannot read XF files simultaneously with 3D geometry.

8.5.6 Storing and Exporting Color Information

You can transfer color information for 3D surfaces in three ways. The most common is through a texture using
a separate bitmap file (see Applying Texture (Procedure)). Another option is to save color information in each
vertex of a mesh. The third is to assign a small textured fragment to each polygon. The two latter methods
produce no texture files.

Colors stored in a vertex are blended throughout the polygon. As a result, you should avoid oversimplifying the
exported mesh; otherwise, colors blended over a large face may fail to render true texture information.

Table 8: Formats that support color-information transfer.
Texture stored as a bitmap PLY, VRML (*.wrl), OBJ, X, USD
Model file contains separate texture for each face PTX
Formats that support vertex color plyVC, XYZRGB, E57

When exporting texture as a bitmap image, you can select one of the following formats: PNG, BMP or JPG.
PNG format provides the best quality for a given file size thanks to its lossless image compression. JPG is the
most compact format.

8.5. Exporting Models, Scans and Point Clouds 138



Artec Studio, ver. 19

8.5.7 Exporting Target Coordinates

If you scan while in the Targets tracking mode using only Artec scanners, you can save an OBC file containing the
target coordinates. Once you finish scanning, run Global registration, then do the following:

1. Use the button to mark any scans that you captured without having uploaded an OBC file.

2. Select the File → Export → Scans command.

3. Click the … button to open and specify the destination folder.

4. Select obc from the Scan export format dropdown list.

5. Click OK. The targets.obc file will appear in the folder you specified.

For more information on the OBC file structure, consult the FAQ.

8.5.8 Exporting to Leios

Artec Studio enables you to export files to Leios by accessing the File menu if the Leios software is already
installed on your computer.

1. Select a model in the Workspace panel

2. Open File → Export to Leios

3. Then, in Leios, select millimeters as the length unit for the imported files.

8.5.9 Exporting to Geomagic Design X

Polygonal models created in Artec Studio are insufficient for most design needs. Geomagic Design X (formerly
Rapidform XOR) is purpose built to create manufacturing-ready CAD model’s directly from meshes.

To export a model,

1. Make sure Geomagic Design X is installed on your computer

2. In the Workspace panel, mark one model using the flag

3. Select the Export to Design X command from the File menu

4. Wait for the model in OBJ format to open in the reverse-engineering system.

8.5.10 Exporting to SolidWorks

Artec Studio allows you to export models, CAD primitives and cross-sections to SolidWorks. You can export CAD
primitives, cross-sections and models directly to SolidWorks without any third-party plug-ins. It is also possible
to export one or multiple objects into a single file in SolidWorks.

To export objects,

1. Make sure SolidWorks is installed on your computer

2. In the Workspace panel, mark one or more objects using the flag

3. Right-click and select the Export to Solidworks option from the context menu

4. Alternatively, use the Export to SolidWorks command in the File menu

5. Wait for the selected objects to open in the CAD system as one single file
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Figure 108: Model exported to Geomagic Design X
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6. In order to export each object as a separate instance, export them one by one

8.5.11 Exporting to Control X

Control X is a 3D quality control and dimensional inspection software with which you can capture and process
the data from 3D scanners to measure and inspect quality. With Artec Studio 17, you can export models and
target clouds to Control X, or directly inspect them and generate inspection results.

To inspect a model or target cloud in Control X,

1. Make sure Control X is installed on your computer

2. In the Workspace panel, right-click on the model or target cloud that you want to inspect

3. Select the Inspect in Control X option from the dropdown menu

4. Wait for it to directly open in Control X and generate the inspection report

8.5.12 Exporting to Artec Cloud

Artec Cloud is an easy-to-use collaborative platform that makes your 3D scan data available to you and your
team, anywhere.

The Artec Cloud interface is now integrated into Artec Studio. You can view, download and upload projects and
fusions in Artec Cloud, directly via Artec Studio. This enables you to quickly share your projects, without any
external devices or without the need to open Cloud in a browser. It is possible to upload projects stored in your
PC, upload newly acquired meshes, generate sharable links and automatically create Artec Cloud accounts, that
are free to use.

8.5.12.1 Sharing projects:

To open and view projects in your Artec Cloud account, open Home panel → Artec Cloud. Each project contains
its status info on the preview image. To upload a new project from your PC, navigate to the Recent tab in the

Home panel, click on the upload ( ) icon of the desired project, and then click on the Upload button. If you’re
a first time user of Artec Cloud, the window prompts you to create a free account.

Figure 109: Upload a project from Artec Studio to Artec Cloud

Once uploading completes, the project preview image will have the uploaded ( ) icon.

To sync the shared project between Artec Studio and Artec Cloud, you have three following states:
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• Project updated locally - click on the synchronize ( ) icon to upload local updates of the project to Artec
Cloud. You can review changes by clicking the Review changes button. Review changes modal will display
the list of changes made with this project in Artec Studio.

Figure 110: Review changes before uploading them to Artec Cloud

To upload changes to Artec Cloud, click the Upload to Cloud button.

• Project updated in Artec Cloud - click the cloud icon ( ), and then click the Check updates button. Once

checking updates completes, you can review updates by clicking the sync icon ( ), and then clicking
Review changes button.

Figure 111: Review changes before downloading from Artec Cloud

To download changes from Artec Cloud, click the Download from Cloud button.

• Project updated both locally and in Artec Cloud - click the sync icon with a dot ( ). Sync popup will show
you how many changes have been made in Artec Studio and Artec Cloud. Click the Review changes button
to see the difference.
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Figure 112: Review changes made either in Artec Studio and Artec Cloud

Here you have the following options to resolve conflict:

• Get changes from Cloud - All changes made in Artec Studio and not uploaded to Artec Cloud will be
overwritten by those from Artec Cloud.

• Upload changes to Cloud - All changes made in Artec Cloud and not downloaded from there will be over-
written by those from Artec Studio and uploaded to Artec Cloud.

• Split changes into two projects - A copy of the conflict project will be created and displayed in the Recent
projects tab, the original project will get all changes from Artec Cloud. From now on, these are two
separate projects.

Alternatively, you can click the Resolve conflict button on the Sync popup instead of reviewing changes in detail.
There, you can select the same options for resolving conflict described above.

8.5.12.2 Sharing fusions:

• To upload a fusion that is currently open on Artec Studio, select the fusion, go to File → Export→ Fusion
to Artec Cloud. Alternatively, right-click on the fusion in the Workspace panel, and select the Upload to
Cloud option from the drop-down menu.
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8.6 History of Project Changes

Artec Studio stores all data changes, and you can later undo any unnecessary changes. You can see the saved

changes and their use of memory in the History panel. To open the panel, click the button at the bottom
left or hit Ctrl+H

Figure 113: The History panel.

Click on the desired operations in the list to undo or redo them. Operations can be undone (redone) only
sequentially, i.e. you cannot skip any of them selectively.

To quickly undo or redo the changes stored in the project history, you can also use the following options:

• Undo:

– Hit Ctrl+Z or

– Click in the lower-left corner of the main window

• Redo:

– Hit Ctrl+Y or

– Click in the lower-left corner of the main window

When you save a project, Artec Studio stores 3D data together with the history of changes. You cannot limit
the maximum length of command history. The Clear command history button clears the command history, and
thus frees up RAM, and makes the undo operation for the most recent changes unavailable. Additionally, in the
Clear History window, you can choose to Keep the last’n’ actions, and clear the rest. Simply specify the number
of actions you would like to keep, and confirm. To clear the history, you can use the Edit → Clear history menu
option in the main window or hit Ctrl+Alt+H.
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CHAPTER

NINE

DATA PROCESSING

Once you have captured an object from all desired angles and created a sufficient number of scans, you can
then build a 3D model. This chapter offers a detailed description of the process.

See also:

3D Scanning at a Glance.

• Reconstructing HD scans from saved raw HD data

• Revising Scans and Editing Scans

• Alignment

• Global Registration

• Creating Models (Fusion)

• Editing Models

• Texturing

9.1 Maximum Error and Registration Quality

Error is the parameter that reflects frame registration quality. For scans, it shows the maximum value among
all the frames. The larger the value, the less accurate the alignment. Artec Studio displays noteworthy values
only for scans that have passed Fine registration, Align and Global registration.

Table 9: Maximum error values for the scanner types.
Good results Acceptable Unacceptable

Spider/Spider II 0.0–0.1 0.2–0.3 0.4–…
Eva 0–0.3 0.4–0.9 1.0–…
Micro/Micro II 0.0 0.1 0.2–…
Leo 0.0–0.5 0.6–1.3 1.4–…
Ray/Ray II 0.1–0.9 1.0–2.9 3.0–…

Table 10: Other possible errors.
Error Recommendations
Warning! Check the frame list
Failed Indicates unregistered frames in Show all frames mode
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9.2 Reconstructing HD scans from saved raw HD data

If your scanner supports the HD mode (such as Artec Eva) and you used it to capture raw HD data without
reconstructing HD scans (see Enabling HD Mode for details), then before you start building a 3D model, you may
want to get HD scans from this data.

To launch the reconstruction of HD scans from your saved raw HD data, follow these steps:

1. In the Workspace panel, select one or more raw data scans (Figure 114, right).

Note: Raw data scans are not rendered in the 3D View window.

2. Open Tools → HD Scan Reconstruction (Figure 114, left).

3. Select the desired values for the HD frames frequency and Point density parameters. For their description
and setup recommendations, see Launching reconstruction after scanning.

4. Click Run.

Figure 114: Launching HD scans reconstruction from saved raw HD data.
The HD Scan Reconstruction data section in the Tools panel on the left, a raw data scan selected in the Workspace panel on

the right.

Important: The HD reconstruction is a time-consuming and resource-intensive operation. On slow computers,
it can take up to several hours. If Artec Studio evaluates your computer’s resources as insufficient for the
selected values of Point density and HD Frames frequency, then the corresponding warning will be displayed.
For information on resources requirements, see the Using HD mode section in System Requirements.

The HD reconstruction will start, and the corresponding progress bar will be displayed on the Status bar.

When the processing is complete, HD scans will appear in the Workspace panel. Their names will be marked
with the letters “HD”, for example: Eva HD Scan 1.
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9.3 Revising Scans

As you begin building a 3D model, you may want to start by preprocessing your scans: separate misaligned
areas (if any) into separate scans and cut out unwanted objects from the scene.

You may encounter the following problems:

Figure 115: Possible scan errors.
Bad geometry on the left, scan misalignment in the middle and hands captured in frames on the right.

• Misaligned frames (see Figure 115, left)—may occur because of small size, an insufficient number of
geometrical features on the object or an insufficient number of polygons in a frame.

• Misaligned parts (see Figure 115, middle)—occurs when the real-time alignment algorithm incorrectly
determines the position of the new frame relative to previous ones.

• Unwanted objects in the frame (see Figure 115, right).

A visual inspection of the frames can be very helpful in determining problematic areas. To perform a visual
inspection, select the scan and view all the frames that it contains by holding ↑ or ↓ on the keyboard. This
technique can easily detect misaligned frames.

When viewing scans, application generally shows only key frames and textured frames. To display all the frames,
select the Show all frames option in the Scene settings.

See also:

Misalignment Detection.

9.3.1 Separating Scans

During the fine-alignment process, frames in certain scans may be misaligned. Sometimes it’s possible to divide
the problematic scan into several scans, where each part is registered fairly well. In this case, divide the scan.
To move some of the frames into a new scan, use the following procedure:

1. Select in the Surface List panel the frames you want to move (see Selecting Frames).

2. Click RMB and select Move to new scan (Figure 70, right).

You can also fix alignment errors in another way: reset the current frame-transformation values and repeat the
registration, making any appropriate changes to the settings. Select the desired scan in the Workspace panel,
click on it using RMB and select Unregister from the dropdownmenu. Doing so will reset the computed positions
of individual frames in the scan. A dialog will then appear, prompting you to confirm the operation. To compute
new positions, run the Rough serial registration and then Fine registration algorithms (see Fine Registration).
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9.4 Alignment and Registration at a Glance

Registration and alignment tools perform similar tasks, however, they differ. Use the table below to get an
insight into the details.

Table 11: Understanding registration and alignment modes.
Type Purpose Details
Fine registration Adjusting frames’ positions Treat scans in batch separately. Starts once

you leave Scan panel.
Align Assembling scans See also Alignment
Global registra-
tion

Optimizing frames within scans Launch it for a pre-aligned batch of scans or
for a single scan

Rough serial reg-
istration

Preliminary registration performed dur-
ing scanning

No need to start it manually

Photo registra-
tion

Applying texture to models with regis-
tered photographs

See also Texturing

9.5 Editing Scans

To edit scans, open Editor from the side panel and select the Eraser tool. You can also use Positioning tool or
Transformation tool to orient the scanned data.

Figure 116: Editor panel.
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9.5.1 Eliminating 3D Noise (Outlier Removal)

During the scanning process, so-called outliers may appear in the scene. Outliers are small surfaces uncon-
nected to the main surfaces. They require removal because they may spoil the model or produce unwanted
fragments. Artec Studio provides two ways to remove outliers: erase them before fusion (preventive approach)
or after fusion (“furthering” approach”). We advise using the former approach because it decreases the possibility
of improper fusion by preventing noisy features from attaching to the main surface.

This outlier-removal approach is based on a statistical algorithm that calculates for every surface point themean
distances between that point and a certain number of neighboring points, as well as the standard deviation of
these distances. All points whose mean distances are greater than an interval defined by the global-distances
mean and standard deviation are then classified as outliers and removed from the scene.

For better results, we recommend running global registration before starting the algorithm. If you begin Outlier
removal before doing so, a dialog will appear prompting you to perform global registration.

Figure 117: Outlier removal: before and after.

In most cases, none of the parameters accessible through the button requires adjustment. But if necessary,
you can change the values of these parameters:

• 3D-noise level is a standard-deviation multiplier. We recommend choosing the value for this parameter
according to the following guidelines:

– 2 for noisier surfaces

– 3 for less noisy surfaces

• 3D resolution, mm should be set equal to the resolution of the Fusion process that you expect to run later.

Click Run to initiate Outlier removal.

9.5.2 Erasing Portions of Scans (Eraser)

Nearly always, the scanning process will capture unwanted elements, such as walls, the operator’s hands, sur-
faces on which the object is located and other extraneous objects. This unwanted data can hinder postprocess-
ing. To avoid this problem, we recommend eliminating these objects before processing. Eraser offers several
options to quickly and easily remove unwanted elements from the scene (see Selection Types).

1. Open the Editor panel using the side toolbar.

2. Open the Eraser tool by clicking or by hitting E.
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3. Select one or more scans in the Workspace panel.

4. In the Editor panel, choose the required selection type.

5. Consult the instructions for a specific mode and select regions on the scans that you want to erase. To
clear all selections, click Deselect.

6. Click Erase to eliminate the area highlighted in red or to apply cutting plane (Cutoff-plane or Base selec-
tions).

To undo changes, click in the Workspace panel or menu Edit, or hit Ctrl+Z. Each click of the Erase button

generates a command history entry. To undo several operations, use the dropdown menu of button and
select the lowest entry.

Note: From Artec Studio version 18 onwards, you can also set an Eraser lock to one or more objects in the

workspace. The Eraser tool will not affect any object in the Locked object status.
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9.5.2.1 Selection Types

Type Illustration Usage

2D Hold down Ctrl and use Scroll wheel to adjust the tool
size. Paint with Ctrl+LMB to create a selection.

3D See above.

Rectangular Use Ctrl+LMB to select a rectangular region.

Lasso
Use Ctrl+LMB to freely outline an irregular region. You can
release LMB (not Ctrl) and then continue clicking on desired
points to select a desired shape.

Cutoff-plane

Create selection as in 2D mode. Once you have released the
mouse button, a plane will appear. If necessary, adjust the
plane level by using Scroll wheel while holding down
Ctrl+Shift or orient the plane freely in 3D space. To this
end, hit Alt to display the designated control. Then still hold-
ing the key, drag the required control ring. Note that it doesn’t
work with raw point clouds from Artec Point.

Base
Select a flat area as in 2D mode. The tool will automatically
fit the base plane and select everything below it. Note that it
doesn’t work with raw point clouds from Artec Point.

Object
Select any separate part of the mesh. This option enables
you to easily remove any unwanted object, as whole, from
the model.
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If the Select through checkbox is selected, all surfaces throughout the scan are affected. If not, the brush only
works on the visible surface.

Figure 118: Select through in 2D selection: disabled in the middle, enabled on the right.

Use the following general procedure to erase unwanted elements. With the Eraser tool, you can also edit target
clouds by selecting the desired target using one of the available selection types (2D, 3D, Rectangular, or Lasso).
Follow the general procedure to complete the editing of target clouds.

See also:

Hot keys in Editor.

9.5.2.2 More Actions With Selections

Apart from erasure, you can perform the following action with the selected regions:

• Clear selection to create a new one. Click Deselect or reselect the region manually while holding down
Ctrl+Alt.

• Invert selection (clear the highlighted region and select the rest). It might be useful when working with
large scans. Click Inverse or hit I.

• Temporarily hide selection if it obstructs the region you want to erase. Click Hide to this end. To display
hidden polygons, click Show. Then select the region you want to erase.

9.5.2.3 Erasing Supporting Surface

Artec Studio offers two selection modes that differ from conventional brushes in the way how you select the
area for erasure. First, you indicate the flat surface (table, floor or base) on which the object is resting. Then,
application either determines the base plane and select the area underneath it (Base selection, Figure 119), or
creates a cutting plane (Cutoff-plane selection) that divides the scan into two parts: the first will remain and the
second will be erased (see Figure 120). You can orient this plane in any way you need.

Tip: Consider using the Enable automatic base removal option when scanning since it deletes the flat surface
automatically after you close the Scan panel.
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Figure 119: Base selection in action: indicating a flat region → defined base → removed base.

Figure 120: Various controls for orienting cutoff plane: around axes (X, Y and Z) and view direction.

9.6 Fine Registration

Fine registration is an algorithm designed to precisely align captured frames.

In a number of cases you can start the Fine registration algorithmmanually open Tools→ Registration and select

the Fine type of registration. The algorithm affects all scans marked with the icon in the Workspace panel
(see Selecting Scans and Models for more information on scan selection), but it processes them separately.

Features Geometry and texture or Ge-
ometry

The type of algorithm that will perform scan registra-
tion. The former is preferable as it takes both geometry
and texture into account. If your scan entirely lacks tex-
ture, we recommend using Geometry option.

Subsampling 0.01–1

The option makes the input geometry data less dense
to speed up the processing. Use lower values for ob-
jects with poor geometry. Designed for scans with HD
reconstruction, this option can speed up processing in
Geometry and texture mode.
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9.7 Scan Decimation

Sometimes it is necessary to leave only a portion of frames in scans, which are hard to process, and doing it
manually can be quite tedious. Therefore, Scan decimation filters surfaces in scans, preserving only the specified
percentage of raw data within reasonable limits of frames before starting processing. The exact decimation %
can be selected and applied to one or multiple scans within the project.

Figure 121: Scan decimation tool.

9.8 Alignment

Although Artec Studio features continuous scanning, there may be some cases where the application lack suffi-
cient information about the relative positions of multiple scans. To assemble all scans into a single whole, you
must convert the data to a single coordinate system—that is, you must perform alignment using the Align tool.

Hint: First refer to Auto-Alignment.

9.8.1 Selecting Objects for Alignment

In the Workspace panel, use the flag to mark all scans or groups that you intend to work with. Once you click
Align in the side panel, the marked scans and groups will appear in the left panel already selected in the same
order as they appear in the Workspace panel.

Note: Workspace group of scans is treated as a single entity. To release objects constituting the group, use
the Ungroup item from the dropdown menu.

During the Align operation, Artec Studio divides the selected scans or groups into two collections: registered
(aligned) and unregistered (unaligned). The first collection initially contains only one scan (the first one in the
list) or group, which are highlighted in blue. Collection name appears in bold and uses the same color icon (
or ). Auto-Alignment, however, may produce several collections of aligned scans.
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The user’s task is to align all scans to those that are already registered and to “assemble a model”. In general,
the procedure includes the following steps:

1. Select a required Type from the dropdown menu in the Align panel.

2. Select one scan or group ( ) from the unregistered collection in the Align panel. The name of unregis-
tered scan appears in a regular typeface. When selected, the unregistered scan is marked by the gray icon
, whereas the group is marked by icon . You can select several scans using either of the following

methods:

• Press and hold down the Ctrl key, and then click each scan or group that you want to select

• Click the first item, press and hold down the Shift key, and then click the last item.

3. If necessary, specify point pairs (for two scans) or sets of points (for more than two scans)

4. Click the desired alignment-command button (Auto-Alignment is the most recommended one). The com-
mand affects all scans selected in the Align panel plus the first one ( ).

Note: If other objects, except for scans, belong to a group, you can also position them simultaneously with the
scans. Select the Apply to all objects in parent groups checkbox to this end.

Since each alignment type varies in its effects, see the details in the corresponding subsections for more infor-
mation. Note that you can use either one method or a series of methods: drag alignment, best fit alignment
with and without points, auto-alignment, datum alignment etc.

9.8.1.1 Changing Object Status

If you have already aligned several scans, you should move them to the registered collection. Select them in the
Align panel using LMB. Next, click RMB on the name of any scan and select the Mark as registered option from
the dropdown menu, or just double-click its name in the list. At this point, Artec Studio will treat registered
scans as one, so you cannot move them independently.

If you accidentally mark a scan as aligned, remove it from the registered collection by selecting the Mark as
unregistered item from the dropdown menu, or just double-click it.

9.8.1.2 Navigation in 3D View

Objects selected in the Align panel will appear in the 3D View window. Navigation in Align mode is similar to
navigation in the 3D View window.

Rotate Hold LMB and move mouse
Zoom in/out Scroll the Mouse wheel, or hold RMB and move mouse
Move freely Hold LMB and RMB simultaneously, or hold the middle button, and move mouse
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9.8.1.3 Managing Collections and Scans

You can perform the following actions on the scans from the list in the Align panel (right-click on the item to
open the context menu):

• Mark as registered. Only available for single unregistered scans or groups ( → )

• Mark as unregistered. Use this command to discard the alignment state of a particular scan (unavailable
for scans)

• Select collection highlights the respective collection ( , , and so on)

• Mark collection as registered converts all scans from the collection into the basic registered collection (
→ )

9.8.2 Drag Alignment

Drag alignment is the fastest alignment method, but also the least accurate. This method allows you to align
scans by manually dragging them in the 3D View window.

Owing to the low accuracy of this approach, however, you can optionally use it for preliminary alignment before
running more-accurate alignment types.

Figure 122: Dragging a scan

1. Select the scan you want to align, keeping in mind the recommendation in Selecting Objects for Alignment.
Artec Studio allows you to select multiple scans, but note that it will align them with the registered scans
as a single unit.

2. Holding down the Shift key and one mouse button, move and rotate the scan you’re aligning (a green
one ) close to the registered scan (a blue one ). Here is a list of allowedmovements and corresponding
buttons:

• Shift+LMB to rotate

• Shift+LMB+RMB to move

• Shift+RMB or Shift+Scroll to move only unregistered scan along the view direction
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Figure 123: “Drag” alignment result

3. To confirm the alignment, release the mouse button(s) and the Shift key, then click Apply. Note carefully
that any scans you are registering won’t automatically move to the registered set (see Figure 123). You
can do so manually as the Changing Object Status describes.

4. If you have several scans to align, repeat these steps for each one individually.

9.8.3 Auto-Alignment

Best Fit alignment is a universal alignment type suitable for aligning most scans. However, Auto-alignment is
the easiest approach. The advantages of the latter type include the ability to align several scans at once and
avoid the need to specify points; the only disadvantage is minimum requirements for the size of the overlapping
areas in the scans you’re aligning.

To perform auto-alignment, follow these steps:

1. Mark the necessary scans/objects for alignment.

2. If several objects are already marked in the Workspace panel, then all of them are automatically selected
upon opening the Align panel. You can then clear unnecessary selections using the Ctrl key.

3. Select the Best fit type in the Align panel.

4. In the Points option, switch ON the Auto toggle, and click on Align.

5. Ideally, Artec Studio aligns all the scans and marks them using the icon. It may, however, mark scans
as registered even though the 3D surfaces failed to join properly.

Important: Artec Studio version 18 onwards, Auto-alignment can be used to align a Mesh to CAD model.

Auto-alignment may produce the following results:

• Aligned scans, marked with the icon (basic collection of registered scans)

• Unregistered scans, marked with the icon

• One collection ( ) or several collections ( , ) of registered scans. Scans forming this collection failed
to align with the basic registered collection ( ), although they succeeded in aligning with each other.
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Note: Auto-alignment may be unsuccessful if the scans have a small overlapping area.

We recommend resolving issues with unregistered scans or registered collections by aligning them manually as
Best Fit Alignment with Points describes. Other methods may also help.

9.8.4 Best Fit Alignment without Points

You can perform Best Fit (rigid) alignment either with or without markers (point sets). If scans are close to each
other in distance (e.g., after “drag” alignment) or have a large overlapping area or rich texture, you can skip the
task of point specification when aligning them.

Perform the following steps:

1. Make sure the Best fit type is selected.

2. Select the scans you want to align, as the beginning of Alignment describes.

3. Set the Points value to Auto by toggling the corresponding switch.

4. If aligning point clouds from Artec Ray or Artec Ray II, enable the Advanced switch to adjust the advanced
settings that determine how alignment points will be calculated:

• Distance from scanner, mm is a radius around the scanner viewpoint from where the algorithm will
take points. Alter it when you need to ignore the background 3D noise.

• Feature voxel, mm is a volume measure to cull extra points from the algorithm input. The more the
value, the more the points will be culled and the faster the algorithm. Increase it sparingly since it
affects the algorithm accuracy.

• Maximum height difference, mm determines the height difference value of scans, which helps decrease
registration algorithm processing time. If the scans are taken at different heights, please input a
value of 0.

5. Click Align. The result should be as Figure 126 depicts. If you are dissatisfied with this result, click
and follow the recommendations in Best Fit Alignment with Points.

6. Select another scan from the list of unregistered scans and repeat the above procedure.

7. Click Align once again

9.8.5 Texture Alignment

If the object was scanned with texture, the texture-alignment feature may ease the alignment process. It uses
texture-image characteristics of scanned objects and greatly decreases the possibility of incorrect alignment.
This feature also helps to align objects with few or no geometrical features, such as round or flat objects with
no corners. If an object has rich, nonrepetitive geometry, however, we recommend disabling texture alignment
to reduce the algorithm’s running time. Also keep in mind that texture alignment will be useless if the object
texture is monochrome.

To enable texture alignment, select the Enable texture alignment checkbox at the bottom of the Align panel
before you click on Align.

Note: Texture alignment is a resource-intensive algorithm that slows down the alignment process. We recom-
mend using it only in cases where the object’s geometrical features are insufficient.
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Figure 124: Advanced settings for piint clouds alignment without points.

9.8.6 Specifying Point Sets (Markers) and Editing their Positions

Before considering how to align scans using points, it is helpful to learn about point-pair specifications. The
alignment algorithm uses pairs of point, or point sets in Complex alignment type (Complex Alignment), to detect
scan areas that should be brought close together.

To do point alignment, create several point pairs. To create one pair, mark one point on the aligned scan and
then mark another one on the unaligned scan. Ensure that in each case the points for a given pair match a
corresponding point on the surface of a real object.However, high matching accuracy is unnecessary, since Artec
Studio only uses the pairs to gain a rough approximation before performing precise registration. In the Complex
type, you can create a set of points (instead of just a pair), i.e. you can simultaneously specify more than two
points in one or several unregistered scans and only one in the registered scan. All these points are connected
by polylines and form a set.

When specifying points in the Best Fit and Nonrigid types, the application automatically creates pairs. Having
specified one pair, you can immediately create the next one. In the Complex type you must confirm set creation
by hitting Space or by clicking New set from the left panel, because the set may comprise multiple points (see
Figure 125 and Figure 130).

You can toggle between the point pairs (sets) by hitting Space and Backspace, or by clicking RMB in the 3D
View window and selecting the relevant options from the menu. You can also relocate points in the pair (set).
Hover the mouse cursor over the point until the pair (set) is highlighted in white, then drag the point to the
proper position using LMB, or select the pair (set) and specify a new position using LMB. To confirm your actions
and deselect the pair (set), hit Space. You can also remove either a pair (set) or one of its individual points:
click on the point using RMB and choose the appropriate command from the menu. Alternatively, you can use
Del to remove the selected pair (set).
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9.8.7 Best Fit Alignment with Points

We recommend using the Best fit type for scans located at a significant distance from each other or when aligning
polygon models with CAD models.

Figure 125: Creation of point pair.

To use this approach, follow these steps:

1. Make sure the Best fit type is selected.

2. Select the object you want to align, as the beginning of Alignment describes.

3. Enable the Advanced switch to adjust the following advanced settings:

• Feature search radius, mm is the search radius for features used in geometry-based alignment. This
setting applies only if Auto option for Points is turned off.

• Max points is the maximum number of scan or fusion points considered during geometry-based align-
ment.

4. Specify several point pairs (Figure 125), keeping in mind the recommendations from Specifying Point Sets
(Markers) and Editing their Positions.

5. Click Align markers. This alignment type takes into account only the coordinates of specified points and
tries to reduce the distance between the markers for each pair.

6. Carry out Steps 5–7 of the procedure in Best Fit Alignment without Points.

Note: If point clouds from Artec Point are selected for best fit alignment, the Targets switch will be toggled on
by default. This means that targets will be used as alignment points.

9.8. Alignment 161



Artec Studio, ver. 19

Figure 126: Alignment result.

9.8.7.1 Allow Scaling Option

While using the Best Fit alignment mode, Artec Studio allows you to align objects of different sizes without the
need manuelly scale them. To do so, select the point pairs first, which will enable the Allow Scaling option, then
simply enable this checkbox.

Note: You can check the scale factor in your log messages after alignment.

9.8.8 Nonrigid Alignment

While Best Fit (rigid) alignment can only perform such transformations as translation and rotation, the nonrigid
algorithm can deform 3D data. This algorithm is intended to process so-called nonrigid objects: objects whose
shapes have changed during the scan (e.g., models of animals or humans—see Figure 128, left). Keep in mind
that the surface Artec Studio produces as a result of the deformation may differ from the surface of the actual
object.

Note: Nonrigid alignment works on models only. Thus, before you run it, prepare models by fusing the source
scans. It is also necessary to first align models in Best Fit mode (see Best Fit Alignment without Points, Auto-
Alignment or Best Fit Alignment with Points).

To run the nonrigid alignment, follow these steps:

1. Make sure the Nonrigid type is selected.

2. Select the models you want to align, as the beginning of Alignment describes.

3. If the models differ significantly from each other, we suggest that you specify several point pairs, keeping
in mind the recommendations in Specifying Point Sets (Markers) and Editing their Positions.

4. Where necessary, adjust the deformation degree using the flexibility slider. The greater the flexibility
value (i.e., the more “flexible” the deformation), the longer the computation will take.
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Figure 127: Alignment of Artec Point point clouds using targets.
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Figure 128: Two models after Best Fit (left) and nonrigid alignment (right).

Warning: Avoid extreme Flexibility values. Applying very large values may result in major
surface distortions and may slow down the algorithm. Extremely low values, on the other
hand, barely deform surface and often fail to produce the expected nonrigid-alignment re-
sults.

5. Click Align…. The algorithm will align models by deforming one of the model (see Figure 128, right). If

you are dissatisfied with the alignment results, click and specify additional point pairs, or reposition
the current pairs.

6. Select another model from the unregistered set and repeat the steps above.

7. Click Apply to confirm your alignment results or Cancel to reject them.

Figure 129: Flexibility slider in action: original model (left), nonrigidly aligned model with low Flexibility value
(middle) and with high value (right).
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Note: This version of Artec Studio does not support texture mapping on nonrigidly aligned models.

9.8.9 Complex Alignment

Complex alignment allows you to align not only scan to scan, but surface to surface within a given scan. Relative
to other types, this one supports multipoint-set definition—that is, you can link more than two points. It’s
useful for aligning scans obtained during circular movements of the 3D scanner in cases where fine or global
registration fails to align them. To run the Complex alignment, perform the following steps:

Figure 130: Before alignment: two point-set added.

1. Make sure the Complex type is selected.

2. Select the scans you want to align, as the beginning of Alignment describes. This alignment type allows
you to work even with just one registered ( ) scan.

3. Specify one or more point sets on the scan surface (see Figure 130), keeping in mind the recommendations
in Specifying Point Sets (Markers) and Editing their Positions.

4. Click Align… to run the alignment with your specified restrictions (Figure 131 shows example results). If

you are dissatisfied with the alignment results, click and specify additional point sets, or reposition

the current sets. To redo an operation that you have undone, click .

5. Click Apply to confirm your alignment results or Cancel to reject them.
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Figure 131: Alignment result.

9.8.10 Datum Alignment

Some quality control tasks for a CAD model require very precise positioning of the CAD model relative to the
original mesh. For this purpose, the Datum Alignment type was implemented in Artec Studio 17. This type
allows you to view and evaluate the linear and angular deviations between the shapes of the CAD model and
the mesh.

To use the Datum Alignment type, you need to specify a set of key geometric features called datums. Datums can
be described as the reference points, vectors, or planes that help to designate the location and orientation of
the model or its part. When you define a particular geometric feature as a datum, specific constraints dependent
on the datum type are applied to the model, restricting the degrees of freedom controlled by that feature type.

Up to three datums can be specified as it is always enough to constrain all degrees of freedom. At present the
following types of geometric features can be selected as datums:

• Cylinder,

• Cone,

• Sphere,

• Plane.

The type of datums and the order in which they are selected are important, as the degrees of freedom of the
primary datum (datum A) will be applied first, with negligible or no deviation. Then, the remaining degrees of
freedom will be constrained by the secondary datum (datum B) so that models will be aligned as precisely as
the first constraint allows. Finally, the tertiary datum (datum C) will be considered, subject to the limitations
imposed by the previous datums.

Note: Datum alignment is a fine alignment type, so it requires a pre-alignment to be performed first. If selected
objects haven’t been aligned beforehand, a yellow warning will appear on the Datum Alignment tab along with
a button that opens the Best fit alignment tab (see Figure 133).
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Figure 132: Example of datums specified
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Figure 133: The disabled Datum Alignment for non-aligned objects
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To perform datum alignment, follow these steps:

1. Select a CAD model and a mesh to be aligned in the Workspace panel.

2. Open the Align panel. By default, it will open on the Best fit tab.

3. Prepare the selected CAD model and mesh for alignment using one of the Best Fit alignment methods:
Best Fit Alignment without Points, Best Fit Alignment with Points or Drag Alignment. Then, click Align.

4. After the models are pre-aligned, switch from the Best fit tab to the Datum tab.

5. Wait until the models are prepared for further work.

Note: Artec Studio may require additional time to synchronize the models.

6. Specify the Reference model and the Mesh to align. You can hide the mesh from the 3D View window by
deselecting the Show mesh option.

7. Click the desired element of the CAD model to select it as the first datum.

The selected element will be labeled as Datum A (or Datum B, etc.). Depending on the type of element
selected, a linear ( ) and/or angular ( ) deviation pop-up will be displayed (see Figure 132).

• To move the deviation pop-up, drag it to the proper position using LMB.

• To deselect a datum, click the x button to the right of its name in the Align panel or in the deviation
pop-up.

• To clear all datums, click the button in the Align panel.

8. Repeat step 6 to specify other datums if required.

Note: It is not necessary to specify three datums each time. In some cases, to constrain the system
completely, only two datums are required (for example, two non-parallel cylinders). For some quality
inspection scenarios, even one datum may be enough.

9. To complete the work with datum alignment, click Done.

In the Datum Alignment type, you can also calculate a distance map to visually estimate the deviation.

To calculate the distance map:

1. Enable the Distance map switch in the Align panel.

2. Specify the Search distance value (in mm) and then click Calculate. Once the process is complete, the
distance map will appear in the 3D View window.

3. To save the distance map for further work, click . It will be available in the Measures tab under the
name Distance map 1 (Distance map 2, etc).

See also:

Distance Maps
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Figure 134: Example of a distance map calculated in the Datum Alignment type
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9.9 Global Registration

Once you have aligned all your scans, proceed to the next stage: global registration. The global-registration
algorithm converts all one-frame surfaces to a single coordinate system using information on the mutual po-
sition of each surface pair. To do so, it selects a set of special geometry points on each frame, followed by a
search for pair matches between points on different frames. To perform correctly, the algorithm requires an
initial approximation, which a user ensures in the course of the Align operation.

Note: Global registration is a resource-intensive operation. Processing of large data sets may take a long time
and require a large amount of RAM.

Before launching the global-registration algorithm, you can fix the position of some of the scans and/or their
frames if necessary (for detail, see Locking Object’s Position).

To launch the algorithm,

1. Select all aligned scans in the Workspace panel.

2. Open Tools → Registration.

3. Make sure Global is selected as the registration type in Registration pop-up.

4. Check the Preset field on the Tools panel. It must display the actual scanner that was used to obtain the
selected scans.

5. Click Run.
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9.9.1 Global-Registration Parameters

Features Geometry and texture, Geom-
etry, or Reference cloud

The type of algorithm that will perform scan registra-
tion. If an object has rich texture and poor geometry,
consider using the Geometry and texture option. For
objects with rich geometry, you can choose Geometry
mode to increase the registration speed. For registra-
tion of targets on a scanned object with those from a
reference cloud, use Reference cloud mode.

Registration mode Collective, Separate, or Sepa-
rate then Collective

This enables registration of selected scans separately
(one by one), altogether collectively, or both separately
then collectively. Does not work with the Artec Ray and
Artec Ray II.

Key frame ratio 0–0.6

Determines how many surfaces are treated as key
frames. Decreasing this parameter when processing a
feature-rich object may speed up registration. Increase
it if only the previous attempts to register scans failed.
Technically, values higher than 0.7, including 1, are
possible, but they may significantly slow down the al-
gorithm.

Focus on geometry On/Off

Enable it for objects with rich geometry and poor tex-
ture. With this setting enabled, the registration will still
take texture into account, but geometrical consistency
will be given a higher priority. It is only available for
Geometry and Texture mode.

Search features within,
mm

3–5 mm (Spider); 5 mm
(Eva/Leo) and 50 mm in Ge-
ometry and texture mode

To align frames, the algorithm needs information on
how far away the identical features are distributed on
the adjacent frames. Lower this search radius for objects
with many repetitive features and increase for large ob-
jects to ensure the algorithm robustness. Increase this
parameter sparingly since large values may cause er-
roneous registration and hinder calculation. Adjust it if
Fine Registration completes with inappropriate values of
maximum errors.

Smart subsampling On/Off

Enable it to allow Artec Studio to automatically adjust
the input geometry data as required, to speed up the
processing. Designed for scans with HD reconstruction,
enabling this option can speed up processing in Geom-
etry and texture mode.

9.9.2 Locking Object’s Position

When you perform operations that change the relative position of objects or individual frames (such as Global
Registration), it may be necessary sometimes to lock the repositioning of some of these objects or frames.
Consider, for example, the case where you work with several scans made in the Target-Assisted Scanning mode.
The initial relative position of such scans in space should be preserved.

Artec Studio supports two types of locking mechanism:

• Lock frames ( ) - locks the repositioning of scan frames relative to each other during the global regis-
tration but allows you to move the scan itself. This mechanism applies only to scans containing frames,
that is, obtained using handheld scanners such as Artec Eva, Spider, Leo, Micro, or Micro II.
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• Lock object ( ) - locks the repositioning of the object relative to the global coordinate system. This
mechanism applies to scans and any other objects.

Note: Lock frames is the same mechanism that was called Lock in Artec Studio 15 and earlier.

The Lock object status affects not only the results of global registration but also the operations of Position-
ing, Transformation and Eraser tools (see Preparing Models To Export for details). When using these tools, any
reposition or change to objects with the Lock object status is blocked.

You can lock or unlock a specific object in the Workspace panel:

• using the context menu of this object, or

• by clicking the object row in the Lock column area

To lock or unlock all objects in the Workspace panel, click the header of the Lock column ( ).

To lock or unlock all objects in a group, click the group row in the Lock column area ( ).

Note: When you change the lock status of several objects at once, the result of the mouse click will depend
on the types of objects that are displayed in the Workspace panel or included into the group and on the current
lock status of these objects.

9.9.3 Global Registration for Point Cloud Scans

Global registration with the Artec Ray and Artec Ray II presets only runs on several point cloud scans. Artec
Studio offers four modes:

• Geometry Ray. The prerequisite step for this mode is alignment. The scans must have sufficient initial
approximations and may not have targets.

• Targets considers only targets (spheres and checkerboard targets)

• Targets and geometry. Global registration first runs on the basis of targets, then on geometric features.

• Reference cloud. Global registration of targets on a scanned object with those from a reference cloud.

9.9.4 Possible Global-Registration Errors

• After the global-registration algorithm finishes, the frames are in disarray (see Figure 135, left) or the
frame positions are unchanged. This error occurs because the application is configured for a different
scanner type than the one that captured the data. Change the device type in the application settings (see
Algorithm Settings).

• The algorithm has completed successfully, but a gap exists between two or more scans (see Figure 135,
right). Select just these scans in the Workspace panel and run the global-registration algorithm. If the
scans have drawn closer to each other but have failed to align after the algorithm finishes, increase the
number of iterations and rerun the algorithm. Repeat this process until you achieve full alignment, then
run global registration once again for all data. If you are unable to align several problematic scans, try
aligning just two of them, then gradually increase the number of scans until all of them are aligned.
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Figure 135: Global-registration errors: wrong settings on left and gap between scans on right.

9.10 Transferring Transformations

Sometimes it can be useful to transfer transformations from one scan to another (see Use Cases for Transforma-
tions Transferring). The transfer of transformations means that all transformations of scan frames resulting from
the application of different Artec Studio tools are sequentially repeated for all frames of another scan. The
transformations of the source scan as a whole are copied to the destination scan as well, including the global
registration status.

Note: In general, you can transfer transformations from one scan to any other scan. However, of practical
interest are only the cases when the source and destination scans are copies of each other.

To transfer the transformations from one scan to another, perform the following actions:

1. In the Workspace panel, right-click the source scan and choose Copy Transformation from the context menu
(see Figure 136, left). The transformations of the source scan and its frames will be saved.

2. Select one or several destination scans.

3. Right-click the selected scan(s) and from the context menu choose Paste from <source scan name> (see
Figure 136, right).

All saved transformations will be sequentially applied to the selected scans and their frames. After the transfer
is finished, the information about the saved transformations will be erased.

You can use the corresponding buttons of the main window to undo and redo the transfer of transformations
(see History of Project Changes).

9.10. Transferring Transformations 174



Artec Studio, ver. 19

Figure 136: Transferring transformations: copying transformations (left) and pasting them (right)
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9.10.1 Use Cases for Transformations Transferring

Use case 1: Saving time when processing HD scans

Global registration of HD scans is a very time-consuming operation: several times longer than it takes for SD
scans. To save time, you can utilize the following scheme:

1. Make a copy of an HD scan.

2. Treating the scan copy as an SD scan, perform all the required transformations including the global reg-
istration.

3. Transfer the transformations from the copy to the original HD scan.

Use case 2. Saving time when working with backup copies of scans

Global registration takes longer than any other scan and frames transformation. Therefore, replacing the Global
registration with the transformations transfer may save time.

Consider the following scenario:

1. You make backup copies of scans and then only work with the original scans.

2. You remove some excess parts of the scans using Eraser, run Global registration, apply Outlier removal and
finally perform the Fusion operation.

3. After examining the resulting model, you conclude that you removed too much when working with the
Eraser and/or the Outlier removal.

You have to undo all previous operations and once again repeat the sequence of actions, including Global
registration. To avoid the latter and save time, you can instead transfer the transformations from the current
scans to their backups and then continue working with the backups.

9.11 Ray Scan Triangulation

Application offers two ways to convert point cloud surfaces to the commonly used models:

• Fusion operation

• Special triangulation algorithm

The latter approach is preferable to fusion in terms of speed. It generates a polygonal mesh from the original
point cloud by simplifying its structure.

To launch this algorithm, follow the steps:

1. Mark a scan from Artec Ray or Artec Ray II using the flag icon in the Workspace panel.

2. Access Tools → Ray Scan Triangulation from the left toolbar.

3. If necessary, specify the Decimation ratio and set either of the threshold filters.

4. Click Run.
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Mode Simple, Adaptive
(distance-aware)

Adaptive takes into account the distance from the
scanner, whereas Simple removes points with the
fixed step (Decimation ratio)

Decimation ratio 1–10

The larger the value, the more the points will be
culled. 1 leaves the point cloud unchanged. 2
culls half of the points, 4 keeps some 25% of the
total amount of points, 10 about 10%.

Render mesh based on
Distinct colors for
sections, One random
color, Vertex colors

It can color an output model on the basis of Ver-
tex colors or sections constituting the point cloud
scan. The latter yields multicolor model.

Polygon edge length (max), mm Above 0.1 mm Algorithm will remove triangles whose edge
lengths are greater than the specified value.

Polygon angle (min), deg 1–60°

Triangles with angles smaller than specified limit
(in degrees) won’t be created in the resulting
mesh. Extremely large values that are out of the
recommended range may yield no mesh.

Incidence angle (max), deg 0.1–90°
If the angle between the normal to triangle and
the scanner view direction is larger than the spec-
ified one, this triangle is subject to removal.

Incidence angle between vertices
(max), deg 0.1–90°

The algorithm will remove triangles whose edges
form angles (toward the scanner viewpoint)
greater than the specified limit (in degrees).

9.12 Creating Models (Fusion)

Fusion is a process that creates a polygonal 3D model. It effectively melts and solidifies the captured and
processed frames. Fusion is the most interesting part of the processing task because a polygonal 3D model
is what most people expect to see when performing a 3D scan. To this end, you can use one of the following
algorithms, each of which has a self-explanatory name (see also the summary in Table 12):

• Smart fusion perfectly reconstructs fine features and is suitable for both industrial objects and human
bodies. It is compatible with all scanner types. Depending on the Sharpness slider value, Smart fusion can
deliver either smoother or more detailed geometry.

• Fast fusion (legacy) produces quicker results and constructs a noisier geometry at the same time.

Tip: To use the Fast fusion algorithm, open the Settingswindow, select the Enable old fusion algorithms checkbox
under the Legacy section of the General tab, and restart the Artec Studio.
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Figure 137: Models of a human subject obtained using various algorithms: Fast fusion (left), Smart fusion
(smooth, middle) and Smart fusion (sharp, right).

Figure 138: Models of a shoe sole obtained using various algorithms: Fast fusion (left), Smart fusion (smooth,
middle) and Smart fusion (sharp, right).
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Table 12: Comparison of fusion modes.
Smart Fusion (smooth) Smart Fusion (sharp) Fast Fusion (legacy)

Usage
Large, noisy data sets with
patchy missing regions;
scans of moving objects

Scans from Artec Spider;
scans having regions with
fine details and sharp edges

Fast results for large data
sets; also for measurements

Eva resolution no less than 0.5
Spider resolution no less than 0.15
Spider II resolution no less than 0.1
Leo resolution no less than 0.6
Fill holes Available Not applicable

Features

Smoother results. Can
compensate for slight
movements, but not rec-
ommended for accurate
measurements Relatively
slow

Higher level of detail. Faster
than Smooth fusion, but may
intensify existing noise.

Resulting surfaces are rela-
tively noisy.

To obtain a model:

1. Make sure the scans you intend to fuse have passed Global registration.

2. Select the scans in the Workspace panel using the checkboxes.

3. Open the Tools panel.

4. Hover the mouse cursor over the Fusion label in order to activate the controls of the tool and the pop-up
with the default parameters (see Figure 139).

5. Specify the necessary parameter values by clicking the icon (optional).

6. Click Run.

7. View the model in the 3D View window and in theWorkspace panel once the algorithm finishes. The model
name will have Smart fusion followed by the index number.

Figure 139: The Fusion pop-up with the default parameters.

The fusion algorithms use the following parameters:
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• Type: Smart (smooth), Smart (sharp) or Fast (legacy). Formore detai on the fusion types, see the Comparison
of fusion modes.

• Max mesh resolution, mm is the step of the grid (in millimeters) that the algorithm uses to reconstruct
a polygonal model. In other words, this parameter defines the mean distance between two points in a
model. The lower the resolution value, the sharper the shape. When specifying values, keep in mind the
default values, lower limits in Table 12 and Error.

• Sharpness specifies the level of detail in the final fusion and allows to switch from smooth geometry to
higher resolution and sharper detailed geometry within a single tool

• Fill holes instructs the algorithm to fill holes in the mesh being reconstructed; option unavailable for Fast
fusion. The methods for filling the holes are as follows:

– With radius smaller fills all holes with radius less than or equal to the specified value in the Hole
radius (max), mm text box

– By relative radius fills holes with relative radius less than or equal to the specified value in the Rel-
ative hole radius (max), mm text box based on the internal filling holes parameters of the scanner.
Recommended for combined scans of different scanners or for Ray scans.

– Later, manually prompts you to fill holes manually in the Fix holes panel, which opens automatically

– Manually by relative radius prompts you to fill holes manually in the Fix holes panel, which opens
automatically. Recommended for combined scans of different scanners or for Ray scans.

– None fills no holes

– All (watertight) automatically fills all holes in the mesh

• Remove targets allows you to erase small embossments from surfaces on which targets are placed (see
Target-Assisted Scanning). This checkbox is unavailable for Fast fusion.

• Glare-noise reduction allows you to significantly reduce the glare related noise in the models obtained
from the scans made with Artec Micro or Artec Micro II. This checkbox is only available for Artec Micro and
Artec Micro II for the Fusion algorithm.

• Filter frames by error is a setting that automatically excludes all frames with error values above a set
maximum threshold. Turn it on, and then enter the maximum error threshold value in the box that appears
below.

9.12.1 Multi-preset Fusion

Starting from Artec 19, multi-preset fusion allows processing data from multiple scanners to create a single
fusion. Artec Studio provides an interface to set the 3D resolution for each scanner type included in the scanned
data.

The Highest 3D resolution value defines the resolution for the primary scanner in the input field (i.e., the scanner
with the highest resolution among those selected).

To set an each scanners resolution manually, click the gear icon . The resolution of each scanner type from

the selected objects in the Workspace panel can be adjusted manually by clicking the and next to the
respective input fields.

Note: Resolution limit toggle switches for all scanners, except the one with the highest resolution, can be
turned off. When disabled, Artec Studio will ignore the resolution of these scans and process data at the highest
resolution, which may decrease performance.
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Figure 140: Tools panel: parameters of the fusion algorithm.

Figure 141: Multi-preset fusion with the Highest 3D resolution for Artec Spider II.

9.12. Creating Models (Fusion) 181



Artec Studio, ver. 19

Figure 142: Input fields for setting the resolution of each scanner type used.
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9.12.2 Fusion-Algorithm Errors

Occasionally, defects appear in the 3D model after fusion; some are correctable by creating additional scans,
whereas others are correctable by using the model-processing tools described in the next section.

Figure 143: Surface noise caused by insufficient data (left) and improved model after adding one more scan
(right).

Errors that can be corrected by capturing additional scans include low-amplitude noise on the surface (see Figure
143, left). Normally, this error indicates that the affected area has a small number of frames. The number of
frames needed to eliminate the noise depends on the reflective properties of the object’s surface. To correct the
error, you need one more scan to cover the noisy area (see Figure 143, right).

Sometimes the cause of noise is an insufficient number of scanning angles. Areas captured at a larger angle
have more noise than areas captured at a direct angle (i.e., 90 degrees). You can correct this error by scanning
the area again using a better angle.

When the scanning conditions or the object features are such that you are unable to capture additional data,
you can correct errors using the Fix holes (see Fixing Holes) or Smoothing (Smoothing (Tools)) tools. If such errors
are frequent, reduce the speed at which you move the scanner around the object, or increase the capture rate
(see Decreasing Scanning Speed).

9.13 Editing Models

The resulting fusion model may contain surface defects due to scanning or registration errors. Artec Studio
provides a number of tools to correct such errors:

• Repair corrects the model’s triangulation errors.

• Small-object filter removes small objects located near the model surface.

• Fix holes semiautomatically fills holes and smooths the model edges.

• Hole filling fills holes in the model automatically

• Smoothing filters low-amplitude noise over the whole model

• Smoothing brush enables manual smoothing of the surface areas with the most noise

• Mesh simplification reduces the number of polygons in a model while minimizing lost accuracy
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• Isotropic remesh creates isotropic mesh while keeping the processed mesh as close to the original as
possible

Each algorithm processes all scans selected in the Workspace panel and replaces the original data with the

results. If the algorithm is unsuccessful, you can restore the original data by clicking (Undo) in theWorkspace
panel.

See also:

Boolean operations.

9.13.1 Mesh Optimization (Tools)

In Artec Studio 18, several tools, including the Small-object filter, Hole filling, and Mesh simplification, have been
combined into a single tool called Mesh optimization. Using all of them at the same time is optional, but it can
proide you with better output when running the algorithm.

To start working with Mesh Optimization tool, select only the model you are currently editing in the Workspace
panel, open Tools→Mesh Optimization. Once you set up all parameters that you need, click the Run button either
on the pop-up of the Mesh Optimization tool or next to its name on the Tools panel to run Mesh Optimization
algorithm.

9.13.2 Small-Object Filter (Tools, Mesh Optimization)

Small-object filter is a part of the Mesh Optimization tool which can help you erase outliers before fusion (see
Eliminating 3D Noise (Outlier Removal)), Artec Studio may solidify and preserve them in the scene as small, distant
fragments.

You can effectively remove these remaining outliers by using a filtering algorithm.

To remove these artifacts, make sure that Remove Small Objects checkbox is selected (see Figure 144). Addition-
ally, you can adjust the following parameters:

• Remove surfaces

– All except largest instructs the algorithm to erase all objects except the one with the most polygons

– Smaller than specified erases from the scene all objects whose number of polygons is less than the
amount specified in the Polygon count (max) parameter.

9.13.3 Hole Filling

Sometimes the shape of an object or the scanning conditions prevent you from properly capturing of all parts
of the scene. As a result, the fused 3D model will have holes. In such instances, you can use either of the
hole-filling tools to interpolate the surface.

• Bridges or Smart Hole Filling

• Automatic Hole Filling (Tools, Mesh Optimization)
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Figure 144: Filtering of small objects: before (left) and after (right).

9.13.3.1 Bridges or Smart Hole Filling

The Bridges tab is intended to connect a pair of the edge fragments by constructing a surface that follows the
curvature of the neighboring surfaces.

To create a bridge, follow the procedure:

1. Open Fix holes → Bridges. All holes will outline in red.

2. Specify two opposite fragments1 between which a bridge will go (Figure 146). There are two ways to do
this:

Quick method Ctrl-key method
Perform the steps below for each fragment: Click once anywhere in the 3D View to acti-

vate this method and then perform the steps
below for each fragment:

a. Point the cursor at the edge. A part
of this edge will be automatically high-
lighted indicating a future fragment.

b. Drag the cursor along the edge to find
the desired fragment location.

c. Click LMB to confirm the fragment.

a. Press and hold Ctrl and then point the
cursor at the edge.

b. Press and hold Ctrl+LMB to specify a
fragment beginning.

c. Still holding Ctrl+LMB, drag the cursor
to specify the entire fragment.

d. Release Ctrl+LMB to confirm the frag-
ment.

3. Once you’ve confirmed the second fragment, a bridge preview will appear.

4. Drag the square sizing handles to adjust the bridge width and position as necessary.

5. Adjust bridge curvature on both sides and Bridge smoothness as necessary.
1 Normally a bridge goes between two opposite fragments of one hole. In complex cases, you may use fragments on different holes or

edges.
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6. Click Build bridge to confirm your bridge.

Figure 145: From left to right: original surfaces, bridge preview, actual bridge.

Figure 146: Specifying fragments. Correct fragments can resolve original geometry.

The table below lists the possible actions matched with the options and commands for this tool.

Prepare edges by removing raggedness Select the Smooth edges first checkbox
Preserve the original geometry (Figure
146)

Clear the Smooth edges first checkbox

Smooth bridge surface Use the Bridge smoothness slider
Edit bridge-preview position Drag the square controls around the corners of the bridge pre-

view
Adjust bridge tension Use interactive sliders Curvature (start, end)
Delete bridge preview Click Clear preview or Delete key
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Smoothing or Keeping Edges

Smoothing edges might not always be beneficial to you. If the bridge failed to recreate the original geometry,
try one or several actions from the following list:

• Clear the Smooth edges first checkbox.

• Use small or medium values of the Bridge smoothness slider (Figure 147).

• Select fragments correctly.

Figure 147: Small smoothness values on left and maximum on right.

9.13.3.2 Automatic Hole Filling (Tools, Mesh Optimization)

To quickly and automatically fill holes, make sure that Heal bad polygons checkbox of the Mesh Optimization
pop-up is selected. The algorithm processes the following polygon types which can be selected by clicking the

icon next to the Heal bad polygons checkbox:

• Non-manifold

• Dangling

• Crossing

• Folded with angle (The angle can be specified in the angle field)
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Figure 148: Hole-filling algorithm: original model on left, processed on right.

9.13.4 Mesh Simplification (Tools, Mesh Optimization)

The mesh produced after fusion may be less than optimal for some applications because it will contain a large
number of polygons. This complexity will increase the amount of memory the model occupies, hindering further
processing. To optimize the model size while retaining accuracy, toggle the Mesh simplification switch in the
Mesh Optimization tool.

Figure 149: Mesh simplification: original mesh on the left, optimized mesh on the right.

Regular mesh simplifcation type allows to select the Target when simplifying option:

• Shape deviation optimizes model to a predetermined accuracy: the Maximum shape deviation, mm parame-
ter defines the optimized model’s maximum allowable deviation (in millimeters) from the original model.
When the algorithm reaches this value, the optimization stops.

• Remove small polygons performs simple mesh optimization, removing triangles whose edge lengths are
less than the Polygon edge length (max), mm value (in millimeters).

• Polygon count simplifies the model by targeting the number of triangles specified in the Polygon count
text box. The algorithm minimizes the resulting model’s deviation from the original model, but the final
deviation value will remain unknown until processing concludes. Use this method when you know how
many triangles the resulting model should have.

Tip: To determine the number of triangles, reveal the Properties panel for the appropriate
model in the Workspace panel.

• Keep texture is similar to the Polygon count algorithm, but intended for meshes with textures mapped by
the Atlas method (see Applying Texture (Procedure)). This approach not only simplifies the polygon grid,
reducing the number of triangles, but it preserves texture.

Tip: Since the UV methods tend to slightly reduce texture resolution, we recommend using either of them only
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when no raw scans are available. It is generally better to simplify models using one of the regular method and
then reapply texture.

The three first algorithms in the list above have the additional parameter:

Keep edges maintains the model boundary. Mesh simplification on the scan edges may affect their geome-
try. Thus, if the shape of the boundaries is more important than the optimized mesh, select this checkbox.
Otherwise, clear it, and the algorithm will simplify the boundary mesh.

Figure 150: Boundary-appearance options: Keep edges enabled (left) and disabled (right).

Note: Mesh simplification may take a long time when the parameters of the original and optimized models
are significantly different (for example, if the deviation value is high in Shape deviation mode or if the required
number of polygons in Polygon count mode is much smaller than the number in the original model). For very
large 3D models the operation requires extensive memory resources and may fail owing to insufficient RAM.
Free the memory by closing unused applications and by optimizing memory usage in Artec Studio, keeping in
mind the recommendations in Memory Management: Smart RAM Usage and History of Project Changes.

The Fast mesh simplification algorithm works faster than the regular one.

• Simplification ratio option allows to select the percentage of polygons to keep in the simplified mesh.

• Target polygon count determines the number of triangles for the resulting model, depending on the value
of Simplification ratio. You can find out how many are in the actual model by double-clicking it in the
Workspace window.

• Nonstrict polygon count option:

– If this checkbox is cleared, the value specified in the Polygon count text box remains constant.

– If this checkbox is selected and the algorithm is unable to produce a surface with the specified
number of triangles (Polygon count), Artec Studio will automatically update this value. In other
words, improving the quality of the resulting surface is the primary objective.

• Keep edges maintains the model boundary. Mesh simplification on the scan edges may affect their geom-
etry. Thus, if the shape of the edges is more important than the optimized mesh, select this checkbox.
Otherwise, clear it, and the algorithm will simplify the boundary mesh.

• Keep texture boundary preserves all vertices on the boundaries of texture patches, causing them to be
ignored by the algorithm. Consequently, there is no need to perform texturing again.

After adjusting the algorithm settings, click Run to start processing.
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9.13.5 Defeature Brush (Editor)

Erasing certain geometrical imperfections often demands further processing of the resulting holes in the model.
The Defeature brush combines functions of the Eraser and Hole filling tools and may boost your productivity. To
use it, follow these steps:

Warning: If you edit a textured model, note the following. Since the texture will incorrectly fit the altered
surface, the Defeature brush will remove it from the model. So you will need to repeat texturing after you
finish editing.

Figure 151: Defeature brush: imperfection on the scanned surface (left), results of applying the tool (right).

1. Select one model in the Workspace panel.

2. Open the Editor panel using the side toolbar and click either Defeature brush or hit D.

3. In the Editor panel, choose the required selection type.

4. Consult the instructions for each mode and select regions on the model that you want to modify. To clear
all selections, click Deselect.

5. Click Apply. The software will delete the feature, close up the hole and smooth the surface.

To undo changes, click in the Workspace panel or menu Edit, or hit Ctrl+Z. Each click of the Apply button

generates a command history entry. To undo several operations, use the dropdown menu of button and
select the lowest entry.
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9.13.5.1 Selection Types

Type Illustration Usage

2D Hold down Ctrl and use Scroll wheel to adjust the tool
size. Paint with Ctrl+LMB to create a selection.

3D See above.

Rectangular Use Ctrl+LMB to select a rectangular region.

Lasso
Use Ctrl+LMB to freely outline an irregular region. You can
release LMB (not Ctrl) and then continue clicking on desired
points to select a desired shape.

Cutoff-plane

Create selection as in 2D mode. Once you have released the
mouse button, a plane will appear. If necessary, adjust the
plane level by using Scroll wheel while holding down
Ctrl+Shift or orient the plane freely in 3D space. To this
end, hit Alt to display the designated control. Then still hold-
ing the key, drag the required control ring. Note that it doesn’t
work with raw point clouds from Artec Point.

If you need to deselect any region, hold Ctrl+Alt and reselect this region. To clear all selections, clickDeselect.

If the Select through checkbox is selected, all surfaces throughout the model are affected. If not, the brush only
works on the visible surface.

See also:

Hot keys in Editor.
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Figure 152: Applying Cutoff-plane selection in Defeature brush.

9.13.6 Smoothing

9.13.6.1 Smoothing (Tools)

The smoothing algorithm evens out noisy areas in the 3D model. Artec Studio provides two such tools: au-
tomatic smoothing of the entire model and manual smoothing of specific areas identified using a brush (see
Smoothing Brush (Editor)).

To run the automatic smoothing algorithm, open the Tools panel and select Smoothing. You need only set the
Steps parameter (the number of algorithm iterations to be performed).

9.13.6.2 Smoothing Brush (Editor)

The Smoothing brush is a tool that you can employ selectively in specific areas without touching areas that
require no alteration (for more information about automatic smoothing, consult Smoothing (Tools)).

To use the Smoothing brush,

1. Select just one model.

2. Open the Editor panel, and click the icon or hit S.

3. Hit Ctrl, an orange region will appear around the cursor in the 3D View window.

4. Change brush size if necessary:

• Use either the Ctrl+[ and Ctrl+] shortcuts or

• Use Scroll wheel.

• Enter a size (in millimeters) in the Brush size field.

• Alternatively, you can adjust the slider bar in the Smoothing brush panel.

5. Set the smoothing strength if necessary:

• Enter the desired value in the Smoothing strength field or

• Adjust the slider bar.

6. Hold LMB and paint the surface region in order to smooth it. The tool will smooth the affected areas (see
Figure 153, right).
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To undo changes, click in the Workspace panel or hit Ctrl+Z as many times as needed to return to the
original state of the model since each brush stroke generates a command history entry.

Figure 153: Before smoothing (left) and smoothing out a poorly captured area (right).

9.13.6.3 Smoothing Edges

The Edges tab allows you to smooth ragged edges of the model.

To smooth an edge or any part of it, follow the steps:

1. Open Fix holes → Edges. It will show the list of edges detected on the surface. These defects are sorted
by their full length.

• Mark the checkbox next to the edge in the list to select a whole edge2.

• In 3D View window, hold down LMB and drag the square control to specify a part of the edge.

• Use the Select all button to select all edges.

2. Artec Studio will highlight these edges in red and draw yellow curves alongside them depicting smoothed
boundaries.

3. Use the Strength slider to control the edge-smoothing intensity as necessary.

4. Click Smooth edges.

5. Click Apply to confirm the results. If the results aren’t satisfactory, use the button to cancel recent
changes.

9.13.6.4 Fixing Holes

The Holes tab provides Flat and Smooth hole filling options for respective surfaces.

1. Open Fix holes from the side panel.

2. Select the Holes tab. It will show the list of holes detected on the surface. These defects are sorted by
their perimeter length.

3. Select a hole either in 3D View window or mark the checkbox next to it in the list. Artec Studio will
highlight these holes in red (see Figure 156).

Note: If the Move camera to selection option is checked, the model will automatically rotate to
display the selected hole.

2 If the Move camera to selection option is checked, the model will automatically rotate to display the selected hole.
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Figure 154: Boundary selection for edge smoothing

Figure 155: Edge-smoothing algorithm results.
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Hint: Use the Select all and Deselect all buttons in the panel to select or clear all selections,
respectively.

4. Select a suitable filling mode. If you are filling a hole on a flat surface of the mesh, go for the Flat mode,
and go for the Smooth mode to fill tricky holes in the curved parts of the mesh.

5. Click Fill holes to repair your model.

6. Click Apply to confirm the results. If the results aren’t satisfactory, use the button to cancel recent
changes.

Figure 156: One hole on a curved surface, marked for correction.

Figure 157: Result from running the Fill holes algorithm using the Smooth mode.

If you try to exit the Fix holes mode without accepting changes, the software will ask you for confirmation.
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9.14 Photo Registration

The photo registration algorithm in Artec Studio enables you to apply textures to models using photographs.
Photos of the object can be used to project textures onto fused models. This advanced texturing approach can
be used to capture complex textures and significantly enhance models.

9.14.1 Preparing Object

To obtain best texturing results, it is important to follow the below given tips before scanning and taking
photographs.

1. Before taking photos, make sure the object has prominent texture features.

2. For large objects with monochromatic surfaces, add additional features in the background to highlight
the texture. However, if you will have to rotate the object, it is better to use a plain background.

3. Provide adequate and uniform lighting. It is recommended to use external studio lighting for cameras
with low light-sensitivity. Do not use the flash.

4. In the case when exposure is too big to hold the camera in hands, it will help to use a tripod.

5. Make sure the object remains stationary during scanning and taking photos. If you need to turn or move
the object to scan all sides, it is recommended to take photos immediately after scanning in one position,
before moving the object to scan in another position.

9.14.2 Capturing Photos

The photos for registration can be captured using any SLR camera or a smartphone with a good camera. For
optimal results, it is important to capture good quality photos that are sharp and bright, and not noisy and
blurred. Here are some best practices for capturing good quality photos for texturing.

1. Capture photos from a proper and fixed distance. The object must be at the center of the photo and occupy
the most space, with minimal background details.

2. Adjust and fix the focal length, exposure and aperture.

Note: A best practice is to capture all photos with the same settings.

1. Capture subsequent photos of the object with at least 66% or 2/3 overlap while moving the camera. Take
a series of photos, much like the texture frames captured by Artec scanners.

2. Photograph each element of the object at least 3 times.

3. Avoid taking photos of any additional objects that can disturb the texture of the object you’re scanning,
like a pedestal the object is placed on.

4. It is recommended to convert all photos to .jpeg format and preserve their EXIF information.

Color corrections or white-balance corrections can be applied to photos for post-processing, but it is advisable to
process all the photos in the same manner. Avoid geometrical transformations, resizing, distortion corrections,
or color-space transformations.
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9.14.3 Importing Photos

1. After all the necessary photos have been captured, save them to a folder in your system.

2. Obtain the 3D model of the object using the standard procedures until fusion.

3. Import all the necessary photos, using the File → Import → Import photos menu option.

Note: Starting from version 17, you can import pictures from several different cameras or the same camera but
with different exposition settings.

Artec Studio will automatically sort the imported pictures by focal length, camera type and resolution and place
them into separate sets of photos. These sets will appear in the Workspace panel and in the 3D View window.
Pictures with random parameters will be placed to the Unusable set of photos.

Figure 158: An imported set of photos in the Workspace panel and in the 3D View window.

Before registering the imported photos, you can inspect their quality.
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9.14.4 Inspecting Quality Of Photos

In Artec Studio 17, it is now possible to assess each captured photo for adequacy of texture capturing or mis-
alignments before completing photo registration. To inspect the quality of the imported pictures, follow these
steps:

1. In the Workspace panel, double-click a set of photos. The entire list of pictures it contains will appear.

• For each picture, its name and the error registration value will be provided.

• Pictures that failed to register will be highlighted in red.

• To locate the picture in the 3D View window, select it in the list. You can also use the arrow
keys to navigate from one picture to another.

Note: By default, all objects in the 3D View window except the pictures of the selected set will
be hidden. To see other objects, select the Show other selected objects option.

2. Double-click an individual picture to inspect it closer. It will be opened in a superimposition viewing
mode:

• To compare the model’s texture with a reference picture or check for misalignments, use the Show
photo toggle or press Ctrl+Q. The 3D model will appear in the 3D View window.

• To zoom in and out, use Scroll wheel.

• To move the picture, hover over it and drag it holding down Scroll wheel.

• To exit the viewing mode, press either LMB or RMB and drag in any direction.

Figure 159: Inspecting the quality: a—the Show photo toggle is on, b—the Show photo toggle is off.

3. To delete a picture from the set of photos, click it in the Workspace panel by RMB and select Delete from
the context menu. You can also press Delete on the keyboard.
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9.14.5 Registering Photos

To register photos for use in further texturing of the model, follow these steps:

1. In the Workspace panel, select all the scans of the model, the fusion and the desired sets of photos (all
three items).

2. Open Tools → Registration.

3. Select Photo as the registration type in the Registration pop-up.

Note: Artec Studio automatically sorts the imported photos, and groups them into sets based
on their settings (focal length, resolution, camera type, orientation etc.). Inapplicable photos
are removed into a separate photo set.

4. Set the photo registration parameters as necessary. See Photo-Registration Parameters.

5. Click Run.

Once the photos are registered, follow the Texturing procedure and apply the texture to the model.

9.14.6 Photo-Registration Parameters

Image pre-processing On/Off
Enable it to apply contrast to scanner images. For Eva,
Leo, or Spider (if the object was captured from large dis-
tances and the textures are dark).

Use model in registration On/Off Enable it to perform registration not only on photos but
also on geometric data.

Feature sensitivity High/Low
Select the level of sensitivity small and repeated texture
patterns on the object. The higher the sensitivity, the
better quality of the algorithm.

9.15 Texturing

Artec scanners are equipped with a color camera, allowing you to capture 3D surfaces with texture and expand-
ing the range of objects available for scanning. Texturing is a process that projects textures from the individual
frames onto the fused mesh.

9.15.1 Preparing Model

To take advantage of texture, do the following:

1. Make sure the Don’t record texture checkbox is cleared.

2. Adjust the capture frequency for texture frames if necessary (see Texture-Recording Mode or Frequency for
Capturing Texture Frames).

3. Avoid turning off the flash bulb.

4. Adjust the texture brightness in Preview mode by using the eponymous slider in the Scan panel.

5. Scan the object using a tracking algorithm of your choice. Captured frames are marked with the checker-
board icon in the Workspace panel (surface-view mode) (see Figure 70, right).
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6. Process the data and create amodel, consulting the list in the beginning ofData Processing or Use Autopilot.

7. Run a mesh-simplification algorithm for the resulting model (see Mesh Simplification (Tools, Mesh Opti-
mization)) to accelerate the texturing process.

8. Use the Texture panel to apply the texture to the model.

9.15.2 Applying Texture (Procedure)

The 3D model obtained after fusion contains no texture information. To apply textures onto a model, do the
following:

1. Open the Texture panel.

2. Choose a model from the first list (see Figure 160); Artec Studio will apply the textures to this model.

3. From the second list, select the scans from which you created the model (these scans have the required
textures3) or the photos you registered using photo registration.

4. Next, choose a method for applying textures to the model. Artec Studio offers two methods:

• Preview (triangle map)

• Export (texture atlas)

5. Select the required Output texture size4 and other options as necessary (Supplementary Settings).

6. Click Apply to start the texturing process5.

7. Finally, when the texture is ready, adjust it as necessary.

To reduce or increase the resolution (Output texture size) of the already applied texture, you can re-apply it
several times faster by enabling the Export (reuse UV map) option.

To replicate texture from a textured model instead of raw scans, use the Export (transfer from model). Ensure
that you’ve selected this model in the Select texture source field. Using texture from a textured model might be
useful in the following cases:

• Original scans are lost.

• Intention to replicate texture altered using Texture healing brush.

• Speed up texturing identical models or models undergone Defeature brush operations.

Warning: We recommend that you avoid applying texture to models that have undergone major changes
in geometry or orientation. The algorithm will apply the texture incorrectly if you have done any of the
following:

• Position or transform the model relative to its source scans

• Nonrigid Alignment

• Erase major parts of the model

Perform these operations only after texturing.

3 Note that those texture frames from Leo scans that appear blackish when previewing them in the 3D View window will not be used
for texturing the model (see Specifics of displaying the textures of Leo scans for details).

4 Texturing with the 16K resolution (16384x16384) is only available if your graphics card features at least 3 GB of GPU memory.
5 To optimize resource utilization, Artec Studio unloads all surfaces from memory, except those needed for texturing, before running the

applying procedure. For a more detailed description of selective project-data loading, see Memory Management: Smart RAM Usage.
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Figure 160: Choosing a texture-application method and adjusting its parameters.
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9.15.3 Modes

Table 13: Comparison of the texture-applying methods.

Mode Texture Distortion Speed Number of Tex-
tures

Texture-Resolution Manage-
ment

For preview
Does not preserve
aspect ratio of trian-
gles

Fast One or more Adjust triangle size and
texture-image resolution

For export Preserves aspect ra-
tio of triangles Slow Only one Adjust texture-image resolu-

tion

9.15.3.1 Texturing for Preview (Triangle Map)

The Preview method transfers all textured triangles to a square texture image (or a series of images). You can
adjust the Triangle size (in pixels)6 using the eponymous slider (see Figure 161, right). To select the resulting
texture size, use the dropdown list (maximum texture size depends on the capabilities of your graphics card).
After changing the triangle/texture size, the estimated number of textures will appear in the Estimated area at
the bottom of the panel; the actual number may differ slightly, however.

9.15.3.2 Texturing for Export (Texture Atlas)

The Export method cuts the surface into pieces, then unfolds and nests these pieces flat and fits them into
the specified image size (see Figure 161 (middle) and Figure 98 in Displaying Boundaries of Texture Atlas). This
method takes longer to run than Preview, but the resulting texture is much more convenient for manual editing.

Figure 161: Texture mapping methods: mesh with texture applied (left), texture-atlas sample (middle) and
triangle-map sample (right). The latter covers only a portion of the mesh surface (the rest two images not
shown).

6 Triangle size is determined by the number of pixels per side.
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9.15.4 Supplementary Settings

To modify a texture using an inpainting technique, use one of these two options:

9.15.4.1 Missing Texture Inpainting

This option allows you to apply a texture to regions with no texture information by spreading it from the
neighboring regions.

9.15.4.2 Targets Removal

Targets removal is similar to inpainting. It paints out targets by applying surrounding texture information (targets
are used to facilitate scanning—see Target-Assisted Scanning). This option makes sense if you enabled Targets
removal before producing this fusion model (see Creating Models (Fusion)).

9.15.4.3 AI Texture Enhancement

This option allows you to apply HD texture image for further texturing.

9.15.4.4 Glare Reduction

Glare reduction is intended to eliminate glare spots on texture. This option is only available for Texturing for
Export (Texture Atlas) and requires many texture frames captured from different perspectives.

1. Check whether the source scans include sufficient number of frames (especially texture frames). If nec-
essary, increase texture-frame rate and rescan.

2. Select the Glare reduction checkbox.

3. Adjust the Reduction level slider as necessary. Avoid extreme values.

Hint: Glare reduction is a time consuming algorithm. If you plan to obtain a high-resolution texture, we advise
you to first tweak the settings on low values (for example, 512 x 512) and then reapply texture with the required
Output texture size.

9.15.4.5 Background Colors Suppression

Object’s surfaces may inherit texture information from the surroundings. To diminish this impact, use the Back-
ground colors suppression option. This option is only available for Texturing for Export (Texture Atlas), requires the
enabled Glare reduction option and a sufficient number of texture frames captured from different perspectives.

1. Ensure the Glare reduction checkbox is selected.

2. Select the Background colors suppression checkbox.

3. Adjust the Reduction level slider as necessary. Avoid extreme values.
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Figure 162: Diminishing background color impact.

9.15.5 Texture Adjustment

After the texturing is complete, you can adjust the texture on the model (see Figure 164).

You can adjust the following texture parameters by way of the corresponding sliders (see Figure 163 for details):

• Brightness

• Saturation

• Hue

• Contrast

• Gamma correction

The initial position of theHue slider corresponds to the current texture color. Dragging it left or right corresponds
to rotation counterclockwise or clockwise, respectively, on the color wheel.

After making the necessary changes, click Apply to transfer the resulting textured model to theWorkspace panel.

To reopen the texture-adjustment dialog, follow the steps:

1. Select a textured model in Workspace.

2. Use RMB to call the context menu.

3. Select the Adjust texture command from the list.
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Figure 163: Hue, saturation and brightness representation.

Figure 164: Texture adjustments.
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9.16 Texture-Healing Brush: Manual Inpainting

You can manually inpaint missing textures by using the Texture-healing brush. This tool is based on the same
algorithm as the Missing texture inpainting option covered in Applying Texture (Procedure). The inpainting al-
gorithm uses texture information from neighboring regions to fill in areas with missing or incorrect texture.
Left image in Figure 165 shows a small texture imperfection: a felt-tip pen mark on the figurine. Results of
inpainting this region appear in Figure 165 (right).

Figure 165: Texture-healing brush: before application (left) and after (right).

To launch the tool and inpaint a texture, do the following:

Hint: We advise you to first back up your model by selecting the Duplicate scans command from its context
menu since the undo function is unavailable in this tool.

1. Mark the model textured for Export with the flag.

Important: This version of Artec Studio does not support texture restoration on the models
‘textured for Preview’ (triangle map) and in regions of any models that have been corrected
using the Defeature brush.

2. Open the Editor panel by clicking its icon in the side toolbar.

3. Select the Texture-healing brush.

4. Hold down Ctrlwhile using Scroll wheel or [ and ] keys to adjust the tool size. It should not exceed
the size of the region that needs texture correction.

5. Paint over the region of interest using LMB while holding down Ctrl so that the tool (a circle or a spot)
only rolls over the problem area. Try to avoid touching neighboring areas. Use the Deselect button to
clear all the selections.

6. Repeat the previous step as necessary.

7. Click Apply to accept the changes or close the panel to reject them.
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Note: If you paint an area in which the number of polygons exceeds the value specified in the settings dialog
(see Warnings), a message will appear prompting you to either ignore the value, which means that processing
may take longer, or cancel the operation.

9.17 Preparing Models To Export

9.17.1 Moving, Rotating and Scaling (Transformation Tool)

The Transformation tool allows you to move, rotate, scale and mirror objects relative to the global coordinate-
system axes.

To access this tool, open the Editor panel and select Transformation tool or hit T. The panel will open, displaying
four tabs that correspond to different modes for altering the object position in the global coordinate system.
The name of the active mode appears at the bottom of the 3D View window.

To revert your changes inside the tool, use the Reset button. Artec Studio applies changes when you leave the

tool. Use the (Undo) button in the Workspace panel or hit Ctrl+Z to reset changes after you close the tool.

Hint: To quickly move objects to the origin and align them with the camera viewport, use the Auto-position
button.

Note: The Transformation tool does not affect objects with the Lock object status ( ). See Locking Object’s
Position for details.

9.17.1.1 Translate

To enter translation mode, click the Translate tab or hit T. Three input fields will appear in the Editor panel
showing the current origin coordinates (in millimeters) of the local coordinate system. The initial position of
the local coordinate system will be in the center of the global one. To translate an object, do either of the
following:

• Enter the new coordinate values for the local system using the input fields in the Editor panel. To adjust
the position only along a specific axis, first hit the corresponding X, Y or Z key.

• Translate the object in the 3D View window by dragging the corresponding control (see Figure 166):

– Square in the center to move it freely

– Arrow to move it along a specific axis

– Lines between arrows to move it along the two axes simultaneously

Note: Orienting the object may be easier if you first specify a new position for the origin of the local coordinate
system: double-click on the desired surface point in the 3D View window.
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Figure 166: Translation control

9.17.1.2 Rotate

To enter rotation mode, click the Rotate tab or hit R. Three input fields containing the Euler-angle values will
appear in the Editor panel. Initially, all values are set to zero. To rotate the object, do either of the following:

• Enter the new angle values (in degrees) using the input fields in the Editor panel.

• Drag one of the three circles (see Figure 167) to rotate the object. Hitting the key that corresponds the
required axis (X, Y or Z) will hide the controls for the other axes.

Note: Orienting the object may be easier if you first specify a new position for the center of the local coordinate
system: double-click on the desired surface point in the 3D View window.

Figure 167: Rotation control

9.17.1.3 Scale

To enter scaling mode, click the Scale tab or hit S. A single input field with the current scale value (1.000) will
appear in the Editor panel. You have two options for scaling the object:

• Enter the new scale value in the field.

• Drag the origin of the control (Figure 168) or either of its round ends in the 3D View window.
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Figure 168: Scaling control

9.17.2 Placing Objects on Coordinate Plane (Positioning Tool)

You may need to place the model on one of the coordinate planes (e.g., for aesthetic reasons or when prepar-
ing the model for measurements, for capturing a screenshot, for exporting and so on). Instead of adjusting
the model position using the Rotate and Translate modes of the Transformation tool, you can use the special
Positioning tool. To do so, follow these steps below.

1. Open the Editor panel from the side toolbar and click either Rough positioning button or hit P.

2. Choose the Rough tab—a rough positioning is available for all the object types, whereas the Precise option
works only with CAD objects.

See also:

Setting constraints for CAD primitives

3. Ensure that the coordinate axis grid is shown. Otherwise hit G or select the Grid command from the Scene
settings.

4. Choose the coordinate plane in which you want to place the model by activating one of the following
options: XOY, YOZ or ZOX. Note that you may skip this step and return to it after Step 3.

5. Use LMB to specify at least three points on the surface; the plane will automatically pass through their
center of mass (see Figure 169). The following conditions will then apply:

1. For each additional point you specify, Artec Studio rebuilds the plane. Click Clear points at any time
to redefine the points.

Note: Three points determine a plane. When you’re dealing with nonplanar surfaces, how-
ever, three points may be insufficient. In that case, the more points you specify, the more
precisely a plane will fit the surface.

2. In addition to the plane passing through the center of mass of the points you select, the coordinate
origin will shift to that location as well.

3. The position of the coordinate origin is adjustable, as described below.

6. Invert the direction of the coordinate axis, if desired, by clicking the Invert Z button for the XOY plane,
Invert X for YOZ, or Invert Y for ZOX.

7. If appropriate, adjust the model’s position relative to the coordinate origin:

1. Shift + LMB—rotate the model around the axis that is currently normal to the plane

2. Shift + RMB—move the model along the plane in a fixed direction
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Figure 169: Positioning the model in the global coordinate system.
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3. Shift + LMB + RMB—move freely along the plane

8. Hit Apply to fix the model on a specified plane or close the panel to cancel positioning.

To discard changes of object position, hit Ctrl+Z.

Tip: The Enable automatic base removal option may come in useful to position scans automatically after the
scanning completes (see Base Removal: Erasing a Supporting Surface.)

Note: The Positioning tool does not affect objects with the Locked object status ( ). See Locking Object’s
Position for details.

9.18 Advanced Techniques

9.18.1 Automatic Processing

See also:

Use Autopilot

Automatic processing is a special mode for the Tools panel that saves time and simplifies postprocessing. It
allows you to run all postprocessing algorithms available in the Tools panel, such as Registration (Global, Rough
serial, Fine, Photo); Outlier removal; Fusion or Fast fusion (legacy); Mesh optimization (Small-object filter or Hole
filling) and Smoothing, with just a single button click.

Each algorithm setting and parameter is based on the values can be set and adjusted in the Auto mode. To
change these values:

1. Toggle the Auto mode switch on.

2. Select a specific scanner type via the Preset dropdown list.

3. Using Add tool, add the new algorithm from the list to the auto mode.

4. Click the icon to open a paramaters pop-up of the added algorithms.

5. Make the necessary alterations and close the parameters pop-up.

6. Repeat the previous steps for the required algorithms.

7. Click Run button to begin automatic processing.

Changing the scanner preset type resets all the parameters to the default ones (for the selected preset).

Keep in mind that the algorithms run in the order in which they are listed, starting with Registration and ending
with Normal inversion. Thus, if you want to run the Smoothing before Mesh optimization, for instance, you must
do so manually.

Unlike manual processing, automatic processing runs without the need for constant user attention, so it is
more convenient when processing large objects: you can configure the settings, start the process and leave it
unattended. It can also process objects of any size, reducing the number of mouse clicks to get the result.
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Figure 170: Manual adjustment for the specific scanner type.
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9.18.2 Mirroring

Artec Studio allows to mirror the 3D data. The application uses the local rotation center as a mirroring center
(see Global Coordinate System and Rotation Center). If it isn’t specified, Artec Studio employs the global coordinate
center.

To mirror the model, follow the steps:

1. Open Editor

2. Access Transformation tool

3. Select the Mirror tab

4. If necessary, double click the model to specify a rotation center

5. Select an axis to mirror the object along. Press the respective button—for example, Along axis Y.

Figure 171: Mirroring in action.

To revert your changes, use the Reset button. For details, consult Moving, Rotating and Scaling (Transformation
Tool).

9.18.3 Isotropic Remesh

Isotropic remesh is an operation that modifies 3D model in the way that new mesh triangles have uniform size.
Software packages where themodels from Artec Studio are intended to be usedmay impose these requirements.

The algorithm produces an isotropic mesh, but doesn’t necessarily decrease the polygon count. However, the
output file is often smaller than the original one through the uniform triangles.

To produce a uniform mesh,

1. Mark the model using the flag
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Figure 172: Isotropic remesh operation in action: original model on left, processed one on right.

2. Open Tools → Isotropic remesh

3. Specify the 3D resolution, mm value if necessary

4. Click Run button.

9.18.4 Normal Inversion

Normal direction determines the visibility of a surface in 3D graphics. Learn how to show normals of the objects
in Artec Studio 3D View, see Representation of Normals and Boundaries.

Normal inversion allows one to turn the model inside out. This operation may be useful when you need to
manufacture some mating parts, like molds; or obtain a model based on its cast (e.g., turn the footprint cast
into a shoe last, see Figure 173).

Figure 173: Normal inversion application: obtaining a foot model (right) from its cast (left).
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To invert normals on a particular model,

1. Mark the model using the flag

2. Open Tools → Normal inversion

3. Click Run button.

9.18.5 Correcting Triangulation Errors

Some algorithms may introduce triangulation errors into the resulting model. These errors include the follow-
ing:

• Unattached vertices. Points that are not vertices of any of the triangles

• Vertices with identical coordinates. Vertices that have the same coordinates

• Faces containing invalid vertices. Triangles that point to nonexistent vertices

• Singular faces. Triangles for which at least two of the three vertices coincide.

• Faces with equal signature. Faces with fully coinciding sets of vertices

• Edges incident to three or more faces. Edges that are adjacent to three or more faces

• Faces with wrong orientation. Faces whose normals point in a direction opposite to those of the adjoining
faces

To correct these errors, mark a model in the Workspace panel by using the flag and hit Ctrl+R or select
the Window → Repair menu command. If the algorithm detects no triangulation errors, Artec Studio will notify
you that it has found no defects. Otherwise, the Repair panel will open, displaying the above-mentioned list of
defects to be corrected. Next to the names of the defects, a column will appear stating the number of defects
of a certain type found in the model. You can select all defects by pressing View all. Doing so will display in the
model all the defective vertices and triangles using colored points. You can disable display of any particular

defect type by removing the icon next to the corresponding name, or disable them all by clicking View none.
To correct the defects, click Repair all. Clicking the Apply button accepts the changes.
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WORKING WITH CAD OBJECTS

Starting from version 15, you can work with CAD objects in Artec Studio. You can either create CAD primitives
and then export them into CAD files or import CAD objects designed in external applications. This allows you
to:

• Modify and design new parts for existing objects;

• Reverse engineer scanned objects;

• Ensure quality control by comparing scanned objects to their CAD models.

Starting from version 17, Artec Studio supports two kinds of CAD primitives that differ in the way they are
created:

• Fitted CAD primitives that Artec Studio fits into the selected part of one or multiple models/point clouds;

• Independent CAD primitives that are created independently on the model.

10.1 CAD Primitives Types

At present it is possible to construct the following types of primitives:

• Cylinder,

• Cone/Truncated cone,

• Sphere,

• Plane,

• Torus,

• Box.

A torus is a donut-like figure, which is determined by the radii of its outer and inner circumferences: major and
minor radii, respectively.

There is also another type of the fitted CAD primitives called surfaces:

• Freeform patch,

• Autosurface.
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10.2 Constructing CAD Primitives

You can construct two kinds of CAD primitives: fitted and independent ones.

See also:

Importing CAD models

10.2.1 Constructing Fitted CAD Primitives

Fitted CAD primitives are constructed on the basis of polygonal meshes (models) and then are fitted into the
latter.

Figure 174: From left to right: original object, scanned model, a set of constructed primitives.

A freeform patch can be thought of as a sheet of paper that you wrap around the portion of the object’s surface.
The freeform patch can be used for complicated surfaces that are not covered by usual types of primitives, such
as surfaces of organic objects, for example. The following parameters are required for constructing a freeform
patch:

• Padding — the percentage by which the selected surface area is expanded before building the patch.

• Number of points — the number of control points (patch mesh nodes) on each axis of the patch.

• Order — the order of splines used for building the patch.

Note: The more points and the higher the order of splines, the more detailed surface curvature and the closer
fit to your model you can get. However, you need to keep in mind that increasing the number of points and the
order of splines requires more CPU time for fitting the primitive.

Autosurface allows you to build a CAD primitive in the form of a surface that partially or completely covers the
model. The autosurfaces address the problem of quick transformation of organic shapes into CAD objects, as
well as the problem of approximating massive meshes with CAD objects suitable for further use in CAD software
packages. An autosurface is constructed as a set of patches of approximately the same size.

The following parameters can be adjusted for constructing an autosurface model:
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• Patch aggregation mode — Merges square cells into larger patches. Instead of setting a patch count, you
control detail with a Patch factor slider. This results in a more accurate model that also occupies less
space.

• Allow T-Nodes — Defines the form of patches.

• Allow triangles — Allows the resulting model to include triangles in cases where they are more optimal.

• Number of patches — Defines the allowed number of patches in the resulting model. Not applicable in
Patch aggregation mode.

Note: The suitable number of patches depends on the size of the selected part of the object’s surface and the
number of polygons in the original mesh. For massive meshes with a high number of polygons, more CPU time
for constructing the autosurface is required.

Note: An autosurface model can be exported to an external CAD software as a CAD model.

Figure 175: Mesh converted to the fitted autosurface with 25,000 patches (left) and the autosurface itself (right).

To construct a fitted CAD primitive, follow these steps:

1. Load a polygonal model in which you will fit the CAD primitive.

2. Open the Construct panel. The Fit tab will be opened.

3. Select one of the available primitive types you want to construct (in the example below it is Cylinder).

4. Choose Selection type and specify the required area on the one or multiple models/point clouds:

• 2D brush ( ) and 3D brush ( ) slightly differ in how they work: the former is circular
and marks the model surface on the basis of the current viewpoint, whereas the latter is
sphere-shaped and selects the surface that falls inside that sphere. Use the Brush size slider
to change the brush size.

• Lasso ( ) allows you to specify a polygon on the surface of the objects by clicking the
vertices of that polygon. A surface is selected that falls inside it.

10.2. Constructing CAD Primitives 218



Artec Studio, ver. 19

• Lasso ( ) and 2D brush ( ) allows you to select the object’s backface using the Select
through checkbox.

• Segment ( ) is the most convenient of the selection tools. It automatically expands the
area you mark with your brush and shows you the result. Thus, you can evaluate which of
the regular primitives Artec Studio identified. This selection tool has two settings avail-
able: the Brush size slider to adjust the size of your brush and the Segmentation sensitivity
slider to adjust the degree of expansion of the area marked with your brush (the higher the
sensitivity, the more Artec Studio will expand the marked area).

Note: The Segment option is not recommended for the Freeform CAD primitive or for simplified
models (models with fewer polygons).

To select an area on the object or multiple objects, use Ctrl+LMB above the model surface.
To deselect, use Alt+LMB above the selected area.

To clear the current selection partially, use Ctrl+Alt+LMB above the selected area.

Use the Invert button to invert selections, and also use the Deselect button to reset all the
selections you made.

Note: When you create an Autosurface CAD primitive, it can cover the model partially or com-
pletely, or cover the parts of multiple objects. If you select an area on the model, the primitive
will only approximate the marked area. If no area is selected, then the entire model will be
approximated.

5. Once the required area has been selected, choose a Fitting mode:

• Expanding mode requires the user to mark just a small spot on the object. The algorithm
will search the model corresponding to the shape of the selected primitive, and fit the
primitive at the borders of the found location.

• Robust mode works with the area that the user has selected. However, if there are any
conflicting surfaces, the “Robust fit” will ignore them andwill work with the largest selected
area.

• Exact mode only works on the area the user has selected. The algorithm allows you to
select custom areas for a future primitive and control its size, even if the object isn’t exactly
primitive-shaped.

Note: It is not recommended to use the Expanding mode with the Segment selection tool as
their implementing algorithms contradict to each other.

Note: The Fitting mode is not applicable for surfaces.

6. Click the required primitive icon on the Primitive type bar.

7. If the selected primitive (sphere, cylinder or truncated cone) should fit into a hole of a given depth, such
as a hole in a plate, then check the Smart height evaluation option. In this case, Artec Studio will use an
algorithm that provides a more accurate fitting of the primitive to the objects.
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Figure 176: The Fit tab of the Construct panel: specifying the area using the 3D brush.
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8. If necessary, specify the desired parameters of the primitive to be created (see CAD Primitives Types for the
description).

9. Click Fit cylinder button (or Fit sphere, etc.) to confirm your choice. Artec Studio will create a CAD primitive
and fit it into the selected area.

Figure 177: Cylinder (blue) fit into the model.
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10.2.2 Constructing Independent CAD Primitives

To construct an independent CAD primitive, follow these steps:

1. Open a new project or load a polygonal model which you will modify with the CAD primitive.

2. Open the Construct panel and go to the Create tab.

3. Select one of the available primitive types you want to construct (in the example below it is Cylinder).

4. Specify the parameters of the CAD object to be created:

• For a cylinder—its radius and height

• For a cone—its radius, height, aperture, and Truncated checkbox

• For a sphere—its radius

• For a plane—its width and height

• For a torus—its major and minor radii (see CAD Primitives Types for torus description)

• For a box—its width, length and depth

5. Position the CAD object as needed.

• To move the primitive, click and drag the appropriate gizmo control while the Translate tab
is active.

• To rotate the primitive, click and drag the appropriate gizmo control while the Rotate tab
is active.

• You can also specify the translation of the object and its axes rotation changing the corre-
sponding parameters in the Translate and Rotate tabs respectively.

6. Click Create cylinder button (or Create sphere, etc.) to confirm your choice. Artec Studio will create a CAD
primitive and position it as specified.

Note: Make sure that the CAD primitive is positioned properly before creating it. Once it is created, its position
will be fixed and you will not be able to change it.

10.2.3 CAD Primitive Properties

To see the properties of the created CAD primitive, do the following:

1. Click the name or the icon of the primitive in the Workspace panel.

2. At the bottom of the Workspace panel, click the Properties section to expand it.

The presence of certain geometric parameters in the Properties section will depend on the type of the selected
CAD primitive (see the table below).

10.2. Constructing CAD Primitives 222



Artec Studio, ver. 19

Figure 178: The Create tab of the Construct panel: specifying the CAD cylinder parameters.
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Figure 179: Constructed cylinder (orange).
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Table 14: Presence of geometric parameters in the Properties section
for different CAD primitives.

Primitive Radius Width Height Aper-
ture

Faces

Cylinder Yes No Yes No No
Truncated cone/Cone Yes No Yes Yes No
Sphere Yes No No No No
Plane No Yes Yes No No
Torus Yes (major and minor radii) No No No No
Box No No No No Yes

For the freeform primitives the Properties section displays:

• Points — the number of points used for constructing the surface

• Order — the order of splines indicating the degree of surface smoothness

• Padding — the expansion of the surface, relative to the selected area

10.2.4 Converting CAD to Mesh

It is possible to convert CAD models and CAD primitives to a mesh in Artec Studio (17 and above).

To convert CAD to mesh,

1. Select the CAD object you want to convert in the Workspace and right-click on it.

2. Open Tools → Convert CAD to Mesh.

3. To adjust the level of detail (i.e., count of polygons) in the resulting mesh, change the value of Accuracy
as required. A higher value results in a more detailed mesh and vice versa.

4. Then, click Run.

Artec Studio then converts the CAD to a mesh (PLY). The original CAD object remains intact too.

Figure 180: CAD model converted to a mesh with 72 (left) and 144 (right) accuracy values.

Alternatively, to convert CAD to Mesh using a default Accuracy value,
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1. Select the CAD object you want to convert in the Workspace and right-click on it.

2. Select Convert to mesh option.

Artec Studio then converts the CAD to a mesh (PLY). The original CAD object remains intact.

10.2.5 Disassembling CAD objects

If the imported CAD model is recognized as an assembly, you can split it into its individual parts. The Disas-
semble option can be found in the context menu of the Workspace panel only if the selected element is a CAD
assembly.

Once the option is selected, theWorkspace panel will display a new group named after the assembly. This group
will contain the individual parts it was disassembled into and the original assembly will stay on the same level
with the new folder.

10.3 Setting constraints for CAD primitives

After creating CAD primitives, you can adjust their size and relative position by applying various constraints to
them. Artec Studio supports the following kinds of constraints: conditions (they are set for one primitive) and
relations (they are set for two or more primitives). Below see the table of available constraint types.

Table 15: Constraint types for primitives.
Icon Kind of constraint This constraint … Applicable to …

Relation requires the axes (or normals) of the selected primi-
tives to be parallel

cylinder, cone,
plane, torus

Relation requires the axes (or normals) of the selected primi-
tives to be perpendicular

cylinder, cone,
plane, torus

Relation sets a given angle between the axes (or normals) of
the selected primitives

cylinder, cone,
plane, torus

Relation requires the selected primitives to be coaxial all types of primi-
tives except plane

Condition sets a given value for one of the sizes of the selected
primitive, for example, cylinder radius/height, torus
minor/major radius, etc.

cylinder, cone,
sphere, torus

Relation requires the selected sizes of the selected primitives
to be equal

cylinder, cone,
sphere, torus

Condition prohibits changes to the primitive during the Refit
operation

all types of primi-
tives

Note: Independent CAD primitives, as well as Freeform and Autosurface CAD primitives do not support any
constraints.

You can set several different constraints for each primitive. There is no limit to the number of constraints.
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Note: You cannot set constraints for CAD primitives created in Artec Studio version 16 and earlier.

Applying constraints to CAD primitives consists of two stages. First, you specify the desired constraints, and on
the second stage, you force Artec Studio to rebuild the primitives to meet the constraints you set (the refitting
process).

To specify and apply constraints to CAD primitives, follow these steps:

1. Open the Construct panel and create the CAD primitives you need (see Constructing CAD Primitives for
details).

2. Click the desired primitive. The Constrain pop-up toolbar appears with icons for the applicable constraint
types (see an example of such a toolbar for the case of a cylinder in Figure 181, a and Figure 182, a).

Note: If you are having difficulty selecting a CAD primitive, you can hide other objects in the 3D View area that
may interfere, i.e., meshes, scans, imported CAD models.

3. Click the icon of the desired constraint type.

4. Perform the appropriate actions depending on the constraint type you selected:

• For (lock), no actions are required.

• For (set length), click one of the icons of primitive sizes on an additional pop-up tool bar if it
appears (see an example in Figure 181, b). Specify the desired primitive size value and click on
the appropriate pop-up toolbar (see Figure 181, c).

• For (parallel to …), (perpendicular to …), (at angle to …), and (coaxial to …), click all other
primitives to be involved into the new relation (see an example in Figure 182, b). When done, click

on the appropriate pop-up toolbar (see Figure 182, c).

• For (equal to …), select one of the primitive sizes on an additional pop-up toolbar (it appears if two
or more sizes are available). Then click the second primitive and select one of its sizes. To establish
an equality relationship between the two selected sizes, click on the appropriate pop-up toolbar.

The corresponding constraint icon will be displayed next to each primitive participating in the constraint
but no changes to the size or position of the primitives will occur at this point (see examples in Figure
181, d and Figure 182, d). A pop-up toolbar with the Refit button will appear at the top of the 3D View
window.

5. Repeat steps 2 to 4 to add more constraints if required.

6. Before proceeding to the next step, you can click the icon of any constraint and make the necessary
changes or remove it by clicking on the constraint’s pop-up toolbar.

7. To apply the newly added constraints to the CAD primitives, click the Refit button on the panel at the top
of the 3D View window.

The primitives will be rebuilt to satisfy the specified constraints. Figure 183, b presents the result
of applying both constraints illustrated in Figure 181 and Figure 182.

Note: If the constraints are applied successfully, the symbols in their icons remain yellow, otherwise—the
symbols turn red.
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Figure 181: Example for specifying CAD primitive constraints: setting the height of a cylinder.
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Figure 182: Example for specifying CAD primitive constraints: setting the requirement that the axes of two
primitives are at a given angle to each other.

Figure 183: Example for applying CAD primitive constraints.
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8. If red constraint icons appear as the result of step 7, follow step 6 to change or remove such incompatible
constraints, and then repeat step 7 if necessary.

Note: Actions with constraints, as well as the Refit primitives command triggered by the Refit button are recorded
in History and can be undone or redone (for example, using the Undo and Redo buttons).

To add more constraints, repeat the above procedure (steps 1 to 8).

To modify the constraints applied to your CAD primitives, perform steps 6 to 8 of the above procedure before
closing the Construct panel. You can also switch to the Show CAD constraintsmode to view andmodify constraints
without the Construct panel. To turn it on, use the View → Show CAD constraints menu command.

To cancel the constraints applied to CAD primitives last time you pressed the Refit button, use the Undo com-
mand. The previous state of the involved CAD primitives will be restored, however, the constraints themselves
will remain unchanged.

To remove a constraint, click its icon and then on the constraint pop-up toolbar. In this case, the result will
be the following:

• The constraint will be removed.

• The CAD primitives participating in this constraint (their size, position, orientation) will not be affected.

10.3.1 Ambiguity of some constraints

For some relations, the result of applying the constraint is ambiguous. For example, the condition that the axis
of one primitive is directed at an angle to the axis of another one is not enough to determine the direction of
the axes. This problem has an infinite number of solutions. In this case, Artec Studio will choose one of the
solutions. For the solution to be unambiguous, additional constraints must be used.

Let us explain this with the following example. Suppose we have two primitives: a cylinder and a plane (see
Figure 184, a), and we would like to adjust the position of the plane so that its normal becomes perpendicular
to the axis of the cylinder. For this, we specify and apply the corresponding constraint ( ). The result obtained
after refitting the primitives is shown in Figure 184, b. It is correct, but not what we expected. To get the
desired result, we need to set an additional constraint, for example, we can lock the cylinder for changes (see
the corresponding result in Figure 184, c).

10.4 Positioning CAD Primitives

The Precise positioning mode benefits from the presence of parametric data in the scene. Use the Precise mode
to quickly and accurately position CAD primitives, and thus scans and models to which they belong.

1. In the Workspace panel, select the models and primitives you want to align.

2. Open Editor → Precise positioning.

3. In the Primitives box, select the CAD primitive you intend to position. Below the Primitives box you will
see the available positioning options (see Table 16 for details), which appear as buttons and vary with the
type of the selected primitive.

Note: Freeform and Autosurface CAD primitives are not available for precise positioning.
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Figure 184: Example of ambiguous CAD primitive constraints.
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4. If some other objects belong to the parent group of the selected primitive and you want to apply the same
positioning actions to them, check Apply to all objects in parent groups.

5. Click either of the self-explanatory positioning buttons. Artec Studio will position the primitive in accor-
dance with the selected option and disable this button. You will see the alignment information in the
Primitives box next to the name of the selected primitive.

Every positioning action is recorded in the local history, so you can undo or redo it:

• To undo an action, use Edit → Undo or Ctrl+Z.

• To redo an action, use Edit → Redo or Ctrl+Y.

Figure 185: Editor → Precise positioning: the aligned CAD primitive is highlighted.

Table 16: Actions for primitives.
Button Purpose Status
Move to origin Place the selected primitive’s point to the coordinate origin. For de-

tails, see Primitives’ Points To Use for Positioning.
O

Align with X/Y/Z Align the primitive with the respective axis. X, Y or Z
Align with YOZ/XOZ/XOY Align the plane primitive with the respective coordinate plane. YOZ,

XOZ or
XOY

Any CAD primitive that you first align with any coordinate axis or plane
is considered primary. A primary object will be given a priority when
conflicting alignments occur.

P

Make primary Make another object primary and remove this status from the current
primary one

Reset origin Undo the Move to origin action.
Invert direction Invert direction of the axis or plane in the applied alignment I
Reset alignment Reset all the positioning actions applied to the primitive
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Note: The Precise positioning tool does not affect locked objects ( ). See Locking Object’s Position for details.

See also:

Exporting CAD objects, Distance Maps and Sections and Volume.

10.4.1 Primitives’ Points To Use for Positioning

Depending on the type of a CAD primitive, you can use the following points in the Move to origin action.

Table 17: Primitives’ points to use in the Move to origin action.
Type of primitive Points for positioning
Cylinder 3 points: the center of the cylinder and the intersections of the cylinder axis with

its bases
Plane The center of the plane
Sphere The center of the sphere
Cone 3 points: the cone vertex, the middle of the cone axis, and the intersection of

the axis of the cone with its base
Truncated cone 3 points: the middle of the cone axis and the intersections of the axis of the cone

with its bases
Torus 3 points: the center of the torus and the intersections of the axis of the torus

with the sides of the box into which it is inscribed

To select the center of a primitive for using in the Move to origin action, click the primitive or select it in the
Primitives box. The selected point and the outline of the primitive will be highlighted in white (Figure 186, left).

When you hover the cursor over the primitive’s axis, other points for positioning will appear on it. To select any
of the possible positioning points, click on it. The selected point will be highlighted in white (Figure 186, right).

Figure 186: Selecting a point for positioning.
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10.5 Editing meshes using CAD objects

In Artec Studio, you can not only generate 3D forms through 3D scanning, but also create complicated shapes
through combining meshes, CAD primitives, and CAD models. The following tools for engineering tasks are
currently available:

• Boolean Operations

• Splitting Object By Surface

10.5.1 Boolean Operations

Starting from version 17, the basic set of Boolean operations is available in Artec Studio. You can create unifi-
cations and intersections between meshes and CAD objects, as well as subtract objects from each other.

The table below lists the available Boolean operations.

Table 18: Types of Boolean operations
Icon Boolean operation This operation …

Unification creates a new mesh by merging one or more objects with each other
Subtraction creates a new mesh by subtracting one or more objects from another one
Intersection creates a new mesh that is the common part of two or more source objects

Boolean operations in Artec Studio can be applied to meshes, CAD primitives, imported CAD models and as-
semblies (collection of multiple objects). The following combinations are possible: mesh and mesh, mesh and
CAD primitive, mesh and CAD model, mesh and assembly etc. The result of the operation is always a new mesh.
The number of objects used in one operation is not limited, for example, you can create a Boolean unification
by merging several objects.

Note: If you perform Boolean operations on a set of two CAD models, you will get a mesh as a result, not
another CAD model.

To perform a Boolean operation, follow these steps:

1. Open the Construct panel and go to the Edit tab.

2. Click the icon of the desired Boolean operation.

3. Specify the objects for the operation.

• For (Boolean unification):

a. Сlick Add object in the Objects to merge field.

b. Select one or more objects.

• For (Boolean subtraction):

a. Click Add object in the Subtract from field.

b. Select an object.

c. Click Add object in the Objects to subtract field.

d. Select one or more objects. If only one object is selected in the Objects to subtract field,
you can swap the objects selected for the operation by clicking the button.
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Figure 187: Examples of Boolean operations with objects: a—source objects, b—Boolean unification, c—Boolean
subtraction, d—Boolean intersection
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• For (Boolean intersection):

a. Click Add object in the Objects to intersect field.

b. Select one or more objects.

Note: To select an object, click it in the 3D View window or click its name in the Workspace
panel. To deselect an object, click the x button to the right of its name in the Construct panel.
Upon selection, the objects are appropriately hightlighted in the 3D View window.

Figure 188: Selected objects are highlighted before the boolean operation

1. In order to preview the result of your boolean operation, enable the Preview toggle switch in the panel.

Note: The Preview option is currently available only for the Subtraction and Intersection op-
erations.

2. If you need to keep the source objects intact, check the Keep initial objects option. Otherwise, they will
disappear from the Workspace panel after the operation is completed.

3. Click the Create mesh button to confirm the operation. Artec Studio will create a Boolean unification (or
Boolean subtraction, etc) mesh.
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10.5.2 Splitting Object By Surface

You can split a mesh or CAD object into segments using one or more pre-built surfaces or planes. The result of
split by each individual surface is two separate parts of the source object. The contact zone of these parts is
sealed for both segments. The new parts appear as two separate objects in the Workspace panel.

The split tool can be used in particular to precisely divide an object into manageable chunks for further 3D
printing.

To split a mesh by one or several surfaces, follow these steps:

1. Open the Construct panel and go to the Edit tab.

2. Click the Split object ( ) icon.

3. Specify the objects for the operation:

• Сlick Add object in the Object to split field.

• Select a mesh that you want to split.

• Click Add object in the Cutting surface field.

• Select one or more surfaces.

Note: To select an object, click it in the 3D View window or click its name in the Workspace
panel. To deselect an object, click the x button to the right of its name in the Construct panel.

4. If you need to keep the source object intact, check the Keep initial objects option. Otherwise, they will
disappear from the Workspace panel after the operation is completed.

5. Click the Apply button to confirm the operation. Artec Studio will split the object by the specified surface(s).

10.6 Working with Imported CAD Models

Imported CAD models can be aligned or compared with polygon models (fusion operation outputs).

10.6.1 Alignment

When aligning CAD models with polygon models, don’t use Nonrigid alignment and employ many point pairs
(5–6 pairs). You can also align an imported CAD model with a mesh precisely by specifying datums.

For details, consult Datum Alignment, Best Fit Alignment with Points and Specifying Point Sets (Markers) and Editing
their Positions.

10.6. Working with Imported CAD Models 237



Artec Studio, ver. 19

Figure 189: Example of splitting a mesh using 3 pre-built planes: a—before splitting, b—after splitting
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CHAPTER

ELEVEN

ADDITIONAL MODES

This chapter describes other Artec Studio modes, such as

• Multicapturing

• Measurement Tools

• Copying Log Records

• Feedback Form

11.1 Multicapturing

Artec Studio enables synchronized scanning with multiple scanners. This mode is helpful when capturing a
large object from several angles using more than one scanner simultaneously. Multicapturing with several
scanners implies that the system knows their position in advance. This condition simplifies and accelerates
data processing considerably. For this reason you must calibrate the relative positions of the scanners before
capturing. The resulting calibration data, which includes scanner IDs and their spatial orientations, is referred
to as a bundle.

Important: Using multiple Artec scanners requires your workstation to integrate as many independent USB
host controllers as connected scanning devices.

The entire procedure is given below and covered in the following sections.

1. Calibrate the relative position of each device (i.e., create a bundle)

1. Capture the test object using all bundled scanners (see object requirements in Bundle Creation)

2. Manually align the resulting scans using the Align tool to compute the relative position of all scanners

3. Create the bundle using the Create bundle panel

2. Use the Multi panel to capture scans
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11.1.1 Bundle Creation

11.1.1.1 Preparation

Perform the following steps to prepare the devices and the environment:

1. Select device positions. The scanners’ combined field of view should cover the required area.

2. Fix the scanners in the chosen positions. If you plan to use hardware synchronization (see Hardware
Synchronization for Eva), attach the scanners to the tripods by securing them with thumbscrews while
allowing the wires to hang freely.

3. Select and set up the calibration object. Any object with a geometry-rich surface is a candidate. Avoid
selecting objects with simple geometries for calibration (e.g., planes, spheres or cylinders). You may
use several objects as a composition when creating a bundle. We recommend object installation at the
distance corresponding to the middle of the operating range for the chosen device type.

11.1.1.2 Capturing

4. Use either the Capture or Multi panels to make scans. The latter option is more convenient, as it allows
you to capture the video data stream simultaneously from several scanners. For details regarding this
mode, see Performing Multicapture.

If you install the scanners at small an-
gles relative to each other (i.e., you can
see the same object area simultaneously
through different scanners), you need not
rotate the object. In this case, you can
take calibration scans either sequentially
or concurrently. In case of sequential
scanning, make sure the object is fixed
safely and remains motionless during the
scan.

If you set up the scanners at a large angle and their fields of
view have no overlap, use the Multi panel to start the capture
sequence and then turn (move) the object to enable all scanners
to capture the same parts.
Note! It is important that all scanners capture a large portion
of the object or scene (but not necessarily the same portion) in
each frame, because the position of all subsequent frames—as
well as the scanners themselves—will be determined by their
predecessors. Also, the relative positions of the scans will de-
termine the intercalibration of the devices.

11.1.1.3 Alignment

5. If the cameras are far from each other and the object was moving, then you should register the scans
using the Fine registration and Global Registration algorithms.

6. Next, proceed to the Align panel and align the captured scans as Alignment describes. At that point,
everything will be ready for bundle creation.

11.1.1.4 Bundle

7. From the menu, select File → Create bundle. A warning message will appear if you forget to align the
scans. Otherwise, the bundle-creation panel will appear (see Figure 190). The 3D View window will
show the selected scans, the position and viewing direction of the scanners (by means of an appropriately
colored pyramid), the device ID, and the scanner coordinates. It will display a list of connected devices
and corresponding information.

8. Add a device to the bundle or remove one by inverting the image in the leftmost column of the list.
The order of devices in a bundle refers to the scan order in the Workspace panel.
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Figure 190: Bundle-creation window.
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9. A bundle name will appear in the field at the top of the bundle-creation panel. By default it contains the
serial number of the bundled scanner. Before creating the bundle, you can easily change this name by
typing in the corresponding field. Click Apply at the bottom of the panel to create and install the bundle.

Note: Once you have created the bundle, you can no longer move the scanners relative to one another. If even
one device has changed position, you must recreate the bundle.

11.1.2 Performing Multicapture

Multi mode allows you to capture 3D reality simultaneously from several devices.

1. Select File → Multicapture (bundle). The panel will open (see Figure 191).

2. Either use one of the existing bundles or specify the scanner list manually.

Note: In multicapture mode the system possesses information about the relative scanner positions. There-
fore, scans captured by bundled scanners differ from manual scans in that the matching frames from different
scanners are already in the same coordinate system.

1. Select the Use bundle checkbox. A dropdown list of all installed bundles will appear in the panel. Active
bundles are highlighted in black, inactive bundles in gray. Artec Studio considers the bundle active if all
bundled devices are installed and connected to the PC.

2. Select Synchronization type from the Options tab in the Multicapture panel.

• In Software mode, scanners are synchronized via USB, Windows and Artec Studio, and the slave-
scanner actuation time always varies (~10 milliseconds) owing to the numerous links in the chain.

• In Hardware mode, scanners are synchronized via cables (see Hardware Synchronization for Eva for
details). Hardware synchronization provides high precision and repeatability for slave-scanner actu-
ation time (about 1 millisecond with a precision of less than 10 microseconds, thanks to microelec-
tronic processes).

Note: We recommend hardware synchronization in most circumstances; when capturing moving objects,
it is mandatory.

3. Click Preview to start capture.

11.1.2.1 Tweaking Multicapture Options

You can store multicapture data either as separate scans (use the Separate scans radio button) or as a single
scan in which every frame represents an aligned union of corresponding frames from all bundled devices (use
the Merge frames radio button).

If you need to capture frames with a certain delay between the scanners, enter the delay value in the Delay
between frames field. Unlike the Scan mode, the Multicapture mode captures each frame independently without
attempting to align each subsequent frame with the previous one, so it makes sense.

Sometimes, limiting the cameras’ field of view is necessary (e.g., to cut off extraneous distant objects). Two
sliders in the Depth of field area set the near and far scanning boundaries. The application sets work-area
boundaries for each device independently in the device tabs (see Figure 191, right). By default, theminimum and
maximum boundary values for the corresponding device type are set to the recommended range; we encourage
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Figure 191: Multicapture panel: Options tab on left, Device tab on right.
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you to avoid changing them. However, if you’re using Artec L scanners or 3D sensors, it may become necessary.
To change these values manually, mark the Override default depth range checkbox in the Scan tab of the Settings
dialog and enter the appropriate values in the fields below.

Note: For most scanner types, redefining the recommended depth range may reduce accuracy.

Fast capture mode instructs Artec Studio to store raw scanned data in memory and processes frames after com-
pleting the capture sequence. It allows to save processor time on building and rendering surfaces. And if the
number of processor cores is less then doubled number of scanners in the bundle, it can also increase scanning
speed.

To enable it,

1. Check the Fast capture mode box.

2. Enter the desired capture duration in seconds. The application will automatically recalculate and display
the required amount of memory.

Artec Studio saves multicapture parameters when you exit the application and reapplies them the next time
you start it.

11.2 Measurement Tools

Artec Studio offers a number of measurement tools, including

• Distance

– Linear distance

– Thickness

– Geodesic distance

• Sections and Volume

• Distance map

• Section analysis

The corresponding buttons reside in the upper part of the Measures panel.

To work with these tools

1. Mark the checkboxes of each desired scan or model to display them in the 3D View window.

2. Select the measurement tool you need and click on the object surfaces to create measurement lines,
planes, etc.

The sections below takes a closer look at the different measurement tools and their features.
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Figure 192: The Measures panel.

11.2.1 Distance

11.2.1.1 Linear Distance

When you select Measures → Distance ( ), the linear measurement will be used by default. Don’t mark the
Geodesic checkbox.

The linear-measurement tool allows you to measure:

• the distances between selected points

• the thickness of a model (see Thickness measurement for details)

• the total length of a polyline determined by a sequence of points

You can enter a name for the new measurement by typing it in the Name and color field. Click on the color circle
next to the field to choose a color of the measurement projection. The application creates new measurements
with default names Linear 1, Linear 2 and so on.

To measure distances between points,

• Use LMB to sequentially set the points on the model in the 3D View window. The application will add
these points to the current point list (in the Measures panel), which will also display linear dimensions
and point coordinates.

• When you roll the cursor over any one of these points in the 3D View window, the point will be highlighted;
you can then drag it to another location using LMB. When you release the mouse button, the point will
fix to its new location.
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Note: You can’t set a point outside the object’s surface; in this situation, if you release the
mouse button, the point will return to its original position.

Figure 193: Linear measurement.

After you click Save measurement, the application will return to the original Measures panel and will display a
list of all saved measurements along with editing and deletion options.

11.2.1.2 Thickness measurement

Artec Studio allows you to measure the thickness of a model. Thickness measurement uses the ability of Artec
Studio to determine the shortest distance between any selected point and a plane.

To measure the thickness of a model, follow these steps:

1. In the Construct panel, build a plane (shown in orange in Figure 194) that fits the side surface of the model
(find out in Constructing CAD Primitives how to do this).

2. In the Workspace panel, select the model and the plane you constructed.

3. Open the Measures panel and click . Leave the Geodesic checkbox clear.
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4. Select any point on the side of the model opposite to the plane (Point 1 in Figure 194, left).

5. Click the plane. To avoid mistakes, it is recommended to hide the model in the 3D View panel before
doing this.

Artec Studio will automatically construct a perpendicular to the plane, determine the point of their intersection
(Point 2 in Figure 194, right), and calculate the distance between the two points. This distance gives you the
thickness of the model.

Figure 194: Thickness measurement: selecting a point on the side opposite to the plane (left), clicking the plane
to determine distance to it (right).

11.2.1.3 Geodesic Distance

Geodesic distance is defined as the length of the shortest path over a surface between several given points. To
activate the geodesic measurement, mark the Geodesic checkbox in the Measures → Distance panel and select
a point cloud scan or model to start using the tool.

Working with geodesic measurements is similar to working with linear measurements (see above).

Calculation of the shortest path is a time-consuming process that is accompanied by a progress-bar window.
Also keep in mind that the shortest path between different surfaces or disconnected parts of the same surface
is not defined. Therefore, the program will display an error if you select points on parts of a surface that are
not connected to each other.

Note: The geodesic algorithm is complex, and computations for a large number of verticesmay take a long time.
Therefore, if you choose the first point on a surface containing more than 150000 points total, the software will
warn you that it may be a lengthy operation. You can either use the mesh-optimization algorithm beforehand
(see Mesh Simplification (Tools, Mesh Optimization)) or delete the parts of the surface that you don’t need.

The left panel in this mode is similar to the one for linear-measurement mode (see Linear Distance).
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Figure 195: The Geodesic measurement.

11.2. Measurement Tools 248



Artec Studio, ver. 19

11.2.1.4 Exporting Linear (Geodesic) Measurements

Once you have made and saved the required measurements, you can export them. Go to the general section
Measures, select the desiredmeasurement(s) and click on Export… You can export measurements in the following
formats: CSV and XML.

11.2.2 Sections and Volume

Section is the plane that splits model or scan into two parts. Once created, it can provide you with data on
volumes and areas of these parts as well as area and perimeter of the contour, i.e. the line formed as an
intersection of the plane with surface.

To create a section of an object, follow the steps:

1. Select one or more models or scans and click Measures→ Sections & Volume ( ). Models are preferable,
since they contain only one surface.

2. Change the section name in the Name field as necessary.

3. Select the type of restrictions to create a plane: Unconstrained (3 points) or Parallel to either plane. Al-
ternatively, you can also construct a plane using CAD Primitives and then, use this constructed plane to
create a section by selecting the Use constructed plane option.

4. Use LMB to mark points on the object’s surface:

• Mark only one point to specify a plane parallel to one of the coordinate planes (XOY, YOZ,
XOZ).

• Mark three points to specify the plane that passes exactly through them.

Note: You can mark more points than required, i.e. more than one point or more than three
points respectively. In this case, the plane will pass through the center of mass of the specified
system of points.

5. If necessary, redefine your selection of points before using Calculate; to do so, click the Reset button.

6. For the plane to intersect the entire object, check the Scale to bounding box option. Alternatively, to
enlarge or reduce the plane, you can use the Scale mode (see the next step for details).

7. Change the location and orientation of the plane as necessary. Choose a mode for doing this: Translate,
Rotate or Scale. You can either specify numerical values in the text fields (in the plane’s coordinate system
for the Scale mode or in the global coordinate system for other modes) or drag the controls (which are
also called gizmo) in the 3D View window.

8. You can also get a live preview of the section by dragging and moving the respective axis arrows (gizmo),
for a clearer visualization.

9. Click Calculate.

Note: The control principles of the section gizmos are the same as for the model gizmos. See here for details.

To measure the other side of the selected section

1. Flip the axis direction by clicking on the Flip button next to Axis direction in the panel.

To create a series of sections
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Figure 196: Gizmos for the Translate, Rotate and Scale respectively.

Figure 197: Change location and preview a new section by dragging the Gizmo controls.
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1. Specify the quantity of planes you want to create by entering the value in Planes and define the spacing
in the Spacing (in mm) field.

2. Then select from the Direction list one of three directions (Positive, Negative or Both) in which to create
the new planes.

3. Click Calculate.

Figure 198: Calculating with two planes.

Once you have created the section(s), the Section panel will display its geometrical information. This information
includes perimeter and area for contours as well as area and volume for parts of meshes. Besides displaying
geometrical values, Artec Studio will show a list of meshes and contours that allows you to highlight them in
the 3D View window by clicking on them in the list.

11.2.2.1 Comparing Values

The Section panel allows you to compare contours and mesh parts. To this end, select either two contours or
two mesh parts from the list using the Ctrl key. Artec Studio will calculate the differences between the areas
and perimeters of the contours and the difference between volumes and areas for mesh parts. These values
will be available in the lower part of the Section panel (see Figure 199).

11.2. Measurement Tools 251



Artec Studio, ver. 19

Figure 199: Calculating the contour difference.
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11.2.2.2 Volume and Surface Area of Models

To calculate the entire volume and surface area

1. Select one or more models in the Workspace panel.

2. Check Measure entire model in the Sections & Volume panel.

3. Click Calculate.

Artec Studio will calculate the parameters for all the selected models.

11.2.2.3 Exporting Sections

Once you have made and saved the required measurements, you can export them. Go to the general section
Measures, select the desiredmeasurement(s) and click on Export… You can export measurements in the following
formats: CSV, XML or DXF.

Also, if you have SolidWorks installed, the Export to SolidWorks button will be accessible.

11.2.3 Distance Maps

You may often find it necessary to compare two models and assess the deviation of their forms. For instance,
quality control may require comparison of the original model with the scanned one. You can handle these tasks
by using the Distance option in the Distance map feature.

Note: Artec Studio can only compare models or scans containing a single surface.

Use this tool as follows:

1. Select two aligned models for comparison.

2. Go to Measures → Distance map ( ), and select the option Distance.

3. If necessary, specify the name of the distance map in the Name field of the Distance map panel. By default,
the application creates new distance maps under the names Distance map 1, Distance map 2 and
so on.

Note: The direction along the normals of the first scan is considered positive; the opposite
direction is considered negative. The button swaps scans.

4. Specify the Search distance value (in mm), a maximum range in millimeters for calculating distances be-
tween surfaces. You can adjust the actual range subject to this maximum after the calculation finishes.

5. Select a desired Raycasting mode. The Raycasting modes refer to the point-to-point projected distance
between the two surfaces in comparison.

6. Click Calculate.

Note: Artec Studio 18 introduces two distane-projection (Raycasting) modes - Shortest Distance and Along
normals.

Once the process is complete, the distance map will appear in the 3D View window and the calculation results
in the Distance map panel.
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Figure 200: Surface-distance map calculated for two models.
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See also:

You can also calculate a distance map in the Datum Alignment mode. See Datum Alignment for more details.

To recalculate the distance map with a new Search distance value, simply enter the new value in the Search
distance field and click on the Recalculate button. The new distance map will be generated.

You can analyze the calculation results and the distance map:

• On the basis of the Search distance value you entered, Artec Studio calculates the following:

– Mean absolute distance

– Mean absolute deviation

– Mean signed distance

– Root mean square (RMS)—the square root of the arithmetic mean of the squared distances

• A distance map is a colored rendering on the particular surface regions. You can read the corresponding
distance values and their distribution from the graduated scale and histogram that appear adjacent to the
model. The map color changes from blue, which corresponds to a negative distance, to red, which
corresponds to a positive distance.

– Green means the distance between surfaces in this region is close to zero.

– Gray highlights any surfaces with distances that exceed the specified Search distance.

– Orange and bright blue correspond respectively to distances that are slightly above and below
the limiting values of the scale.

• The graduated scale ranges from the positive value to the negative value of the Error scale. You can adjust
this range using the Error scale (mm) slider or text box. Its maximum value cannot exceed the Search
distance.

• If you move the mouse cursor to a particular point on the map, the exact distance will appear nearby.

Artec Studio enables you to set a tolerance value for the distancemap and assess the deviation of each individual
selected point against this value.

To set a tolerance value:

• Enable the Tolerance check toggle switch in the panel

• Enter a tolerance value (in mm), the markers for which will appear in the graduated scale adjacent to the
model

• A tolerance-based 3D map is rendered and the labels at each point are marked with dots of three colors
(Red, Green and Yellow).

• Green means the point is within the tolerance, Yellow means the point is very close to the tolerance value,
and Red means the point is outside the tolerance limit.

If you want to identify the spots with maximum and minimum deviation, simply click on the Show Max./Min.
deviation button in the panel. Artec Studio will automatically mark and display the objects’ maximum and
minimum deviation points on the 3D View window.

To save the current distance map and quit this mode, click Save map.
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11.2.3.1 Thickness Maps

Sometimes, it is required to assess the consistency of an object’s thickness. For instance, the thickness of a
sheet metal part and its uniformity. Artec Studio 18 enables you to measure an object’s thickness and inspect
how much it deviates from a given reference thickness value. This can be done using the Thickness option in
the Distance map tool.

To use this tool:

1. Select an aligned model.

2. Go to Measures → Distance map ( ), and select the option Thickness.

3. If necessary, specify the name of the thickness map in the Name field of the panel. By default, the appli-
cation creates new distance maps under the names Thickness map 1, Thickness map 2 and so
on.

4. Specify the Reference thickness value (in mm).

5. If needed, adjust the size of the projection-area using the Projection angle slider. It’s recommended to
increase this value when working with geometry-rich models.

6. Click Calculate.

Figure 201: Thickness map calculated for a model.

Once the process is complete, the thickness map will appear in the 3D View window and the calculation results
in the panel. To recalculate the thickness map with a new Reference thickness value, simply enter the new value
in the Reference thickness field and click on the Recalculate button. A new thickness map will be generated.
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The graduated scale ranges from the positive value to the negative value of the Error scale. You can adjust this
range using the Error scale (mm) slider or text box. Its maximum value cannot exceed the Reference thickness.

If you want to identify the spots with maximum and minimum deviation from the reference value, simply click
on the Show Max./Min. deviation button in the panel. Artec Studio will automatically mark and display the
object’s maximum and minimum deviation points on the 3D View window.

To set a tolerance value for the thickness map and assess the deviation of each individual selected point against
this value:

• Enable the Tolerance check toggle switch in the panel

• Enter a tolerance value (in mm), the markers for which will appear in the graduated scale adjacent to the
model

• A tolerance-based 3D map is rendered and the labels at each point are marked with dots of three colors
(Red, Green and Yellow).

• Green means the point is within the tolerance, Yellow means the point is very close to the tolerance value,
and Red means the point is outside the tolerance limit.

To save the current thickness map and quit this mode, click Save map.

11.2.4 Section Analysis

Artec Studio 18 introduces another tool for inspection. You can now compare selected sections of two models
and assess their deviations. This can be done using the new Section analysis tool in the Measures panel. Similar
to Distance maps, this tool is especially for inspection of a particular surface section only.

To use this tool:

1. Go to the Section analysis tool in the Measures panel.

2. Select two aligned models, or one model or one CAD object, for instance.

3. If necessary, specify the name of the section analysis in the Name field. By default, the application names
the analyses as Section analysis 1, Section analysis 2, and so on.

4. Select an appropriate Raycasting mode. This mode refers to the type of projected distance between the
two models under inspection.

5. Select a coordinate plane, by clicking on one of the options under Use a coordinate plane.

6. To select a section on the surface, simply drag and move the respective coordinate axis gizmo that appears
on the 3D View window.

7. After selecting a section, click on Calculate.

Once the process is complete, the section analysis will appear in the 3D View window and the deviations are
displayed in the form of colored projection lines. The calculation results appear in the Section analysis panel.

To increase the scale of the projection lines on the 3D ViewWindow, for a better visual evaluation of the analysis,
use the Projection line scale slider. A higher value sizes the projection lines up, and vice versa.

Using the Tolerance field, you can set a tolerance value for the section anaylsis and assess the deviation of each
individual selected point against this value.

You can also ask Artec Studio to automatically indicate the points of minimum and maximum deviation, by
switching the Show min/max deviation toggle switch ON.
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Figure 202: Result of section analysis of a model (bottom), for a selected section (top).
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11.2.4.1 Exporting Measurements

Once you have made and saved the required measurements, you can export them. Go to the general section
Measures, select the desired measurement(s) and click on Export… You can only export maps and analyses in
CSV format.

11.2.5 Notes (Annotations)

Notes allow you to mark noteworthy points on the surface (parts of the object) and fix the calculated values
on distance maps. Notes can be saved in screenshots (see Saving Screenshots for details), which is useful for
making presentations or sharing your notes with colleagues. Notes are available in all the Measures modes.

To make a note, just click Ctrl+LMB on the desired surface and you will see an editable label. Type any text
into this label.

For example, in the Distance mode:

Use the following buttons to control your notes:

• is for committing notes

• is for editing notes

• is for removing notes

Note: To commit a note, you can also click anywhere outside the note’s pop-up window.

In the Sections & Volume and Distance map modes, it works just the same. But in the Distance map mode, if you
create the note on the colored part of the model, the note will automatically fix the calculated signed distance
at that point (see the figure below).

11.2.5.1 Exporting Notes

Notes are exported with the measurements in which the notes are made. See Exporting Linear (Geodesic) Mea-
surements and Exporting Sections.

The export of linear measurement with notes to XML is shown below.

<?xml version="1.0" encoding="utf-8"?>
<Linear title="Linear">

<Annotation>
<coord>vector float : 3; 11.39915; -1.54995; 24.40591</coord>
<text>string : Hand</text>

</Annotation>
<Annotation>

<coord>vector float : 3; -2.042809; -1.170498; 39.77322</coord>
<text>string : Head</text>

</Annotation>
<point_0>

<coord>vector float : 3; -1.869595; -1.218353; 39.71429</coord>
<length>float : 0</length>

</point_0>
<point_1>

(continues on next page)
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Figure 203: Notes on the model surface (Distance mode).
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Figure 204: Note on the distance map.
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(continued from previous page)

<coord>vector float : 3; 11.40365; -1.638699; 24.64325</coord>
<length>float : 20.0871</length>

</point_1>
</Linear>

11.3 Copying Log Records

If for some reason you need to copy the log records, for example, to provide information to our support center,
you can do this using the context menu of the Log window:

• To copy a single log record to the clipboard, first click it to highlight, then right-click this record and select
Copy.

• To place the entire log content to the clipboard, right-click any line of the Log window and choose Select
all. After all log records are highlighted, right-click any of them and select Copy.

11.4 Feedback Form

We’re always here to help, and we welcome constructive input from our customers. If you have a question,
comment or suggestion about an Artec product, the feedback form is a quick and easy way to get in touch with
us. Simply provide a valid email address (or use default MyArtec email) and type in your question or comment,
and we’ll direct it to the proper staff members. If appropriate, we’ll respond with an answer to your question or
a request for further information so we can better assist you. To use the feedback form, you must agree to our
terms of service.
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CHAPTER

TWELVE

SETTINGS

This chapter describes Artec Studio settings that you can change through the Settings dialog. To display this
dialog, select Settings… from the File menu or hit the F10 key.

The user-adjustable settings are divided into categories under separate tabs. These categories include the
following:

• General

• Performance

• Scan

• UI

• Miscellaneous

12.1 General

The General tab contains basic Artec Studio settings and includes the following options (see Figure 205):

• Project-storage folder

• Temporary folder

• Import/export options

• Default import units and Default export units

• View control settings

• Legacy section

12.1.1 Project-Storage Path

Project-storage path is a default path which Artec Studio will use in the project saving dialog (Saving a Project).
The default location is Windows user’s Documents folder. You can alter this path by editing the field content
or clicking Browse… and afterwards specifying the required folder.
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Figure 205: General settings tab.
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12.1.2 Temporary Folder

A newly created and yet unsaved project is stored at the location specified in the Temporary folder field. The
default path is the Windows temporary folder. To change this folder, use the Browse… button or enter a new
path in the field. Artec Studio does not delete a new project and all the actions unless you save it manually in
another location.

You can access Windows temporary folder and remove the unwanted projects later as necessary.

1. Open the Explorer window.

2. Type %temp% in the address bar and hit Enter.

3. Locate folders that have GUID names in braces { }.

12.1.3 Clear Artec Studio temporary files

Whenever you encounter a shortage of free space on your system, do not hesitate to clear up some room by
clicking the Clear Artec Studio temporary files button in the General tab.

12.1.4 Registering Artec Studio as Default Viewer

Artec Studio supports various file formats. To make it the default application for supported formats, click
Change… and select the formats you want the application to open by default (see Figure 206):

*.a3d Project files for Artec Studio
*.scan Single-scan export/import format
*.ply Format for saving polygonal models obtained using 3D scanners
*.stl 3D-model export format for fast-prototyping equipment
*.wrl Virtual-reality files in VRML 1.0 and VRML 2.0 format
*.obj Texturized 3D models; Wavefront OBJ format

Figure 206: Making Artec Studio the default application for various file types.

For more information on importing and exporting files, see Exporting Models, Scans and Point Clouds and Import-
ing Models and Scans.
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12.1.5 Opening Files

Artec Studio can serve as the default viewer for A3D, SCAN, PLY, STL, OBJ and VRML (*.wrl) formats. To
open each subsequent file in a new application window, select Open new model in a new window. If the Open
new model in the same window option is selected, Artec Studio will use existing windows to display subsequent
files.

12.1.6 Surface-Consistency Detection During Import

The Surface-consistency detection during import option instructs Artec Studio to examine imported files for de-
fects. Select one of the following parameters:

Do not detect. Disable automatic surface-consistency detection.

Detect & ask. Enable automatic surface-consistency detection; Artec Studio will prompt you to start defect
correction.

Always detect & fix. Enable automatic surface-consistency detection and correction.

12.1.7 Model Placement

When exporting, the application can automatically center scans and models on the origin of the axis grid. To
enable this option, select the Move model to origin of the axis grid during export checkbox. If the checkbox is
cleared, the application will save the model’s current placement on the axis grid when exporting surfaces.

12.1.8 Base Removal for Leo Scans

The Enable automatic base removal option in the Scan panel only works for scans from Eva and Spider and other
handheld scanners connected to computer. To enable automatic base removal for scans from Leo, select the
Launch base removal for Leo scans checkbox. The algorithm will start after the application imports that project.

12.1.9 Point-Cloud Export

The Export point clouds to PTX with merged sections ensures a successful import of the exported files in third-
party software products. See Merging Sections.

12.1.10 Units

In Artec Studio, all software operations use millimeters as the default measurement unit. If you need to export
a model in other units, change the corresponding setting using the Default export units dropdown list. Artec
Studio supports the following units for exporting models: millimeters, centimeters, inches and meters.

When exporting point cloud scans (Artec point cloud and Leica Geosystems Cyclone Point Cloud), application
will ignore the specified units. See Exporting Point Clouds for details.
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12.1.11 View-Control Settings

Artec Studio allows you to use Scroll wheel to zoom in on the model in the 3D View window. You can take
advantage of this capability in two ways:

• Clear the Mouse-wheel zoom to cursor checkbox to enable zooming to the center of the screen. In this
case, you must keep the target area in the screen center and readjust its position from time to time.

• Select the Mouse-wheel zoom to cursor checkbox to enable interactive zooming to the mouse-cursor po-
sition. In this mode, you need only keep the cursor on the target area while spinning Scroll wheel
forward and backward.

12.1.12 Legacy

Enable old fusion algorithms allows you to turn the Fast fusion alogrithm which is deprecated in Artec Studio 18.
It is faster but doesn’t provide the same output quality and compatibility with various scanners as Fusion does.

12.2 Performance

The following parameters are user adjustable by way of the Performance tab (see Figure 207) multithreading,
memory usage, command-history storage, compression levels for stored data, texture-recording mode and Real-
time fusion settings.

12.2.1 Multithreading

On computers that feature multicore processors, Artec Studio uses all cores by default. If you would like to limit
the number of cores the application employs, clear the Use all available processor cores checkbox and enter the
number of concurrent threads manually.

12.2.2 Texture-Recording Mode

By default (Automatic texture recording enabled), Artec Studio doesn’t capture texture for every frame. You can,
however, manually specify the frequency for capturing texture frames by using the spinner in the Record texture
every __th frame option.

12.2.3 Real-Time Fusion Settings

Real-time fusion offers two optional settings (see Scanning With Real-Time Fusion):

Voxel size (mm). The fusion resolution. It affects the algorithm’s performance and quality. The lower the value,
the sharper the shape of the model. Note that specifying low values may produce noisy surfaces.

Buffer size. Amount of GPU memory employed to reconstruct a Real-time fusion object in the scene. The default
value depends on the computer’s available GPU memory. Note that Artec Studio may fail to correctly determine
the upper limit if your computer has an Intel HD Graphics card. The more memory you have, the larger the
scene you can scan in Real-time fusion mode. The slider doesn’t define the total finite memory size, however;
the algorithm employs system memory (RAM) when GPU memory is consumed.

Note: Avoid altering the Buffer size unless you have started noticing artefacts while scanning.
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Figure 207: Performance settings tab.
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12.2.4 Scan Reconstruction

In order to achieve the fastest possible reconstruction, Artec Studio has an in-built benchmark test that checks
your GPU type, the driver version, and automatically adjusts the internal reconstruction settings. The test is
optional, but is highly recommended as it considerably speeds up the algorithm performance. You will only
need to rerun the test when you change GPU or update the adapter drivers.

The first time you open Artec Studio in your system, a pop-up message prompts you to run the GPU test. You
can opt to skip it for the time being, and run it later. In order to run the test, go to Settings → Performance →
Scan Reconstruction section. This section also displays the result of the test after it is run once.

12.3 Scan

The Scan tab allows you to edit the parameters that the application uses both while scanning and while post-
processing the results (see Figure 208).

Figure 208: Scan settings tab.
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12.3.1 Algorithm Settings

Artec Studio automatically selects and displays settings for each scanner type in the Current scanner type drop-
down of the Settings dialog and in the Preset dropdown of the Tools panel. If it fails to correctly identify your
scanner type or you process scans from different scanners, select the appropriate scanner type manually. To
reset all settings to their default values, click Reset to defaults.

Current user preset allows you to save the current parameter values in the Tools panel. By selecting a saved
preset, you can change all settings at once. Note that this option applies only to the selected device type.

12.3.2 HD Reconstruction

When using Artec Eva or Artec Leo in the HD mode, you can adjust the following parameters that influence the
results of the HD reconstruction:

• The maximum edge length (in mm) of the polygons used for the HD reconstruction

– Eva max. edge length (mm)

– Leo max. edge length (mm)

• Sensitivity

– Eva sensitivity (0.0-1.0)

– Leo sensitivity (0.0-1.0)

Higher sensitivity results in more detailed reconstruction of scanned surfaces, on the one hand, and in higher
noise level, on the other:

• sensitivity of 0.0 means maximum noise filtering

• sensitivity of 1.0 means no noise filtering

You can vary the sensitivity with the step of 0.01.

You can also instruct Artec Studio to import the HD raw data for all Leo scans, or to launch HD reconstruction
for all Leo scans immediately after import. There are two respective checkboxes for this.

12.3.3 Photogrammetry Settings

Photogrammetry settings allow you to define the target size. Inner target diameter (mm) corresponds to the
diameter of the white circle in the middle of the target; Outer target diameter (mm) corresponds to the outer
diameter of the target’s black ring. The most popular targets have diameters of 6 mm and 12 mm; the values
5 mm and 10 mm correspond to the Scan Reference target. See Target-Assisted Scanning for details.

The Disable hybrid tracking for .obc checkbox ensures that tracking is purely based on targets. Select the check-
box if you don’t want the texture and geometry features to assist target scanning (Photogrammetry Solution).
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12.3.4 Capture

The Capture section covers settings related to the trigger button for the Artec MHT scanner, as well as the
scanning-depth range and individual frames acquired during the scan.

The first option is the Trigger mode for device button checkbox, which changes the button behavior on the Artec
MH and Artec MHT scanners. For details regarding these buttons, see Scanner Buttons and Capture Modes.

The scanner has a defined depth range. If it’s too close to the object, it may fail to capture all or part of
the object. On the other hand, if the scanner is too far away, various types of 3D “noise” will appear in the
scene, complicating the postprocessing effort and affecting the final results. Therefore, you should position
the scanner as close as possible to the object without crossing the cutoff plane. Default settings for each 3D
scanner contain minimum and maximum limits within which you can position the cutoff planes. The scanner
model determines these values. If you are using an Artec L scanner or 3D-sensor and high accuracy is of lesser
importance, however, you can adjust the depth boundaries manually, allowing you to scan closer to or further
from the object than the recommended distances indicate. To this end, mark the Override default depth range
checkbox and enter new range values.

Warning: Redefining the depth range may reduce accuracy.

12.3.4.1 Scan Using Auto-Alignment

The Scan using auto-alignment option is enabled by default and is covered in the Resuming Scan After Lost Tracking
and Auto-align new scans with those marked in Workspace sections. The application’s behavior varies depending
on this option’s value, as Table 19 shows.

Table 19: Application behavior with option enabled and disabled.
Scan Using Auto-Alignment On Off
Tracking Mode Geometry + Texture Geometry or Geometry + Texture
Audio Notification? Yes (see Audio Notification) Yes

Message in 3D View Searching for position: Point 3D Scanner at the
object to continue

Tracking lost: Repeat scan using
slower motions or additional fea-
tures

Instructions
Direct the scanner at any already captured region
with sufficient texture, maintaining the original
scanner orientation relative to the object

Direct the scanner at the last cap-
tured region

Data Recording Handled in a newly created scan Handled in the same scan

12.3.5 Misalignment Detection

In some cases, Artec Studiomay incorrectly determine relative frame positions, resulting inmisalignment. When
this error occurs, you must restart the scanning session and remove the misaligned scans. Alternatively, you
can attempt to fix the misalignment by breaking the scan into several segments. Further information about
addressing this problem by dividing scans is available in Separating Scans. To prevent possible misalignment
and improve your scanning experience, Artec Studio features a Misalignment detection for EVA scanner setting
that functions during the scanning process. However, if you have difficulty maintaining the tracking when
scanning particular objects, you can disable this setting.

Options are as follows:

• On (Hybrid tracking only). The default value, option works for Geometry + Texture tracking mode.
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• On. The option works for all tracking modes, including Geometry.

• Off. The option is turned off for all trackers.

12.3.5.1 Default Capture Settings

Artec Studio allows you to change the characteristics of single-frame surfaces as the scanner captures them. To
change the default parameters, clear the Use default capture settings checkbox and change the settings manually
in the displayed window. The options below are user adjustable:

Important: We recommend using default settings. Poorly chosen settings may reduce data quality.

Triangles step. Point density for a frame mesh.

Minimum object size. The smallest object scanned, by number of polygons.

Length filter threshold. Triangle-filtration threshold by edge length (maximum possible size in mm).

Interpolate. Use interpolation for parts of surface that are missing data.

Max interpolated length. Maximum size of areas to be interpolated (in mm).

Max angle. Triangle-filtration threshold by maximum angle (in degrees) between the triangle’s normal and the
camera’s sight vector.

Geometry registration threshold. The higher the threshold, the stricter the quality requirements for the geometry
being scanned. Therefore, determining the proper geometry in the scene is more difficult in such cases. Sub-
sequently, Artec Studio runs geometry registration less frequently, making way for texture registration. Works
with Geometry + Texture tracking only, values are between 0 and 1.

12.4 UI

The UI page allows you to edit user-interface settings (see Figure 209) and covers the following categories:

• Audio notification

• Workspace colors

• Warnings

• Surfaces that Artec Studio displays during a scan

12.4.1 Audio Notification

Sometimes, automatic alignment in real time is impossible during the scanning process, and the program is
unable to align the previous frame with the current one (see Resuming Scan After Lost Tracking). When this
situation occurs, Artec Studio issues an audio warning that stops once you reposition the scanner and the
software again finds its location in 3D. To enable or disable this feature, use the Enable audio warnings in scan
mode checkbox. A standard “beep-sound” is the application’s default sound. You can choose any WAV file as the
warning sound. To this end, click the … and specify a file path.

See also:

Warnings in Tools and Editor.
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Figure 209: Interface settings tab.
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12.4.2 Workspace Colors

Artec Studio automatically chooses display colors for newly created scans. You can select any of the standard
palettes:

• Full palette

• Light colors

• Web-safe colors

• Random colors

• Monochrome

12.4.3 Warnings

The Warnings options allow you to toggle certain notifications. They include the following:

12.4.3.1 Startup Checks

Show OpenGL compatibility issues on startup. Artec Studio requires OpenGL version 2.0 and some OpenGL exten-
sions to function properly; your PC may or may not currently support these capabilities. Selecting this option
activates a display window on startup containing information regarding possible missing extensions.

12.4.3.2 Warnings in Tools and Editor

If you are familiar with these algorithm peculiarities, you may disable these notifications.

Texture-healing brush: warn if over __ polygons selected. This checkbox instructs the application to display a
warning if you exceed the maximum number of polygons to be inpainted at one time. This limit reduces the
potential for the computer to hang up. Specify a suitable value for your system, or clear this checkbox if you
require no warnings of this kind.

Warn about texture removal by Defeature brush. Be ready that Defeature brush won’t preserve texture in the
corrected areas, so the application notifies you of this.

Warn about complex models texturing. If you are attempting to texture a high polygonal model, Artec Studio will
suggest that you simplify it first.

Warn about scans in transformation tool. We advise that you refrain from repositioning source scans as it may
result in the incorrect texture application. The message may remind you about it.

Inform about texture frames for Glare reduction. Since this option in the Texture panel requires many texture
frames, Artec Studio will advise you to adjust frame-recording settings.

Warn about HD decimation for Leo. Enabling this option instructs Artec Studio to display a warning if both of the
following conditions are met:

• You launch HD reconstruction on raw data from Artec Leo with HD frames frequency less than 1.

• The raw data has already been decimated during scanning with Artec Leo.

Double decimation can lead to poor results, for example, some parts of the scanned surface may be lost, and
the resulting HD scan may have holes.

Warn about GPU capability for reconstruction. With this option enabled, Artec Studio will warn you in case the
installed GPU/hardware is not suitable for data reconstruction. Due to a weak GPU/hardware, Artec Studio may
take forever to complete the reconstruction process successfully.
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Play a sound on completion of algorithm lasting more than 30 seconds. This setting allows you to get distracted
while the application is busy running algorithms and performing commands. Once the application finishes any
of these processes, it chimes.

Inform about locked scans. Artec Studio will remind you that some of the scans selected for Global registration

have or marks (see Workspace Panel). This message allows you to unlock them or run the algorithm
without changing scans’ status.

12.4.4 Displaying in 3D View Window

You can change the way you see surfaces and points during the scanning process, adjust their colors as well as
the background color, and specify the mode for frame playback. To these ends, use the settings below:

12.4.4.1 Display

Last scanned surfaces. Number of visible surfaces most recently captured that will appear in 3D View during
scan.

Visible surfaces. Total number of visible surfaces displayed during scan (equal to the number of most recently
scanned surfaces plus the number of key frames to display).

Disable smart simple rendering mode. Smart simple rendering mode ensures that 3D content is rendered with-
out simplification if computer resources allow it. Once the system experiences lags, it automatically turns on
simplification.

Polygon limit for conventional simple rendering mode. Maximum number of polygons in the viewport beyond
which Artec Studio will switch to simple rendering mode during 3D navigation.

Point-cloud polygon limit. If the polygon count of a point cloud surface exceeds the specified value, Artec Studio
will render a simplified copy of this surface having no more than specified polygons.

Spherical target diameters. List of diameters of the target spheres used during scanning with Ray. Use semicolon
; as a delimiter between values in millimeters in the field.

Point size. Number of pixels for rendering each point when using the Points or the Points and solid rendering
mode.

Animate movements. It shows movement of the 3D data when Artec Studio repositions or reorients it. Disable
this option on slow computers.

Highlight objects. Enable this option for Artec Studio to highlight the outlines of an object displayed in the 3D
view window when you hover the mouse cursor over its name in the Workspace panel.

12.4.4.2 Colors

Last. Color of last scanned surfaces.

Registered. Color of correctly aligned surfaces.

Preview. Color of surfaces in preview mode.

Dropped. Color of unaligned (and thus dropped) surfaces.

Key frames. Color of key frames (surfaces).
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12.4.4.3 Screenshots

You can specify the default screenshot size in pixels (see Saving Screenshots):

• Width

• Height

If your system configuration is incompatible with the specified settings, Artec Studio will save a screenshot of
the maximum possible size.

12.4.4.4 Playback

See also:

Selecting Scans and Models

Repeat. Continuously loop the frame sequence in the surface-view mode of the Workspace panel.

FPS. Speed (in frames per second) at which frames appear during playback.

12.4.4.5 Background

Color. Background color; the application may automatically alter this color in certain modes, such as X-ray.

Dropped color. Background color when misalignment occurs while scanning.

Texture. Display patterned (chessboard pattern) or plain background.

Gradient. Gradient or monochrome background color.

Background for screenshots. Application will use this background color when saving screenshots, the actual back-
ground color will remain unaltered.

12.4.4.6 Welcome Screen

Don’t show. Disable the welcome screen.

12.4.4.7 Autopilot

Don’t show greeting screen. Disable the Autopilot screen showing the steps to pass in this mode

12.5 Miscellaneous

12.5.1 Usage Information

You can help us improve the quality and performance of Artec Studio by allowing us to collect and send usage
information to Artec Group. This information will not be used to identify you, and it excludes your project data,
3D surfaces, textures and any other data that you obtain and process using Artec Studio. By default, the Collect
and send anonymous usage data to Artec checkbox is selected. We recommend leaving this checkbox marked so
we can better improve the application.

When installing Artec Studio, you can decide whether you want it to collect and send usage data. The same
checkbox described above also appears in the final installation dialog (see Figure 38).
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Figure 210: Example of altered background.

12.5.2 Language

The Artec Studio interface supports several languages:

• Auto—automatic language selection on the basis of system settings

• Chinese (Simplified)

• Chinese (Traditional)

• Croatian

• Czech

• English (U.S.)

• French

• German

• Italian

• Japanese

• Korean

• Polish

• Portuguese

• Russian

• Spanish
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Figure 211: Miscellaneous settings tab.
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• Turkish

• Ukranian

To switch between languages, choose the one you want and click OK. The program will then prompt you to
restart. If you agree, the application will restart automatically using the newly selected interface language. If
you choose not to restart, the changes will take effect the next time you start the application.

Note: To change the language, Artec Studio must restart.
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THIRTEEN

SCANNER CALIBRATION AND CORRECTION

In some cases, owing to careless handling or transportation (jolts, accidental drops or some other reason), the
scanner may fail to capture surfaces properly. The scanned surfaces may only be partially reconstructed or may
contain holes. You can resolve these issues by correcting or calibrating the scanner.

In Artec Studio, you can calibrate your scanner and correct its existing calibration. Calibration generally involves
verifying and adjusting a scanner’s measurements by comparing themwith standard (etalon) values. Every Artec
scanner is delivered pre-calibrated.

Depending on the scanner model, calibration or correction can be performed directly in Artec Studio (e.g., Artec
Point, Artec Spider II) or by using a standalone application called Calibration tool (e.g., Artec Spider, Artec Eva).

13.1 Calibration Tool

Calibration Tool can operate in one of the two working modes:

• Correction for Artec Eva scanner

• Calibration of Artec Spider scanner

13.1.1 Suggestions for Use

Correction differs from calibration, in that it preserves the current calibration: it only changes the correction
ratio so as to enable good reconstruction. Application of the correction does not guarantee that captured
geometric shapes and linear measurements will be accurate. Use this procedure as a temporary measure until
calibration is performed.

Table 20: Correction versus calibration.
Mode Characteristics Speed For Spider For Eva
Correction Inexact Fast No Yes
Calibration Exact Prep required Yes No

Important: Calibration is available for Artec Spider scanners only. Calibration of Artec Eva can only be carried
out at the Artec production office.
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13.1.2 Launching Calibration Tool

To launch the Calibration Tool, first ensure that the scanner you intend to calibrate appears in Artec Installation
Center as either On loan or Activated. You can launch the tool either through the Start menu by clicking Start →
All Programs → Artec Group → Artec Studio → Calibration Tool or in Artec Studio by selecting the Run Calibration
Tool command from the File menu.

Connect the scanner. If you have several scanners connected, select the appropriate one from the dropdown
list.

Note: The new Calibration Tool has the ability to detect USB types, and automatically make adjustments for
compatibility. This makes it possible to connect scanners using USB 3.1 cables, without external adapters.

13.1.3 Field of View Correction for Eva

Important: Apply correction sparingly, as a temporary measure until calibration is performed. If correction
fails, please contact the Artec support.

The Artec Eva scanner only allows you to correct their current calibration data on field of view.

Figure 212: Artec Eva correction window

1. Launch the Calibration Tool as Launching Calibration Tool describes.

2. If multiple scanners are connected, select the scanner you want to correct. Otherwise, continue with the
connected scanner.
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3. On the main window, click on the Start button, and the scanner will start the preview.

4. Direct the scanner at the right angle to a flat, light (but not shiny) monochrome surface (e.g., a wall or
floor) from a distance of 650–700 mm.

5. The Correction window will indicate whether the distance is optimal, and start rendering the surface.

6. Click Next, to perform the correction.

7. The Evaluation window, will then display the result of the correction. If the correction result meets your
expectations, click on Save correction. Otherwise, click on Recorrect, and repeat the process.

13.1.4 Calibration for Spider

To carry out the calibration, you will need the following additional equipment: a calibration rig, a scanner stand
and a positioning sheet. Assembly instructions for the scanner stand and calibration rig are given in Assembling
the Scanner Stand and Assembling the Calibration Rig, respectively.

Step 1: Set up board

1. Unfold the positioning sheet and place it on a desk or any hard, planar surface.

2. Align the scanner stand with the rectangle marked on the sheet, paying close attention to the orientation
of the slots in the stand cover (see Figure 213).

3. Place the scanner on the scanner stand, making sure that you insert the three scanner stems in the three
slots of the stand cover (see Figure 214).

4. Set the calibration rig on the positioning sheet, turning its marker side towards the scanner as Figure 215
shows.

Figure 213: Scanner stand resting on the sheet.

1. Now, launch the Calibration Tool as Launching Calibration Tool describes.

2. If there are multiple scanners connected, then select you scanner on the Calibration tool main window,
and click on Start.

3. Enter the serial number of your calibration rig, and click Next.

Step 2: Warm up scanner

1. If the scanner temperature is outside the optimal range—for example, you just connected the device to a
power outlet—the tool will notify you to warm the scanner up.
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Figure 214: Placing Artec Spider on the stand

Figure 215: Calibration rig, positioning sheet and scanner stand with Artec Spider.
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2. The warm-up time will depend on the actual temperature of the scanner. In any case, we advise against
clicking Skip and instead recommend waiting for the Artec Spider to reach its optimal temperature.

Note: It is important to warm up the scanner to its optimal working temperature before carry-
ing out calibration. For precise results, do not skip this step.

Figure 216: Warming up the scanner

Step 3: Calibration

1. After scanner reaches its optimal temperature, click Start to start calibrating Artec Spider.

2. Place the rig in its initial position such that the front edge of its base coincides with the color line num-
bered 1 on the sheet. As you do so, keep an eye on the Calibration window for the position plane to turn
green plane. Once the plane turns green, stop moving the rig and wait for the scanner to capture the
plane.

3. Wait for the tool to instruct you to move the rig to the next position on the pattern; the number for that
position will appear on the screen. Move the rig and again wait for the scanner to capture the plane.

4. Repeat the preceding step for the remaining positions sequentially. Depending on the version of your
calibration kit, the positioning sheet will have 11 to 15 positions.

Step 4: Evaluation

1. Once you have captured the last position and the calculations have concluded, the Evaluationwindow will
display the the quality of the calibration and accuracy.

2. If it indicates that the scanner is well calibrated, you can go ahead and click on Save Calibration .

3. Alternatively, direct the scanner at a flat, nonglossy surface (e.g., a piece of paper) from a distance of about
200 mm. Assess the quality of the reconstructed surface and check for any holes. If no holes appear on
the surface and you are satisfied with the reconstruction results, go ahead and Save Calibration.
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Figure 217: Moving calibration rig to position number 1

4. In case of discrepencies or dissatisfactory results, click on Recalibrate, and repeat the calibration process.

13.1.5 Notes Regarding Scanner-Calibration Files

Calibration and correction results reside in files that you can access as follows. Their location is

C:\Users\%name%\AppData\Roaming\Artec\Artec Installation Center \Devices\SP.00.
00000000.

Here, %name% is the current user folder and SP.00.00000000 is the folder corresponding to the scanner
serial number. Note the following information regarding calibration and correction.

• Once you apply correction results, the software will create an ACD file.

• Once you apply calibration results, the software will create ACD and CORR files.

• All newly created files have names of the form YYYYMMDD-HHMMSS, with the characters corresponding
to the date and time of the file’s creation.

• Original ADD and CORR file names are based on the scanner serial number and have the form SP.00.
00000000.

Note: You can restore the initial calibration by removing the ACD and CORR files whose names have the form
20131121_101010.

Note: If you use the scanner on several computers, you need not recalibrate it on every one. Simply copying
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Figure 218: Evaluating calibration results

the ACD and CORR files to the above-mentioned folder on each computer may be sufficient.

13.1.6 Assembling the Scanner Stand

The scanner stand comes unassembled with Artec Spider and consists of five parts (see Figure 219): two side
walls, one front and one back wall (these parts are identical, however), and a cover. Before beginning assembly,
lay them all out as Figure 219 shows. Then follow these steps:

1. Raise the two side walls to the upright position, as Figure 220 shows. Noting carefully the orientation of
the T-shaped slot, install the front wall to the side walls using the two pairs of hooks. Press the front wall
and slide it down against the stop. Make sure the three walls are properly aligned with each other.

2. Install the back wall in the same way (see Figure 221).

3. Paying attention to orientation of the slots, install the cover using the upper hooks of the side walls (see
Figure 222).

4. Press your thumbs against the T-shaped holes on the cover and shift it toward the back wall until you
hear a click (see Figure 223).

The scanner stand is now ready to use.

Note: To disassemble the stand, release the detents in the cover’s T-shaped slots (see Figure 219) using a thin
object like a ballpoint pen. Repeat the assembly steps in reverse order (from Figure 223 to Figure 220), moving
the parts in the opposite directions.
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Figure 219: Parts of the scanner stand.

Figure 220: Assembling the front wall.
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Figure 221: Assembling the back wall.

Figure 222: Mounting the cover.
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Figure 223: Latching the cover.

13.1.7 Assembling the Calibration Rig

The calibration rig comes only with Artec Spider and consists of the base and the board. To assemble the rig,
follow these instructions:

1. Press the hinge of the base against your forefingers.

2. Unfold the bent leaves of the base, pressing on their edges with your thumbs.

3. Insert the board into the slot, as Figure 224 shows.

Figure 224: Assembling the rig.

13.1. Calibration Tool 289



Artec Studio, ver. 19

13.2 Embedded Calibration in Artec Studio

As of Artec Studio 19, you can calibrate Artec Spider II or Artec Point directly in Artec Studio. The process is
generally very simple and takes no longer than 5 minutes.

First, make sure the scanner is connected to your computer. Next, prepare the calibration board, and follow the
steps:

13.2.1 Artec Spider II

1. Open the Scan panel

2. Click the Start button.

3. Scan the QR code in the upper-left corner of the calibration board.

4. Once the QR is code scanned, the warming-up process will begin. This is an optional step, but we highly
recommend warming up the scanner for better results. However, you can proceed to the next step by
clicking the Skip button.

5. Follow the calibration process instructions displayed in the 3D scene.

Figure 225: Artec Spider II calibration

Once the process is complete, Artec Studio will automatically calculate the results. You are now ready to start
scanning.
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13.2.2 Artec Point

1. Open the Scan panel

2. Click the Start button.

3. Follow the calibration process instructions displayed in the 3D scene.

Figure 226: Artec Point calibration

Once the process is complete, Artec Studio will automatically calculate the results. You are now ready to start
scanning.

Note: To gain the best results, we recommend calibrating Artec Point before each scanning session.
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FOURTEEN

SWITCHING FROM ARTEC STUDIO 14

Since version 15, Artec Studio has more comprehensible names for the algorithm parameters (Tools panel). The
glossary below lists these new names in alphabetical order and provides their former names used in version
14. Links lead to the corresponding sections covering these parameters.

3D resolution resolution; everywhere: in Fusion, Outlier removal.

3D-noise level Either std_dev_mul_threshold in Outlier Removal, or minDistBetweenDescriptors in Global regis-
tration for point cloud scans.

Adaptive (distance-aware) Adaptive; in Ray scan triangulation.

All (watertight) Watertight; in Fusion.

All except largest Leave_biggest_object; in Mesh optimization (Small-object filter).

Decimation ratio decimationStep; in Ray scan triangulation.

Distance from scanner effective_dist_from_scanner; in Global registration for point cloud scans.

Distinct colors for sections SectionColor; in Ray scan triangulation.

Feature voxel voxelSide; in Global registration for point cloud scans.

Features registration_algorithm; in registration algorithms.

Fill holes Fill_holes; in Fusion.

Focus on geometry First introduced in version 15.

Geometry Geometry (unchanged); in registration algorithms.

Geometry and texture Geometry_and_Texture; in registration algorithms.

Geometry Ray Geometry_Ray; in Global registration for point cloud scans.

Hole perimeter (max) max_hole_len; in Mesh optimization (Hole filling).

Hole radius (max) max_hole_radius; threshold radius in Fusion.

Incidence angle (max) maxIncidenceAngle; in Ray scan triangulation.

Incidence angle between vertices (max) maxTriangleAngularSize; in Ray scan triangulation.

Keep edges keep_boundary; in Mesh optimization (simplification).

Keep texture UV_Triangle_quantity; in Mesh optimization (simplification).

Key frame ratio key_frame_ratio; in Global registration

Later, manually Manually; one of the options in Fusion.

Maximum shape deviation error; in Mesh optimization (simplification)
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Mode method; in Ray scan triangulation.

No targets (Geometry alignment) Geometry_alignment; in Global registration for point cloud scans.

None Skip; one of the options in Fusion.

Nonstrict polygon count force_constraints; in Mesh optimization (fast simplification).

One random color None; in Ray scan triangulation.

Polygon angle (min) minTriangleAngle; in Ray scan triangulation.

Polygon count tri_num or Triangle_quantity; in Mesh optimization (simplification).

Polygon count (max) threshold; in Mesh optimization (Small-object filter).

Polygon edge length (max) Either maxEdgeLength in Ray scan triangulation, or remesh_edge_thr in Mesh sim-
plification.

Remove small polygons Remesh; in Mesh optimization (simplification)

Remove surfaces mode; in Mesh optimization (Small-object filter).

Render mesh based on colorMode; in Ray scan triangulation.

Search features within feature_search_radius; in Global registration.

Shape deviation Accuracy; in Mesh optimization (simplification).

Simple Simple (unchanged); in Ray scan triangulation.

Smaller than specified Filter_by_threshold; in Mesh optimization (Small-object filter).

Steps steps; in Smoothing (Tools).

Target when simplifying stop_condition; in Mesh optimization (regular simplification).

Targets Targets (unchanged); in Global registration for point cloud scans.

Targets and geometry Targets_Geometry; in Global registration for point cloud scans.

Targets removal remove_targets; in Fusion.

Vertex colors SourceColor; in Ray scan triangulation.

With radius smaller… By_radius; determines which holes to fill in Fusion.
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FIFTEEN

HOT KEYS

15.1 Scanning

Open Scan panel F7 Anywhere exc. modal dialog
Toggle between Preview and Record modes Space Scan panel
Open Multicapture panel F8 Anywhere exc. modal dialog

15.2 Workspace

Select one scan and deselect the rest Ctrl+Alt+LMB Workspace panel
Select one scan and deselect the rest Ctrl+LMB Workspace panel, first column
Select all scans/models or frames Ctrl+A Workspace panel
Deselect all scans/models or frames Ctrl+D Workspace panel
Select/deselect the highlighted scan Space Workspace panel
Select and display a single frame Alt+LMB 3D View window
Select only key frames Ctrl+K Workspace panel → Surface list
Select only textured frames Ctrl+J Workspace panel → Surface list
Rename scan/model F2 Workspace panel
Group objects Ctrl+G Workspace panel
Start/stop playback scan frames Ctrl+P Workspace panel → Surface list

Delete selected frames/scans Del Workspace panel (including sur-
face list)

15.3 Save, Export and Import

Create new project Ctrl+N Anywhere exc. modal dialog
Save project Ctrl+S Anywhere exc. modal dialog
Open existing project Ctrl+O Anywhere exc. modal dialog
Import 3D files Ctrl+I Anywhere exc. modal dialog
Export meshes Ctrl+Shift+E Anywhere exc. modal dialog
Clear command history Ctrl+Alt+H Anywhere exc. modal dialog
Save screenshot of 3D View window Ctrl+Shift+S Anywhere

294



Artec Studio, ver. 19

15.4 Viewing 3D Content

Fit to view F 3D View window
Place coordinate origin to the viewpoint center (Home) H 3D View window
Display/hide coordinate axis grid G 3D View window
Set rotation center to the origin of axis grid Ctrl+Shift+C 3D View window
Set rotation center to the object’s center of mass Ctrl+Shift+M 3D View window
Change rendering mode to Texture Ctrl+Alt+1 3D View window
Change rendering mode to Scan color Ctrl+Alt+2 3D View window
Change rendering mode to Frame color Ctrl+Alt+3 3D View window
Change rendering mode to Max error Ctrl+Alt+4 3D View window
Change rendering mode to X-Ray Ctrl+Alt+5 3D View window
Turn on/off lighting L 3D View window
Display/hide normals N 3D View window
Display/hide boundaries B 3D View window
Display/hide texture boundaries Shift+B 3D View window
Toggle between perspective and orthogonal views 5 (numpad) or Ctrl+5 3D View window
Turn on/off Show CAD constraints mode Shift+C 3D View window

15.4.1 Switching Viewpoint

To front 1 (numpad) or Ctrl+Shift+1 3D View window
To back Ctrl+1 3D View window
To left Ctrl+3 3D View window
To right 3 (numpad) or Ctrl+Shift+3 3D View window
To top 7 (numpad) or Ctrl+Shift+7 3D View window
To bottom Ctrl+7 3D View window

15.5 Editor

Activate 2D selection mode Shift+Alt+1 Editor → Eraser
Activate 3D selection mode Shift+Alt+2 Editor → Eraser
Activate Rectangular selection mode Shift+Alt+3 Editor → Eraser
Activate Lasso selection mode Shift+Alt+4 Editor → Eraser
Activate Cutoff-plane selection mode Shift+Alt+5 Editor → Eraser
Activate Base selection mode Shift+Alt+6 Editor → Eraser
Display control for adjusting cutoff
plane

Alt Eraser/Defeature brush → Cutoff-
plane selection

Move cutoff plane Ctrl+Shift+Scroll Eraser/Defeature brush → Cutoff-
plane selection

Change tool size Ctrl+[ and Ctrl+] or
Scroll Wheel

Editor panel → any tool

Select the entire surface below the
cutoff plane

Ctrl+Q Eraser/Defeature brush → Cutoff-
plane selection

Clear selection of 3D regions Ctrl+Alt+LMB Editor
Invert selection I Editor panel→ any tool→ 3D View
Delete selected region Delete Editor → Eraser
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15.6 Aligning Scans

Display aligned scans/models 1 Align panel
Display unaligned scans/models 2 Align panel
Display all scans selected for alignment 3 Align panel
Manually align scans Shift Align panel
Switch between point sets/pairs Space and Backspace Align panel → points
Confirm creation of point set Space Align panel → Complex

15.7 Starting Tools, Modes and Dialogs

Open Autopilot F9 Anywhere exc. modal dialog
Open Tools panel Ctrl+T Anywhere exc. modal dialog
Open Align panel Ctrl+L Anywhere exc. modal dialog
Open Fix holes panel Ctrl+B Anywhere exc. modal dialog
Open Repair panel Ctrl+R Anywhere exc. modal dialog
Open Measures panel Ctrl+M Anywhere exc. modal dialog
Open Texture panel Ctrl+U Anywhere exc. modal dialog
Open Editor panel Ctrl+E Anywhere exc. modal dialog
Start Eraser tool E Editor panel
Start Defeature brush D Editor panel
Start Positioning tool P Editor panel
Start Transformation tool T Editor panel
Start Smoothing brush S Editor panel
Start automatic processing (don’t confuse
with Autopilot) Ctrl+G Tools → Auto

Open web manual F1 Anywhere
Open local User Guide file Ctrl+F1 Anywhere
Call Settings dialog F10 Anywhere exc. modal dialog
Show/hide Workspace panel F11 Anywhere exc. modal dialog
Show/hide Log window Ctrl+Alt+L Anywhere exc. modal dialog
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SIXTEEN

CONVENTIONS AND ACRONYMS

Portions of this user guide are highlighted to draw your attention. For example,

Note: Important information appears in specially formated paragraphs.

The following examples illustrate our conventions:

• Panel and element names that appear in the application window use italics: e.g., Workspace, File and
Texture

• Buttons, checkboxes and elements of dropdown lists in panels and application menus are italicized and
underscored: Invert, Apply and so on

• Shortcuts, individual keys and hardware buttons use gray highlighting: e.g., Ctrl+A

• Characters that appear in a field, file extension, or directory or file path employ the following style: Scan
1, A3D, SPROJ, C:\Program Files, and so on.

Note the following abbreviations and icons:

• LMB—left mouse button

• RMB—right mouse button

• —Play/Pause button on the scanner body
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\spxentry3D resolution, see resolution, 292
\spxentryfor Fusion, 179
\spxentryfor Isotropic remesh, 213
\spxentryfor Outlier removal, 149

\spxentry3D-noise level, 292
\spxentry3D-noise level

\spxentryfor Global registration, 173
\spxentryfor Outlier removal, 149

\spxentryaccuracy, 28
\spxentryAdaptive\spxextradistance-aware, 292
\spxentryAdaptive\spxextradistance-aware, 177
\spxentryAll\spxextrawatertight, 179, 292
\spxentryAll except largest, 184, 292
\spxentryAutopilot, 28

\spxentrybuffer size, 267
\spxentrybundle, 28

\spxentryCAD object, 28
\spxentryCAD primitive, 28
\spxentrycollection, 28
\spxentryCollective

\spxentryfor Global registration, 172

\spxentryDecimation ratio, 177, 292
\spxentryDescriber preset

\spxentryfor Photo registration, 199
\spxentryDesired edge length, 177
\spxentryDistance from scanner, 173, 292
\spxentryDistinct colors for sections, 177, 292
\spxentryDownsampling

\spxentryfor Global registration, 172

\spxentryFeature voxel, 173, 292
\spxentryFeatures, 292

\spxentryfor Fine registration, 154
\spxentryfor Global registration, 172

\spxentryFill holes, 179, 292
\spxentryfine registration, 28

\spxentryFocal length, pixels
\spxentryfor photos, 199

\spxentryFocus on geometry, 172, 292
\spxentryframes, 28
\spxentryfusion, 28

\spxentryGeometry, 292
\spxentryfor Fine registration, 154
\spxentryfor Global registration, 172

\spxentryGeometry and texture, 292
\spxentryfor Fine registration, 154
\spxentryfor Global registration, 172

\spxentryGeometry Ray, 173, 292
\spxentryGlare reduction, 179
\spxentryglobal registration, 28
\spxentrygroup, 28

\spxentryHD scan, 28
\spxentryHigh

\spxentryfor Photo registration, 199
\spxentryHole perimeter\spxextramax, 187, 292
\spxentryHole radius\spxextramax, 179, 292

\spxentryIncidence angle\spxextramax, 177, 292
\spxentryIncidence angle between

vertices\spxextramax, 177, 292

\spxentryKeep edges, 189, 292
\spxentryKeep texture, 292
\spxentryKey frame ratio, 172, 292
\spxentrykey frames, 28

\spxentryLater, manually, 179, 292

\spxentryMaximum shape deviation, 292
\spxentryMedium

\spxentryfor Photo registration, 199
\spxentrymesh, 28
\spxentryMode, 177, 293
\spxentrymodel, 28

\spxentrynear and far cutting planes, 28
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\spxentryNo targets\spxextraGeometry alignment,
173, 293

\spxentryNone, 179, 293
\spxentryNonstrict polygon count, 293
\spxentryNormal

\spxentryfor Photo registration, 199

\spxentryobject, 28
\spxentryOne random color, 177, 293
\spxentryorigin, 29

\spxentryPolygon angle\spxextramin, 177, 293
\spxentryPolygon count, 293
\spxentryPolygon count\spxextramax, 293
\spxentryPolygon edge length\spxextramax, 293

\spxentryfor Ray scan triangulation, 177
\spxentryproject, 29

\spxentryRegistration mode
\spxentryfor Global registration, 172

\spxentryRemove small polygons, 293
\spxentryRemove surfaces, 184, 293
\spxentryRender mesh based on, 177, 293
\spxentryresolution, 29
\spxentryrough registration, 29

\spxentryscan, 29
\spxentrySD scan, 29
\spxentrySearch features within, 293

\spxentryfor point cloud scans, 173
\spxentryfor scans, 172

\spxentrysection
\spxentryin a point cloud scan, 29
\spxentryin measurements, 29

\spxentrySeparate
\spxentryfor Global registration, 172

\spxentrySeparate then Collective
\spxentryfor Global registration, 172

\spxentryShape deviation, 293
\spxentrySimple, 177, 293
\spxentrySmaller than specified, 184, 293
\spxentrySmart subsampling, 172
\spxentrysparse reconstruction object, 29
\spxentrySteps, 192, 293
\spxentryStitch sections, 177
\spxentrySubsampling

\spxentryfor Fine registration, 154
\spxentrysupporting surface, 29

\spxentrytarget cloud, 29
\spxentryTarget when simplifying, 293
\spxentryTargets, 173, 293
\spxentrytargets, 29
\spxentryTargets and geometry, 173, 293
\spxentryTargets removal, 179, 293
\spxentrytracking, 29
\spxentrytransformation, 29

\spxentryVertex colors, 177, 293
\spxentryvoxel size, 267

\spxentryWith radius smaller..., 179, 293
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